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INTRODUCING BANNER 

Banner is the Student Information System in operation at DIT. There are approximately 200 administrative users of 
Internet Native Banner (INB) system and approximately 900 academic users of the Self-Service Banner (SSB) system. 
Each year DIT expects to register approximately 20,000 students on the student system. All DIT students will also 
interact with Banner via Self-Service system and through the process of online programme registration.  

DIT rolled-out an upgrade to Banner version 8.5 in July 2013. There have been five major upgrades since its original 
implementation in 2001. 

INB OR SSB 

Banner is often referred to as either INB (Internet Native Banner) or SSB (Self Service Banner).  

− INB is the component of Banner which uses an oracle forms front end. It is used by the administrative 
offices and is commonly referred to simply as ‘Banner’. Admin staff use Banner to support the back office 
processing of student records (including admissions, registrations, examinations and fees processing etc). 

− SSB is the web front-end component of Banner that allows students and academic staff to access 
information. Students interact with the Self-Service system to select modules the beginning of each 
semester and to view exam results. Academic Staff use the Self-Service system to enter grades. This is 
commonly referred to as EGB (Electronic Grade Book). 

ACCESSING & LOGGING ON TO BANNER 
To access Banner, first navigate to the Information Services Support website: HUhttp://support.dit.ie/U 

 

Select Banner from the Quick Links menu on the left. This will bring you to the Banner Homepage: 

The Banner Homepage is useful link to save in your Favorites, as it holds all documentation relevant to Banner 
including Training Guides, User Guides, FAQs and any new updates in relation to the Student Cycle of Events.  

http://support.dit.ie/
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The Banner homepage link is: HUhttp://intranet.dit.ie/mis2/DITBannerHomepage.htmU To log onto the Banner application, 
simply click the ‘Banner LIVE’ icon to the right of the page. 

 

You will be then brought to an Oracle Form, where a pop-up box will prompt you for your username and password. 

Simply enter your logon details and select Connect. 

 

Note: You will be provided with your logon details after training when your supervisor fills in the Banner User 
Application form. The application form is available from the IS Support website (HUhttp://support.dit.ieUH) 

You should now see the initial Banner start-up page as below: 

http://intranet.dit.ie/mis2/DITBannerHomepage.htm
http://support.dit.ie/
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BANNER NAVIGATION & FORMS 
 

MAIN MENU 
Looking at the Banner front screen, you will find the main menu on the left-hand pane. This comprises of a list of 
folders and sub-folders.  Within each of these folders are the Banner Forms. By selecting a given form, you are 
effectively accessing an online document where you can enter and look up information in the Banner database.  

Each unique form will also relate to a specific function or process. For example, by selecting the form ‘General Person 
Identification [SPAIDEN]’ under Student -> General Person folders, you will enter the form detailing general 
information about a given student. You could therefore query an existing student record or even create a new record 
from this form.  

 

Alternatively, you could also access this form by simply using the Direct Access option. Simply enter the form ID (in 
this case SPAIDEN) into the Go To…field on the main menu.  

 

 

Once you are familiar with the relevant form IDs, you will most likely access forms by the latter method. This process 
is the same for all forms in Banner, whether they are related to Admissions, Registration, Progression or Exams queries.  
You will see that each function or process will have unique form identification. 
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MY BANNER 
In the folder panel, you will also notice a folder called My Banner. This folder can be customised using the My Banner 
Maintenance form, GUAPMNU, to add or remove required Banner forms or processes.  It essentially acts as a 
‘Favourites’ repository. Within your respective administrative functions, you will most likely utilise the same Banner 
forms repeatedly. You therefore have the option to customise this folder with those commonly used forms. 

 

TOOLBAR, MOUSE & KEYBOARD 
You can perform most functions in Banner by use of the Toolbar.  As this training course progresses, you will begin to 
understand the meaning of each of these functions. 

 

All Banner commands are invoked by clicking a button on the toolbar, selecting an item from a pull-down menu, or 
pressing equivalent keystrokes. To view a list of Keyboard Functions, simply select Show Keys from the Help Menu 

Note: Show Keys is a valuable tool that helps you use the keyboard.   

Show Keys lists the keyboard equivalents that are available for the current form, window and field. 

 

FORMS 
As previously mentioned, a form in Banner is an online document where you can enter and look up information in the 
Banner database.   

Within a given form, you may need to perform various different functions such as query information, enter information, 
or proceed to ‘Next Block’.  These actions are explained below. 
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QUERYING IN FORMATION  

Querying is the process of retrieving existing information already entered in the Banner database.  The most common 
type of query may be searching for a student record from the form SOAIDNS.  

To perform a query, select the relevant query button or option on the Query pull-down menu. The keyboard equivalents 
are F7 to enter query and F8 to execute query. 

The following sequence of actions will help you when performing a given query. 

1. Select F7 (to clear the existing data and Enter a new Query) 

2. Enter your data in the relevant data field(s).  

Note: you can use the wildcard ‘%’ search also. The % is the wildcard character when performing a search and 
can be very effectively used when searching with a limited amount of information (e.g. enter D10% & Last 
Name – Mc% to search for all student IDs which begin with ‘D10’ whose last name begins with ‘Mc’). 

3. Select F8 (to execute a query) 

 

ENTERING IN FORMATION  
When entering information, you may be dictated by the type of data field you wish to enter information against.  

For example, many fields only accept codes from a defined list of values.  To display the list of values double-click in 
the field or select the List option from the Help pull-down.  The keyboard equivalent is F9. 

You may also search for an item if the data field supports it. You can click the drop-down search button to call another 
form, select information from the called form, and return the selected information to the current field.  

Finally you may be required to enter information by inserting a new record. An example of this type of data entry is 
when recording multiple application records against a given student. To enter a record, select Record -> Insert from 
menu bar. The keyboard equivalent for inserting a record is F6.     

To save information, you select the save button or the keyboard equivalent F10. 

BLOCKS & ROLLBACK 
A Block is a section of a form or window that contains related information.   

Use the ‘Next Block’ function to move to the next section or window of a form.  Use the ‘Previous Block’ function to 
move to the previous section or window. Use the Rollback function to go back to the key block of the Form.  

AUTO-HINT  

The auto-hint at the bottom of the form can contain information for the field where the cursor is located such as brief 
field description and any error and processing messages. 

E.g.
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FORM NAVIGATION 
The following options can be used to navigate within or between forms: 

• Tabs – Navigate to Blocks and Forms. 
Tabs allow navigation between blocks and related forms. Use Ctrl-Tab to move from one tab to the next or 
click on the required tab using the mouse.  

• F2 – Displays a list of available Blocks or Forms. 
When in any Form, press the F2 key to display a list of the available tabs or Blocks for that form. Use the 
arrow keys to select the required tab or Block, and then press Enter. 

• F5 – Displays the Go To… field. 
When in any Form, press the F5 key to display the Go To… field. Type the name of a Form or use the arrow 
keys to scroll through a list of recently used Forms. Press Enter to access the Form. 
To close the Go To… field, press F5 again. 

• Mouse Right-Click – Displays Option Menu 
Select the right mouse button to display the contents of the Options menu. Use the mouse to select the required 
Block or Form.  
Note: Select Add to Personal Menu to add the active form to the My Banner folder on the Main Menu 

 

QUICKFLOWS 
QuickFlows are essentially a chain of linked forms. When you enter a QuickFlow, you will be brought to the first form 
in the chain. Then as you finish and exit each form, you will be systematically brought to the next Form. This continues 
until all forms in the QuickFlow have been entered.  

QuickFlows are accessed in the exact same way as forms. Therefore, QuickFlows can be accessed by entering the name 
in the Go To..field. Examples of QuickFlows include Admissions Data Entry ADMT or Part-Time Registrations PRG1 
and PRG2.  
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INTRODUCTION TO SZANAVI – STUDENT NAVIGATION FORM 
An example of commonly used form is SZANAVI (Student Navigation Form). To enter and access the form, simply 
type SZANAVI in the Go To… menu box and hit the return key.  

This form holds all registration and personal details for a given student on a particular term.   

 

To query an existing student for the term (e.g. 201314), ensure the Term Code is entered (the default is the current 
term). Then enter the student number in the Student ID field. 

Note: If you don’t know the Student ID, you can search for this under the drop-down menu beside Student ID and then 
select Person Search. This will bring you into another Form SOAIDNS. By entering the relevant information and 
utilising %, select F8 and you should be able to find the required record. 

Once the Term Code and Student ID data is entered correctly, select ‘next block’ to view information pertaining to this 
student. 

The immediate Block of information you will see is Student Personal Details.  To navigate and view information on 
each Block, simply click on the relevant tab (i.e. Financial Details, Address or Registration) or select ‘next block’ in 
turn. 

Some important information to note includes: 

− Blank record: If programme data on the form is blank, the student has no registration record for the term. This 
will impact the creation of the student’s email account, AD account as well as their ability to register. 

− Registration Status: A registered student has an RE status. See appendix for full list of registration statuses.  
− Date of Birth:  
− Student Year: If no year exists here, the student has not been correctly progressed or set-up. 
− Address: A blank or inactive address may cause issues when trying to generate student reports (e.g. transcripts 

etc) 
− Telephone Number: Reference for contacting the student 
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Click on the Financial Details Tab and you will be able to see all financial transactions for that student.  This includes 
grant details and bank account details  

 

The last section of the form holds CRN details for student.  This does not automatically populate. If you wish to view 
these details, simply click on the Retrieve CRNs tab on the bottom right of the screen. 

In the Address Details tab you will be able to view all stored addresses for the student, their telephone numbers and 
email addresses (mainly their DIT email address). 
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The final tab holds other relevant Academic/Registration details such as how they were admitted to DIT and Leaving 
cert details. 

 

If you wish to print information, click on the Student Details Report on the bottom left of every page. 

 
If you wish to review information for another Term Code or even to query another student, simply select the Roll-Back 
function. 
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Before registration activities can commence for the new academic year, a number of key pre-registration events must 
occur. These events are as follows: 

− Term Roll completed in the Banner Student system. 
− Progression complete. All students eligible have been progressed to the new term with an EL (Eligible to 

Register) enrolment status. 
− New Programmes & Modules validated, approved and live in the Banner Student system.  
− All Programme & Module Fees validated, approved and live in Banner Student system 
− Web Registration InfoPack text reviewed and updated in Banner. 
− Student PINs re-enabled prior to production on InfoPacks. 
− Registration Service support in place. 
− DIT Registration website reviewed and updated (including Registration and ID card collection schedules). 
− CAO preparations completed.  

 

STUDENT PINS 
DIT students require a user ID (Student number) and PIN to: 

− Register on their programme using the Programme Web Registration system. 
− Module selection. This is confirmed using the Self-Service system. 
− Exam Results and overall award classification viewing using the Self-Service system. 

New students to DIT will receive an Invitation to Register (ITR) letter by post detailing their logon details to the 
Programme Web Registration system. Returning students will receive their ITR by email to their DIT student email 
address.  

Later on during the course of the year, students (new and returning) will receive email communications regarding 
access to the Self-Service system to confirm module selections and to view exam results. 

By default, a student’s PIN will be their date of birth in the format DDMMYY. In the absence of a student’s date of 
birth in the system, the last 6 digits of their student ID will be their initial default PIN.  

Note: As part of the Banner 8.5 upgrade in 2013, PINs are stored in the database in encrypted form and therefore are 
not visible to anyone. 

When the student logs on to one of the systems for the first time, they will be prompted to change their PIN.  The 
Banner system is also configured to compel students to change their PIN regularly by expiring them every 90 days. 
Therefore, over the course of an academic term while logging onto various different DIT applications, it is not 
uncommon for students to forget their PIN. To ease the process by which students may recover a PIN, the student 
online systems supports a ‘Forgot PIN’ option. This is facilitated by means of personal security question. 

SECURITY QUESTIONS 
On initial logon, students are prompted to set-up a personalised security question and answer. The list of security 
questions available to students are as follows: 

− What is your mother's maiden name? 
− In what city were you born? 
− What is your favourite sport? 

Students are required to select one question only and to provide their preferred answer. This question and answer can 
then be used in the future to validate the student’s identity for the purpose of recovering a ‘Forgot PIN’. 
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DISABLED PINS 
Access to the various online systems are also controlled by means enabling/disabling student PINs. To review the status 
of a student’s PIN, you should go to the GZTPIND (Disabled PIN Management) form in Banner. 

By entering the ID and ‘next blocking’ into the form, you should see Pin Disabled flag and Reason Code. 

 

The full list of PIN codes is as follows: 

PIN Disabled Code Description 
DPPE Disabled PIN, Results Subject to Panel of Enquiry 
DPOF Disabled PIN, Outstanding Fees 
DPNR Disabled PIN, Student Not Registered on modules (for exams) 
DPCS Disabled PIN, Carried Module Not Passed 
DPDP Disabled PIN, Final Year Deferral Pending 
DPSP Disabled PIN, Staff PIN Disabled Manually 
DPSG Disabled PIN, Banner System Generated 
DPOT Disabled PIN, Other Reason 
DPOS Disabled PIN, Off Season 
DPTP Disabled PIN, Outstanding Third Party Fee 
RENP Re-enabled PIN 

 

Student PINs are disabled for various reasons through the year. For example, the Fees & Income office may disable a 
student’s PIN if the student has outstanding fees. The Exams office may disable a student’s PIN subject to panel of 
enquiry in relation to exam results. IS globally disables all student PINs in advance of exam results being entered into 
EGB. 
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The following list charts the key PIN events throughout the academic year: 

Event Student PINs Responsibility 
EGB Marks Entry PINs are globally disabled,  MIS 
Exam Results PINs are re-enabled by class 'blocks'. Exams Office 
Outstanding Fees PINs disabled for students with outstanding fees Fees & Income 
Programme Registration PINs (not already re-enabled) are re-enabled by 'block'. Registration Service 
EGB Supplemental Marks PINs disabled for students sitting Supplemental Exams. Exams Office 
Supplemental Exam Results PINs re-enabled for students who sat Supplementals. Exams Office 
Module Registration PINs (not already re-enabled) are re-enabled by 'block'. Registration Service 

 

In the context of Online Programme Web Registration, we are concerned with ensuring that student PINs are re-enabled 
prior to the production of InfoPacks. Only when a student’s PIN is enabled will you be able to generate an InfoPack for 
the student. In most instances, student PINs should already have been re-enabled following the publication of ‘Online 
Exam Results’ on the Student Self-Service system. However, this may not always be the case and it is important to 
check students’ PIN status prior to the production of InfoPacks for a given group of students. 

You should not re-enable a student’s PIN from GZTPIND unless you are completely satisfied that it is correct to do so. 
Note that students who have outstanding fees from previous years are not permitted to register for the coming term until 
outstanding fees have been paid. They should have a PIN code of DPOF (Disable Pin Outstanding Fees). Therefore, 
their PIN should remain disabled, unless you have checked TSAAREV and are satisfied that outstanding fees have been 
paid. Only then should you re-enable a student’s PIN who had previously been DPOF.  

To re-enable a student’s PIN from GZTPIND, simply uncheck the ‘PIN Disabled?’ checkbox and save. 

Note: In the case of new students (including new CAO applicants), their PIN will be enabled by default. 

 

CHECKING STUDENT PIN STATUSES BY BLOCK 
It is possible to check the PIN status of all students on a given block code by running any the following three reports. 

I. Student PIN Disabled Reports – GZTPIND 
II. Student PIN Re-enabled Report - GZTPINE 

III. Audit of InfoPacks which have not been Generated – Business Objects 
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I. STUDENT PIN DISABLED REPORT - GZTPIND 
This report is available directly from Banner on form GZTPIND. To run the report, enter GZTPIND and from the menu 
select Options -> Student PIN Disabled Report 

 

You will be prompted with the following: 

 

Enter the Block Code required. 

Do not check ‘Complete History’. You only want to view the latest ‘Disable PIN reason code’. 

Select Produce Report to generate a list of all students with a disabled PIN status for the given Block Code.  

Only students with a disabled PIN status will appear. 
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II. STUDENT PIN RE-ENABLED REPORT – GZTPINE 
This report is available directly from Banner on form GZTPINE. To run the report, enter GZTPINE and from the menu 
select Options -> Student PIN Re-enabled Report 

 

You will be prompted with the following: 

 

Enter the Block Code required. 

Do not check ‘Complete History’. You only want to view the latest ‘Re-enabled PIN reason code’. 

Select Produce Report to generate a list of all students with a re-enabled PIN status for the given Block Code.  

 

Only students with a re-enabled PIN status will appear. 
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III. AUDIT OF INFOPACKS WHICH HAVE NOT BEEN GENERATED 
Assuming no InfoPacks have yet been generated, you could also run the ‘Audit of InfoPacks which have not been 
Generated’ report from Business Objects. 

This report will list all students for which an InfoPack has not yet been generated. For each student listed, it also 
includes detail on the PIN status and reason code.  

 

This report can therefore be used to verify the PIN status of students on the relevant Block. 

 

GTZPINE - RE-ENABLE PINS BY BLOCK 
GTZPINE is used to re-enable groups of student PINs by Programme & Year.   

Note: You can only re-enable PINs which have a reason code of DPOS (Disable PIN Off Season). PINs disabled with 
any other reason code will need to be manually re-enabled from GZTPIND, where appropriate. 

To re-enable PINs from GZTPINE, enter the following parameters: 

− Term Code 
− Programme 
− Year Code 

 

Then select ‘Re-enable PINs’. All students who have a pin disabled with the pin code DPOS (Disabled Pin End of 
Session) only will be re-enabled.   
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RESET PIN 
Once the Programme Web Registration system is open and students have commenced the online registration process, 
you may get queries in relation to student PINs. 

If a student cannot recall their PIN and is having difficulty answering their security question, it is possible to reset their 
PIN to their default one. This will be their date of birth DDMMYY or the last 6 digits of student ID (where no date of 
birth exists in Banner for the student). 

Note: You should always check GZTPIND, prior to resetting a student’s PIN. Only PINs that are ‘ENABLED’ should 
be reset. Otherwise, the PIN will be inadvertently re-enabled via the process of resetting it. 

GOATPAC – PIN ACCESS 
GOATPAC can be used to reset the student’s PIN.  

Remember you should always check GZTPIND before you reset a student’s PIN. Only students with an enabled PIN 
or Disabled Code of DPSG should have their PIN reset.   

To reset, simply select the ‘Reset Pin’ icon.  

You should notice a message at the bottom confirming same. 
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ADVANCED ENTRY & DIRECT APPLICATION STUDENTS 

The Admissions Office is responsible for processing ‘direct’ and ‘advanced-entry’ undergraduate applications. These 
applications are not processed by the CAO and are handled directly by DIT. 

Applications are processed in Banner by using QuickFlow ADMT. This QuickFlow will bring the user from setting up 
a new person record to the point of offering a student a place on a DIT programme. 

If the student accepts their offer on a DIT programme, the admissions office can then process this in Banner. Following 
this, the student’s registration record should be created in SFAREGS for the coming term with a status of EL (Eligible 
to Register) and their default grant codes saved in SZASGNT. The Registration Service should then be informed so that 
process of inviting the student to formally register and pay fees online can commence. 

 

ADMT ADMISSIONS DATA ENTRY QUICKFLOW 

ADMT is the QuickFlow used to create a new student application / acceptance record in Banner. The sequence of forms 
in this QuickFlow is as follows: 

 

SPAIDEN     
 

GOAINTL       
 

SOAHSCH         
 

SOAPCOL                
 

SAAADMS 
 
     SAADCRV 
    
      SGASTDN  
 
       SFAREGS 
 
        SZASGNT 
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SPAIDEN – GENERAL PERSON IDENTIFICATION 

The first form in this QuickFlow chain is SPAIDEN (General Person Identification). This is used to add the student’s 
name, personal details and to generate an ID number.    

Before you generate a new ID, you should you should always search the database to see if a person record already exists 
for the student. You can search for a student by selecting the ID drop-down and then Person Search.  You can also use 
form SOAIDNS for a more specific search. GUIALTI (Alternate ID Search) allows you to search by PPS no. and Date 
of Birth. 

Note: As a caveat to this, you should never re-use a CAO ID from the current term (i.e. students who have also applied 
to CAO in the same term). These IDs should be kept distinct and a new direct application ID should always be created.  

− To generate a number for the current term (e.g. 201314); use the Generate ID button.   
− To acquire a number for the next term (e.g. 201415); use the New Year ID button.  

 

You will notice the GENERATED or GENERNEXT text appears in the ID Field, depending on which option you 
choose. 

 

Once you have generated a new ID or used an existing one, you then select ‘next block’ (or CRTL Page Down) to enter 
information. Assuming you generated a new ID, you can now enter the person’s Last Name, First Name and any other 
relevant details as required in the relevant fields. Save (F10) when complete. You should now notice that the student 
number has been allocated to this record.  It is important to make a note of this number for your own reference. 

Next you will need to enter the Address Information. Choose the Address tab. 

Note: You can also navigate between the tabs by use of the ‘next block’ and ‘previous block’ Icons 

From here, select the ‘return’ key and today’s date will automatically populate the ‘From date’ field. Enter HM in the 
address type field to record a Home Address for the student. Then enter the address details in the appropriate fields.  

When entering the address information you will need to enter the address under the Street Line fields as well as the 
City, County, Nation and Carrier Route fields.   
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Address data as follow: 

− City: City of address 
− County Code: County codes including Dublin postal district codes. There is a look up table here. Double click 

to view 
− Nation Code: This is also a look up table. Double click to view. When entering the nation code enter the 

nation pertaining to the address, as opposed to the student’s nationality. 
− Carrier Route: This is used to record the accommodation type of the student for the purpose of HEA 

statistical returns. This is a free text field, but you must use the following two character codes only when 
entering this information: 

PH  Parental Home 
RA  Rented Accommodation 
OH  Own Home (house, apartment) 
OA  Other Accommodation  
NS Not Specified 
 

Note: You do not need to enter Sate or Zip code information. 

Save changes when complete. 

To enter another address at this point, you can enter a new record by selecting F6 and entering the relevant details as 
above. However, you should be aware that the most recent address entered will be the address used for written 
correspondence with the student. 

If an address record already exists but it is no longer valid, you can de-activate it and enter a new one. See the section 
on Updating Student’s Address for more information. 

Next, you click on the Telephone tab to enter the relevant telephone numbers for the student. You can enter a home, 
mobile or fax number here. 

Save (F10) this information when finished.  

 

The next tab is the Biographical information tab. On this tab, you must enter Gender, Date of Birth, SSN (PPS no.) 
and Citizenship.  All are mandatory for the purpose of HEA statistical returns. 

− Gender 
− Date of birth in the format day-month-year this will automatically populate the age box 
− Citizenship 
− PPSN number should be added into the box labeled SSN/SIN/TFN. 
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Save (F10) when complete. 

The next tab is the E-mail information tab. Select ‘next block’ to view/amend information. 

 

When inputting information, you must first enter an ‘email type’. The email type has a lookup table. You can view any 
look-up table by selecting the drop-down icon or simply selecting F9 (when the cursor is active in the relevant field). 
Once the type has been added, you can then enter the email address.  

Note: Never use the INST type as this is used for automatically generated DIT email addresses. Furthermore, this DIT 
student email address should never be manually changed from this form. 

Save (F10) when this information is entered. 

You have now completed the first form of this QuickFlow. To progress to the next form, simply exit this form by 
selecting the EXIT icon at the top right-hand corner. 
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GOAINTL – INTERNATIONAL IN FORMATION 

The next form available on the QuickFlow is GOAINTL and relates to Visa and Nationality Information.  

First, you need to ‘next block’ to get to the Visa Information section. Use the VISA type code box to enter the visa type 
if available. 

Note: If the student is Irish, enter NS 

F10 to save changes. 

 

Now select the Nationality tab. 

 

Enter the Nation of Birth by selecting from the drop down list.  This field is mandatory and must be entered.  If you 
already know the code, you can enter it directly. 

Save (F10) and exit the Form.
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SOAHSCH - HIGH SCHOOL IN FORMATION  

The next form is used to record information about student’s prior secondary level education.  Assuming the student ID 
field is already populated, select ‘next block’ to enter the High School Details section. 

 

You can now enter the secondary school that the student attended.  You can view a list of schools by selecting F9 or 
you can use the search icon which is to the right of the ‘High School’ field.  You will be brought directly into the list of 
secondary school institutions (SOISBGI) where you can search for a particular school by use of the search (F8) and % 
(wildcard) function.  
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Simply enter part of the school name in the ‘Name’ field and use the % (wildcard) character to assist (e.g. %Christian% 
to find all Christian Brother schools) 

 

Tip: The search is case-sensitive, so you should consider this when entering your search criteria (e.g. omit the first 
character of a word if you are unsure of its case.) 

Select F8 to execute the query. F7 clears the form for a new query. 

Note that these school codes are numeric. Once you have found the relevant school, double click on the ‘Code’ field 
and it will select the appropriate school and enter it on the main SOASCH form.  

Save (F10) when school details are entered and exit the form. 

 

SOAPCOL – PRIOR COLLEGE 

The next form is the Prior College SOAPCOL Form. This is where information about student’s prior third level 
education is held. Assuming the Student ID field is already populated, select ‘next block’ to enter the Prior College 
section.  

You can now enter the last college that the student attended.   

 

You can view a list of colleges by selecting F9 or selecting the search icon to the right of the Prior College field.  
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You will be brought directly into the list of third level institutions (SOISBGI). This list will initially appear blank. 
Select the query function (F8) to retrieve the full list of institutions. Select the desired institution by double clicking in 
the ‘Code’ field cell of the desired row selection.  

 

Your Prior College will be entered.  Once you have selected the relevant college code, you can now save at this point. 

You can also select and add information under the Degree Details section. If the student has graduated you should enter 
the relevant degree information including Degree, Degree Date and Year. 

 

 

Save (F10) and exit the Form. 

 

  



BANNER OPERATIONAL USER GUIDE 

 

Page 40 of 351 

SAAADMS – ADMISSIONS APPLICATION 

The next form that will open is SAAADMS.  This form is used to add the student’s application details. The first item 
that should be added to the key block is the correct Term (e.g. 201314). 

Note: Remember to use the ‘following year’ term code if you are generating an admissions record for next term. 

This first Block/Tab on the form is the Application Block. It displays information describing the applicant type, such as 
admission type and student type. This Block also displays a summary of the information from the Curricula tab for the 
relevant application. The following information must be added on the Application tab: 

− Admission Type (e.g. DA - Direct Applicant ; AE – Advanced Entry) 
− Student Type – (e.g. U – Undergraduate; X – Transfer In Own ; I – Transfer In Other) 
− Residency – ( E or N - European Union or Non European Union) 
− The F/T (fulltime) or P/T (Part time) indicator 
− Application Date – Defaults to system date 
− Application Status – C (Complete ready for review) 
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STUDENT TYPE 
The list of options for Student Type is as follows: 

N – New Entrant (An undergraduate student entering a Third Level education for the first time) 
U – Undergraduates (re-enrolling students on an undergraduate programme) 
P – Postgraduate Taught 
R – Postgraduate Research 
A – Apprentice 
C – Continuing Education 
D – Professional Development 
X - Transfer-In from own institution (This would apply to people who changed course within your institution) 
I - Transfer-In from other higher education institution (This would apply to people who changed courses from one 
institution to another) 
B - Repeat (Students repeating the same year of the same course for which they are primarily registered) 
 

Note: Direct Entry applicants will most likely be coded as N (New Entrants). Advanced Entry students will most likely 
be coded as per level of the programme (U,P)  or as X - Transfer-In Own / I – Transfer-In Other. 

Next, you go to the Curricula tab. Enter 1 for the Priority field and enter the relevant Programme Code in Program 
field. The other significant Programme details will default in. The curricula tab is used to record details of the 
Programme that the applicant is applying for (including Programme Code, Level & Degree Code). 

 

Note: The application will not save until you enter the programme information on the Curricula tab 
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EXCHANGE, DISTANCE, E-LEARNING OR VISITING OCCASIONAL STUDENTS 

If the student belongs to one of the options listed below, you will need to update accordingly under the ‘Fees, Mail 
Submission, Withdrawal Data’ tab.  

Session 
Code Exchange / Non Standard Attendance / Mode of Study Category 

S Exchange – Erasmus/ Socrates incoming exchange 
I Exchange – Other incoming exchange 
O Exchange – Outgoing Exchange 
C Distance Education 
L E-Learning 
N In-Service Education 
Q Postgraduate Qualifier 
V Visiting Occasional/JYA 1 Term 
J Visiting Occasional/JYA 2 Terms 
Y Visiting Occasional/JYA Full Year 
C Distance Education 
L E-Learning 
N In-Service Education 

  

Under the Additional Data section, select the appropriate option from the Session field. 

 

Save changes when complete. 

 
ATTRIBUTE CODE /  YEAR OF  STUDY 
Go to the Contacts, Cohorts and Attributes tab. Enter the programme year under Attribute field.  

 

F10 to save changes. 

 

Note: This data is very significant when it comes to student progression, e-mail generation and fee assessment and 
therefore must be entered. 

ADDITIONAL APPLICATIONS 
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If you wish to add further applications to this student record, return to the Application tab. From the menu, select 
Record ->Insert (alternatively you can use the down arrow key until a new blank record exists).  

 

A new record will be created for the given term. Enter the relevant information (as outlined above) and then enter the 
relevant curricula information under the Curricula tab, attribute under Contacts, Cohorts, Attributes tab and other 
information required. F10 to save and you will now have two applications associated with this record. You can repeat 
the same process over again for multiple applications .Each application can be reviewed from the Application tab by 
use of the scroll bar. 

F10 to save changes. Exit the form to proceed with the QuickFlow. 

SAADCRV – ADMISSIONS DECISION (GENERATING AN OFFER) 

The next form enables you to process the student’s application. First, ensure that both the ‘Student ID’ and the ‘Term’ 
of entry for the student are correct in the key block. Then select ‘next block’.  

All application details recorded on the previous form are recorded in Application Summary section.  If more than one 
application exists, you can scroll through the applications in the Application Summary section of the form.  Scroll down 
to find the Programme for which you wish to record an offer.  

Next, ensure you are active in the Decision Data (Application Decision) section of the form. When an offer is to be 
made to the student, a decision of IO (Offer Made by Institute) should be entered under Decision Code and saved 
against the correct Programme.  Save (F10) and you will see the message Decision Processed appear. Select OK to 
confirm this. 
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If you do not wish to process the applicant’s ‘acceptance’ at this point, you can choose to exit the QuickFlow 
completely by selecting from the menu File → Exit QuickFlow.  

 

 

Otherwise, proceed as outlined below. 

SAADCRV – ADMISSIONS DECISION (GENERATING AN ACCEPTANCE) 

If you wish to record an acceptance (assuming IO entry has already been recorded), simply enter AD (Applicant 
Accepted Offer) under previously entered IO Decision Code.  

Save using F10 and exit the form to proceed with the QuickFlow. 

  

 

  



BANNER OPERATIONAL USER GUIDE 

 

Page 45 of 351 

SGASTDN – GENERAL STUDENT  

The next in the QuickFlow is the General Student Form SGASTDN. Student details will only appear on this form if an 
accepted offer (AD) decision had previously been recorded against the student’s application. 

Before entering the form, ensure the ‘Term’ of entry and ‘Student ID’ are both correct and then select ‘next block’ to 
enter/view information. This is the Student Record.  This first Block/Tab is the Learner Block. This is used to view 
student information such as student status and student type. You will need to complete the following information: 

− Fee Assessment Rate – Full, Part or Overseas (Fees are assessed based on this coding). 
− F/P – F or P (this is the full or part-time indicator, indicating whether the student is studying this programme 

on a full or part-time basis). 
− In the Additional Information section, you should enter the relevant Block Code (Programme & Year of 

Study).  
− In the Additional Information section under Session field, you should also ensure exchange, distance, e-

learning or visiting occasional students are flagged, where applicable. See ‘Exchange / Distance/E-Learning’ 
section above for further information of relevant codes. 

 

 

 

Save (F10) when updates are made and complete. 
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SFAREGS - CREATIN G NEW ‘EL’ REGISTRATIONS RECORD 

Once a student has accepted a place on a DIT programme and has been processed accordingly in Banner, the student’s 
registrations record should then be saved in SFAREGS with an enrolment status of EL (Eligible to Register). 

Note: You can only create an active EL registrations record in SFAREGS for the current ‘active’ term. Therefore, if a 
student has accepted a place on a programme for the next academic term (i.e. in advance of the term roll process), 
Banner will not allow you to create the students registration record in SFAREGS. You must keep a list of these students 
and ensure that you create their ‘EL’ SFAREGS record and default grant record after term roll has completed. 

SFAREGS has a tabbed interface for easy navigation. Simply enter the ‘Term’ and ‘Student ID’ and select ‘next 
block’ to view / update details on the form. 

The form initially appears as follows: 

 

 

Under the Student Term tab, you can view / update detailed information about the student such as: 

− Student Type 
− Residence 
− Full or Part time indicator 
− Block schedule 
− Fee Assessment Rate. 
− Class (Attribute / Year of Study) 

 

Ensure that these details are entered correctly or make any amendments as required. 
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The Curricula tab allows you to view program related information for the student. You should also ensure that the 
details on this tab are as expected (i.e. Programme & Term data). 

 

Return to the Registration tab.  

The student’s status will be EL (Eligible to Register) at this point. Select ‘save’ twice. This will activate the student’s 
registrations record in Banner and trigger ‘Fee Assessment’.  

You should now expect to see the following message. Select OK to proceed. 

 

This will create the student’s registration record and the appropriate fees will be generated on the student’s account. 
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SZASGNT - CREATIN G THE DEFAULT GRANT RECORD 

Having created the student’s ‘EL’ registrations record, you must now save the student’s default grant record. 

Note: This step is only required for Full-Time students. If a student is Part-Time, simply ignore this step. 

To save a student’s default grant record, enter SZASGNT.  In the key block you enter the student’s ID and Term Code 
and ‘next block’ into the form. 

You will be prompted with the message ‘Setting Student Grant Defaults’. Select OK and the standard default funding 
codes for the programme will default against the student’s record. 

 

Level 6 / 7 programmes will have default funding codes of: 

− Funding Category: 03 (TLT Scheme) 
− Funding Maintenance: 30 (Non-Aided) 

 

Level 8 programmes will have default funding codes of: 

− Funding Category: 00 (Standard) 
− Funding Maintenance: 20 (Non-Aided) 

 

Note: More information in relation to grants can be found under the Fees and Grants section of this manual 

Save to commit changes to the grant record. The Registration Service should then be informed so that process of 
inviting the student to formally register and pay fees online can commence. 
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CHANGING A STUDENT’S ACCEPTANCE 
From time to time, it is be possible that an AD (accepted offer) was incorrectly recorded against a student application 
for a particular programme.  It may therefore be necessary to undo this and create a new AD (accepted offer) against a 
different programme application. 

However, this can only be done if the student’s registrations (SFAREGS) record has not yet been created and no fee / 
billing processes has yet assessed on the student’s account. If the latter has occurred, you cannot create a new 
acceptance record on SAADCRV. Instead, you need to update the student’s curricula / programme information directly 
from SFAREGS.  

Details of how to update a student’s programme information from SFAREGS is covered under the section ‘Changing a 
Student’s Programme on SFAREGS’. 

Note: Where a change is required to a student’s programme on SFAREGS you may need to liaise with Registrations. 
This is to ensure they are made aware of any changes, so they can follow up with the student if required (e.g. if another 
Invitation to Register needs to be sent to the student).  

If the student’s EL registrations record has not yet been created, you can change a student’s acceptance by following the 
steps outlined below: 

 

IN SGASADD ‘RECORD REMOVE’ THE STUDENTS ATTRIBUTE. 
− Enter SGASADD.  
− Input the Student ID & Term Code. 
− ‘Next block’ to twice to the Student Attribute section. 
− Highlight the existing attribute and select Record → Remove from the Menu. 
− You will be prompted with a Warning Alert. Select OK and save Changes. 

 

IN SGASTDN, SELECT EXISTING APPLICATION RECORD AND ‘RECORD REMOVE’ THE 
STUDENT’S CURRICULA RECORD. 

− Enter SGASTDN.  
− Input the Student ID and Term Code. 
− ‘Next block’ into form. 
− Select application record by use of scroll bar (if more than one exists) 
− From the menu select Record → Remove 
− You will be prompted with confirmation message. Select Yes to proceed. 

 

IN SAAADMS, ENTER STUDENT ATTRIBUTE AGAINST NEW APPLICATION RECORD 
− Enter SAAADMS. 
− Input the Student ID and Term Code. 
− ‘Next block’ into form. 
− Select correct application record (i.e. new application to be accepted) by use of scroll bar. 
− Once selected, go to the Contacts, Cohorts, Attributes tab. 
− Enter relevant year of entry for student under Attribute section. 
− Save changes. 
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IN SAADCRV, SELECT THE OLD APPLICATION RECORD AND INPUT AN RO 
(APPLICATION REJECTED) DECISION CODE. 

− Enter SAADCRV 
− Input the Student ID and Term Code. 
− ‘Next block’ into form. 
− Select old application record by scrolling through Application Summary section. 
− Under Decision Data section, enter an RO decision code against this application. 
− Select OK to Decision Processed prompt. 

 

IN SAADCRV, SELECT THE NEW APPLICATION RECORD AND INPUT AN IO (O FFER 
MADE) AND AD (APPLICANT ACCEPTED) DECISION CODE. 

− In SAADCRV for same Student ID and Term Code, return to Application Summary section 
− Select new application record by scrolling through applications. 
− Return to Decision Data section and enter an IO and AD decision code against this application. 
− Select OK to Learner Record Created prompt. 
− Save changes. 

 

You previous ‘accepted’ application has been rejected and a new application has been accepted. 
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PRODUCING WEB REGISTRATION INFORMATION PACK - SZAINFO 
Once direct or advanced entry registration records have been created with a status of EL, you can proceed with the 
production of Web Registration InfoPacks. 

However, you should note that you can only proceed with producing InfoPacks the day after the registrations record 
was initially created. Otherwise, their DIT email account will not yet be active and an InfoPack cannot be generated.  

Note: Before generating your first batch of InfoPacks, you should always ensure that your IE & Banner settings are 
configured correctly. Try generating a Student Details Report from SZANAVI to test that you can run reports from 
Banner in advance. Please see http://appupdates.dit.ie  for further details on the correct technical configuration for 
running Banner 8.5. 

When in a position to generate InfoPacks for advanced entry or direct applicants, SZAINFO is the form used to 
generate them. 

 

Parameters to be entered on this form are as follows: 

− Term Code (e.g. 201314) 
− Block Code (e.g. DT366/1) 
− Select checkbox for All Students (or enter individual student no.) 
− Signature & Title remain blank 
− Date parameters remain blank. 

 

The ‘Reprint?’ checkbox should only be checked if you wish to reprint InfoPacks for a block of students which have 
already been generated. 

When you are satisfied with the input parameters you have entered, simply select Generate Info Packs. 

You will then be prompted with the following message detailing the number of InfoPacks to be generated.  

http://appupdates.dit.ie/
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You should expect all ‘direct’ and ‘advanced entry’ students to be selected for ‘paper’ web packs. 

Note: Returning Students will receive their InfoPacks by ‘email’. This will be covered further under section ‘Returning 
Students Registration’. 

Simply select Proceed to continue with the generation of the paper packs. At which point, a new browser window will 
open with a PDF of all the web registrations letters. Each letter contains the student’s details and programme 
information along with instructions on how to logon to the DIT Programme Web Registration system. It will also 
include their logon details to their new DIT email account.  This can then be printed out and posted to the student.   

Upon receipt of this InfoPack letter, the student will be able to go online and register for their respective programme. 
Further information regarding Programme Registration is available on the Registration website. An instructional user-
guide for students is also available from this website.  

Following the generation of InfoPacks you should then check the InfoPack Audit Report for any InfoPacks that did 
not generate as expected. Further instruction on this process can be found under the section Audit of InfoPacks. 

Sample student letter: 
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REGISTRATIONS  
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Registration is the process by which students formally enlist on a given Programme and/or Module(s) within DIT. 
There are various modes by which this process can occur.  

First year applications to any undergraduate full-time programme are made directly through the Central Applications 
Office (CAO). When a student is offered and subsequently accepts a place on a DIT programme via the CAO, their 
registration record is automatically created on the Banner system with a status or EL (Eligible to Register). The student 
will then be invited to register and pay fees online using the DIT Online Programme Web Registration System. Once 
registered, their enrolment status on the Banner system will change to RE (Registered). 

Of course, not all applicants are processed via the CAO. Others may be direct, advanced-entry, international, 
apprentice or postgraduate applicants.  

Subsequent to ‘Programme Registration’, some students may need to choose what modules they will take for a given 
programme and year. This is the process of Module Registration. In most cases, students will interact with the online 
Student Self-Service Banner (SSB) system to complete Module Registration. 

 

CAO & NEW-ENTRANTS REGISTRATIONS 
When a student accepts a place at DIT via CAO (and files are loaded to Banner), their registration record is 
automatically created on the Banner system with a status or EL (eligible to register).  It is the responsibility of the 
Registrations Service to ensure that those students who are offered a place on a DIT programme are processed 
accordingly. In the first instance, they should expect to receive the appropriate communication inviting them to register 
online. 

As subsequent rounds of CAO offers and acceptances are processed, students may have the opportunity to supersede the 
previous acceptance. More information can be found under the Supercedes section below. 

Note: The only exceptions where students are not eligible to register online are those students with a residency of Non-
EU who are liable for the full international programme registration fee. They will be registered directly by the 
Registration Service to ensure that they are accurately fee assessed. See section on International Students for further 
information. 

 

PRODUCING WEB REGISTRATION INFORMATION PACKS - SZAINFO 

When you are ready to generate the first Programme Web Registration InfoPacks, you will need to confirm that the 
relevant student PINS are re-enabled. See section on Student PINs for further details. 

Assuming all relevant PINs are re-enabled, you can proceed with generating ‘Web Registration Information Packs 
(InfoPacks)’ letters for CAO new-entrant students. 

Note: Before generating your first batch of InfoPacks, you should always ensure that your IE & Banner settings are 
configured correctly. Try generating a Student Details Report from SZANAVI to test that you can run reports from 
Banner in advance. Please see http://appupdates.dit.ie  for further details on the correct technical configuration for 
running Banner 8.5. 

 

  

http://appupdates.dit.ie/
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CAO ROUND A AND ROUND 0 ACCEPTANCES 

The first batch of InfoPacks is generated for those students who have accepted a place on a DIT programme via the 
CAO Round A or Round O process. 

SZAINFO can be used to generate ITRs for a group of students based on date ranges (as opposed to block codes). This 
date range should reflect the timeframe for which students accepted their place on a Round A or Round 0 offer. 

Note: This functionality should not be used for other CAO applicants (namely Round 1 and later). 

 

To generate ITRs for Round A and Round 0 students, proceed as follows: 

− Enter Term Code 
− Enter Start Date of Round A / 0 acceptances 
− Enter End Date of Round A / 0 acceptances 
− Select Generate InfoPacks 

 

Note: You cannot select specific Block Codes or a Student ID when generating ITRs based on date ranges from Round 
A and Round 0. Once you enter your date ranges, the other input parameters on the form become locked. 

You will then be prompted with the following message detailing the number of InfoPacks to be generated.  

 

For CAO & New-Entrants, you should expect all InfoPacks to be ‘paper’ web packs.  

Simply select Proceed to continue with the generation of the paper packs. At which point, a new browser window will 
open with a PDF of all the web registrations letters. Each letter contains the student’s details and programme 
information along with instructions on how to logon to the DIT Programme Web Registration system. It will also 
include their logon details to their new DIT email account.  

This can then be printed out and posted to the student.   
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CAO ROUND 1 AND OTHER NEW ENTRANTS 

The next batch of InfoPacks to be generated from SZAINFO will be for CAO Round 1 students and all other new-
entrants.  

Parameters to be entered on this form are as follows: 

− Term Code (e.g. 201314) 
− Block Code (e.g. DT366/1) 
− Select checkbox for All Students (or enter individual student no.) 
− Signature & Title remain blank 
− Date parameters remain blank. 

 

The ‘Reprint?’ checkbox should only be checked if you wish to reprint InfoPacks for students which have already been 
generated. When you are satisfied with the input parameters you have entered, simply select Generate Info Packs. 

 

You will then be prompted with a message detailing the number of InfoPacks to be generated.  

For CAO & New-Entrants, you should expect all InfoPacks to be ‘paper’ web packs.  
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Note: Returning Students will receive their InfoPacks by ‘email’. This will be covered further under Returning Students 
Registration section. 

Simply select Proceed to continue with the generation of the paper packs. At which point, a new browser window will 
open with a PDF of all the web registrations letters. Each letter contains the student’s details and programme 
information along with instructions on how to logon to the DIT Programme Web Registration system. It will also 
include their logon details to their new DIT email account.  

This can then be printed out and posted to the student.  Sample student letter as follows: 

 

Upon receipt of this InfoPack letter, the student will be able to go online and register for their respective programme. 
Further information regarding Programme Registration is available on the Registration website. An instructional user-
guide for students is also available from this website. 

The generation of ITRs will continue for subsequent CAO rounds in line with the Registration Service Event calendar. 

Following the generation of InfoPacks for CAO New-Entrants, you should then check the InfoPack Audit Report for 
any InfoPacks that did not generate as expected. More information on this report can be found under the section Audit 
of InfoPacks 
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CAO SUPERCEDES 

Following each round of CAO offers and acceptances, students may be given the opportunity through CAO to 
supercede their previous acceptance with a new higher preference choice. This information will then be provided to DIT 
on the following day’s file load. 

The Registration Service is provided with a daily summary of both superceded and newly accepted students on DIT 
programmes.  

Supercedes may be either ‘internal’ or ‘external’.  

 

IN TERNAL SUPERCEDES 

‘Internal’ supercedes are students whose previous acceptance was also a DIT programme. Following the CAO load, 
these students will have their newly accepted DIT programme reflected on their registration record (SFAREGS) and on 
their grant record (SZASGNT).  

If the student had already registered (RE) on the previous programme, they will remain registered (RE) on their new 
programme. It is not necessary to re-generate an InfoPack for these students. 

If however, the student’s enrolment status is still ‘EL’ (eligible to register) then a new InfoPack should be generated for 
the student reflecting the new programme details. 

Note: Remember if the student had already received an InfoPack (as part of their previous DIT acceptance), then you 
will need to check the ‘re-print’ checkbox on SZAINFO when generating the student’s new InfoPack. GUIMAIL can be 
used to check if the student previously received an InfoPack. 

A new student ID card should also be generated for the student if they already received their ID card for the previous 
programme.  

SAADCRV – ADMISSIONS DECISION 
You can query applications made by a student including their superceded application on SAADCRV. You can use the 
scroll bar to the right of the ‘Application Summary’ section to query each application against the student’s record. You 
will notice a Superceded (SU) decision code recorded against the relevant programme. 
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EXTERNAL SUPERCEDES 

‘External’ supercedes are students who had previous accepted a place on a DIT programme and have now superceded 
that original choice with an offer on a programme at another third level institution. They are therefore no longer a 
prospective DIT student. 

No action is required by the Registration Service for ‘External Supercedes’.  

Note: If the student had completed the registration process and paid their registration fee, the Fees & Income office are 
notified for the purposed of issuing a refund to the student.  

Each student recorded will have been updated as follows: 

SFAREGS 
− Enrolment Status updated to PN (Person Not Attending) 
− Rate Code removed 
− Block Code removed. 

SGASADD 
− Student Attribute removed 

SGASTDN 
− Student Status updated to SU (Superceded) 

SZASGNT 
− Grant record removed 

SAADCRV 
− Application Decision on relevant programme update to SU (Superceded) 
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RETURNING STUDENT REGISTRATIONS 
Students who have been progressed to the new term and are therefore returning to DIT will also be invited to register 
and pay their fees online. Similarly to new-entrants, they should expect to receive the appropriate communication 
inviting them to register online. In contrast to new-entrants, their invitation to register online will be communicated by 
email rather than by letter. 

Note: The one exception to this is students with a residency on Non-EU, liable for the full international registration fee. 
These students will not be eligible to register online. They will be registered directly by the Registration Service to 
ensure that they are accurately assessed for the appropriate fees. See section on International Students for further 
information. 

 

PRODUCING WEB REGISTRATION INFORMATION PACK - SZAINFO 

When you are ready to generate the first Programme Web Registration InfoPacks for returning students, you will need 
to confirm that the relevant student PINS are re-enabled. See section on Student PINs for further details. 

Assuming all relevant PINs are re-enabled, you can proceed with generating ‘Web Registration Information Packs 
(InfoPacks)’. 

For returning students, their InfoPack will be emailed to their DIT student email account.  

Note: Before generating your first batch of InfoPacks, you should always ensure that your IE & Banner settings are 
configured correctly. Try generating a Student Details Report from SZANAVI to test that you can run reports from 
Banner in advance. Please see http://appupdates.dit.ie  for further details on the correct technical configuration for 
running Banner 8.5. 

SZAINFO is used to generate email InfoPacks for returning students. 

 

Parameters to be entered on this form are as follows: 

http://appupdates.dit.ie/
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− Term Code (e.g. 201314) 
− Block Code (e.g. DT366/2) 
− Select checkbox for All Students (or enter individual student no.) 
− Signature & Title remain blank. 
− Start Date & End Date remain blank 

 

The ‘Reprint?’ checkbox should only be checked if you wish to regenerate InfoPacks for students which have already 
been generated. When you are satisfied with the input parameters you have entered, simply select Generate Info Packs. 

You will then be prompted with the following message detailing the number of InfoPacks to be generated.  

 

You should expect all returning students to be selected for ‘email’ web packs. The only exceptions to this are students 
repeating 1st year and advanced entry students. They will be selected for ‘paper’ web packs.  

Simply select Proceed to continue with the generation of InfoPacks. At which point, you should then expect a 
confirmation message detailing the number of student emails sent. Any paper web packs should also generate in a 
separate browser window in the form of a PDF document. 

 

The InfoPack email inviting the student to register online is sent to the student’s DIT email address which they can 
access by visiting mydit.ie 

This email will list the student’s details, programme information and instructions on how to logon to the DIT 
Programme Web Registration system.  

 

 

http://www.mydit.ie/
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Sample email as follows: 

 

For this email to be sent to the student, their email address must be ‘active’. If the student’s email is not active, they will 
not be selected. More information of the criteria required for an InfoPack (letter or email) to generate can be found 
under the section Audit of InfoPacks. 

If there is a technical problem with the student’s email address and the email could not be sent, you will get the 
following error message. 

 

If you get this message, you should log it with the support desk for further investigation. 

Upon receipt of the email, returning students will now be in a position to log-on to the DIT Programme Web 
Registration system to register and pay their fees. Further information regarding Online Registration is available on the 
Registration website. An instructional user-guide is also available from this site. 
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AUDIT OF INFOPACKS 
The generation of InfoPacks from SZAINFO is dependent on the following criteria being met in Banner:  

– Web Registration is open. 
– Student has an active ‘EL (eligible to register)’ registrations record for the new term. 
– Student has a residency of E (EU).  
– Student’s PIN is enabled. 
– Student’s DIT email address is active. 
– Student has an active ‘Home Address’ record in Banner 
– Student has an F/P indicator on SFAREGS. 
– Student has a valid attribute (year of study) for the current Term. 
 

Upon generation of InfoPack for any block of students, you may have students who did not meet the above criteria and 
therefore for whom an InfoPack did not generate. 

INFOPACK AUDIT REPORT 

You can check for any InfoPacks that did not generate using the new ‘Audit of InfoPacks which have not been 
Generated’ report in Business Objects. This report is under the General Student Reports category. 

This report will list only those students on a ‘block’ for which an InfoPack did not generate.  

It will list the following: 

– Block Code 
– Student ID 
– Student Name 
– Enrolment Status 
– PIN Disable Flag 
– PIN Reason Code 
– Residency 
– Email Status 
– Email Address 
 

 

You should use the output of this report to determine whether any further action is required. 

The report will flag in red the item which may be preventing the generation of an InfoPack  
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(E.g. Enrolment Status – DI; PIN Disabled - Y; Residency – N) 

In some instances, it may be correct that an InfoPack did not generate for a given student. See example scenarios below. 

− Example 1: Student with a Residency on N (Non-EU). Non-EU students are not eligible to register online.  
− Example 2: Student has ‘deferred’ (Enrolment Status - DI), thus is not going to register online for coming 

academic term. 
− Example 3: Student PIN is disabled with reason code DPOF (Disabled Pin Outstanding Fees). On TSAAREV, 

you have confirmed that the student has outstanding fees from previous term. PIN Status Code is correct and 
student is not eligible to register online for coming academic term until outstanding fees have been paid. 

However, in other instances you may have expected an InfoPack to generate but hasn’t. Therefore further action may be 
required to enable the InfoPack to generate. Sample scenarios as follows: 

− Example 4: Student has an Email Status of N (New) or U (Updated). This infers that either the student 
registration’s record was only just created (N – New) or something was recently changed (U - Updated) on the 
student’s record. This may be a name change or programme change. In both case, this will not be updated to A 
(Active) until the following day. At which point, you should then be able to generate the InfoPack for the 
student. 

− Example 5: Student PIN disabled with reason code DPOS (Disable PIN Off-Season). This infers that the 
student’s PIN was never re-enabled prior to production of the Web Registration InfoPacks. You should check 
if this is the same for all students in the same Block Code. If so, you should re-enable the students’ PINs using 
GZTPINE. More information on re-enabling student’s PINs can be found under section ‘Student PINs’. 

 

QUERYING INFOPACK GENERATION AGAINST INDIVIDUAL STUDENT ID – 

GUIMAIL 

You can also query an individual student record directly in Banner to see if an InfoPack had generated for an individual 
student. 

You may want to do this if a student has a query regarding an InfoPack which they did not receive. 

To check if an InfoPack was generated for the student, open GUIMAIL in Banner. Enter the ‘Student ID’ and ‘next 
block’.  

 

A WEB_INFO entry for the current term will indicate that a web registration InfoPack (letter or email) was generated 
for the student. The quantity will indicate the no. of times it was generated (i.e. includes re-prints). 

Before re-printing a paper InfoPack for a student, you should confirm the student’s address details are correct to ensure 
the InfoPack will be posted to the right address. 
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QUERYING / UPDATING STUDENT’S REGISTRATIONS RECORD 
As indicated previously, in order for students to be properly registered, the student’s enrolment status will need to 
reflect ‘RE’ for registered. This should be triggered automatically in Banner when the student registers using the Online 
Web Registration system. However, it is also possible to manually register a student directly in SFAREGS for any 
students not registering online. 

 

SFAREGS – STUDENT COURSE REGISTRATION 

SFAREGS has a tabbed interface for easy navigation. It is used to update information on enrolment, registration, fee 
payments, subject details and class details. From here, a student can be manually registered against a defined list of 
CRNs, processed against a block code, have course information updated or take payment for fees. 

Simply enter the ‘Term’ and ‘Student Number’ and select ‘next block’ to view / update details on the form. 

The form appears as follows: 

 

 

Under the Student Term tab, you can view / update detailed information about the student such as student status, student 
type, Full or Part time and Block schedule. 
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UPDATING STUDENT TYPE (REPEAT OR TRANS FER STUDENTS) 

Note that all students entering DIT for the first time are always coded as: 

N - New Entrant  

 

Students continuing or re-enrolling on a particular programme of study will continue to be coded as per student level: 

A – Apprentice 
C – Continuing Education 
D – Professional Development 
P – Postgraduate 
R – Research 
U – Undergraduate 
 

However, as part of our obligation to return student data to the HEA annually, it is now required that where applicable 
we also code students according to the criteria below. Therefore if Student Type is considered to be a ‘transfer’ or 
‘repeat’ student, the student type should be updated as follows: 

 

Student Type Description 
X Transfer-In from own institution 
I Transfer-In from other higher education institution 
B Repeat (Students repeating the same year of the same course for which they are primarily registered) 
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Select the drop down list beside Student Type field to view list of available options. 

 

 

Save changes. 

The Curricula tab allows you to view or change program related information for the student.  

 

 

 

  



BANNER OPERATIONAL USER GUIDE 

 

Page 68 of 351 

CHANGING A STUDENT’S PROGRAMME ON SFAREGS 

To change a student’s curricula/program on SFAREGS, you should select ‘Replace’. 

Note: ‘Duplicate’ is used to progress a student to a new stage of the same Programme / Curricula. This process will be 
covered in further detail as part of the ‘part-time’ registrations section. 

When changing a student’s programme on SFAREGS you should do the following: 

− Select ‘Replace’ icon. This copies the existing curricula and makes it inactive. It also creates a new blank 
curriculum to add. 

− Update the Catalog Term to reflect current Term 
− Select the new Program Code in the Program field. 
− Select ‘return’ for other Programme fields to default. 
− Save your changes. 

 

Note: If you choose to change a student programme on SFAREGS, you should ensure that all other programme 
information including Block Code, Rate Code and Attribute are also updated as appropriate. The student’s grant will 
also require updating on to ensure it reflects the new programme code and funding rules. Further information on 
updating grant records available under ‘Fees and Grants’ section 

 

EFFECTIVE DATE ON SFAREGS 

You will notice that whenever you enter SFAREGS, the ‘Date’ in the key block field will always default to today’s date 
(i.e. system date). 

 

 

As a result when you ‘next block’ into SFAREGS, any changes you make will the effective from this date. In most 
instances this should be correct. However, you may occasionally be required to ‘back-date’ or make a retrospective 
change to a student’s record in Banner (e.g. a student withdrew from a course three months previously). In which case 
you should ensure that the Date you enter on the key block in SFAREGS reflects the date that the change is effective 
from. 

You can then ‘next block’ into SFAREGS, make any required updates and save. These updates will be effective from 
the date entered on the key block. 

 

WITHDRAWING / DEFERRING A STUDENT 

If you need to change a student status to withdrawn or deferred, this can be done by changing the Enrolment Status 
code on the Registration tab to the relevant withdrawn of deferred code. By selecting from the drop-down list, you will 
see the various codes options.  
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Once you select a code and press the ‘return’ or ‘tab’ key, you will be prompted with a ‘Student Grant Withdrawal 
Date’ pop-up.  

 

Simply confirm the date and save. This date will then be reflected as the end date on the student’s grant record. 

Withdrawal and Deferral Codes are date dependent. Therefore at any one point in time, only a selected list of codes will 
be available. If you need to back-date a withdrawal or deferral, you should ensure the correct effective date is entered in 
the key block initially (see above for further information on ‘Effective Dates in SFAREGS’). Furthermore, there are fee 
refund implications depending on the code used and date of selection. 

These codes and fee implications are outlined in detail on the Student Registration Fees Policy & Procedures - 
http://www.dit.ie/intranet/finance/policiesandprocedures/ 

 

REGISTERING STUDENTS ON CRNS 

Most full-time students are registered automatically on their CRNs (Modules) via the SoS script at the beginning of 
each semester. More information on this process is covered in the ‘Module Registration’ section of this manual. 

However, it is often necessary to manually register a student directly on CRN(s) through SFAREGS. This is due to 
some part-time programmes having fees associated with CRNs. Therefore, if web registration is being used for students 
where fees are attached to the CRNs it is important to ensure that the CRNs are set-up against the student’s records prior 
to sending out the web registrations packs. 

To attach a CRN to the Student Course Registration Form SFAREGS, select ‘next block’ twice. In the Course 
Information section you will need to enter the CRN code. This is typically a 5 character number. If you need to add 
more than one CRN, select F6 and enter the new code until you have entered all the subjects/CRNs the student is 
studying.  Save this form twice for Fee Assessment.  Payment can then be processed. 

 

 

 

http://www.dit.ie/intranet/finance/policiesandprocedures/
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CRNs are set-up against a given Part of Term (i.e. Semester). They may be Full Year (1), Semester 1 (S1) or Semester 2 
(S2).  

Similar to withdrawals and deferrals in SFAREGS, this implies there is a date dependency of registering students on 
CRNs. SFAREGS will therefore not allow you to register a student on a given CRN where the date is not within the 
given date range of the Semester associated with that CRN (e.g. you cannot register a student on a Semester 1 CRN in 
March). Again the use of effective date in the key block may be useful here where a user needs to retrospectively make 
changes effective in the past (as opposed to the current date). 

 

EMERGENCY CONTACT DETAILS - SPAEMRG 
As part of the online registration process, students are requested to enter emergency contact information. This 
information is captured so that the student’s next of kin can be contracted in case of an emergency. 

In order to review/amend these details in Banner, simply go to SPAEMRG.  

Enter the students ID and ‘next block’ into the form to review the student’s emergency contact details (priority 1 
record). Data can be amended as required.   

 

When inserting a next of kin record for a student who has not input their details online you should input the following: 

Priority of 1 

Relationship of this person to the student – select one of the following codes from the dropdown: 
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The surname for the contact person in the Last Name field and their forename in the First Name field 

The telephone number for the contact person in the Telephone fields  

Record the type as EM (emergency contact) in the Address Type field 

When you save the record OK the popup Note advising that No address exists for this address type. 

 

 

MEDICAL PRACTITIONER INFORMATION - SPAEMRG 
As part of the online registration process, students that have supplied details of their allergies are required to provide 
contact details for their Medical Practitioner. 

In order to review/amend these details in Banner, simply go to SPAEMRG.  

Enter the students ID and ‘next block’ into the form to review the student’s medical practitioner details (priority 2 
record).  Data can be amended as required. 
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When inserting a medical practitioner record for a student who has not input their details online you should input the 
following: 

Priority of 2 

Relationship of D (medical practitioner) 

The surname for the medical practitioner in the Last Name field and their forename in the First Name field 

Record the address type as DA (medical practitioner) in the Address Type field and the address for the medical 
practitioner in the street line, city and nation fields 

The telephone number for the medical practitioner in the Telephone fields  

Details of any specific treatment being undertaken are recorded on GOAMEDI. 

 

 

ALLERGEN QUESTIONNAIRE - GOAMEDI 
As part of the online registration process, students are requested to reply to an allergen questionnaire. 

The responses that the student has submitted online in reply to the questions, as well as allergy and relevant treatment 
details are recorded and can be queried in Banner, simply go to GOAMEDI. 
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Enter the students ID and ‘next block’ into the form to review the student’s responses to the Allergen Questionnaire. 
Data can be amended as required.   

The Question/Allergy is referenced in the ‘medical code’ field on the form; the yes/no response is displayed in the 
‘Disability Service’ field and the information input by the student for any reaction, treatment, diagnosis details are 
recorded in the ‘Comment’ field. 

 

Input the student’s ID and ‘next block’ into the form to manually record the student’s responses to the Allergen 
Questionnaire. 

Insert a record for AQ_FOOD code to record their reply to the ‘any significant food allergies’ question then input Y/N 
in the Disability Service field to indicate appropriate Yes or No response.   

  

Insert a record to record the Yes or No reply for each specific food allergen (DAIRY, GLUTEN, MOLLUSC. Etc.), 
including details of any treatment, diagnosis details in the ‘comment’ field.  The list of food allergen codes is as 
follows: 
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Details of any specific treatment being undertaken with their medical practitioner should be recorded against the 
DQ_Treat (DR detail treatment undertaken) medical code. 

Their response to the declaration that the information they have supplied is correct should be recorded against the 
AL_DECLAR (Declaration info correct) medical code. 
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STUDENT BEREAVEMENT PROTOCOL 

Information concerning the death of a student may come from a variety of different sources. Student Bereavement 
Protocol document outlines the protocol in relation to such a death.  

In the context of updating a deceased student’s record in Banner, the following steps should be followed. All other 
actions and communications should be addressed in accordance with the Student Bereavement Protocol guidelines. 

DECEASED STUDENT 

On receipt of the Bereavement Protocol Form issued by a Senior Manager advising that a student has died, you must 
follow the steps below to update to the student’s record in Banner: 

DROP STUDENT FROM ANY REGISTERED CRNS ON SFAREGS.  
− First check with the Exams office if the student has any grades entered against their registered CRNs before 

making the decision to drop them from their modules. 
Note: You can only ‘drop’ a student from CRNs which have not yet had grades rolled to Academic History. 

− Enter SFAREGS.  
− Enter Student ID, Date & Term in the key block and ‘next block’ into the form. 

Note:  You must enter an effective date within the range of the CRN semester. 
− Next block to the Course Information section. 
− Change Status of registered CRNs to DD (Drop).  
− Save changes twice to commit changes and trigger fee assessment. 

 

 

 

UPDATE STUDENT’S ENROLMENT STATUS TO DD (DECEASED) ON SFAREGS  
− Enter SFAREGS. 
− Enter Student ID, deceased Date & Term in the key block and ‘next block’ into the form. 
− Update enrolment status to DD (Deceased). 
− Select OK to message ‘Enrolment Status prohibits registration’. 
− Save changes twice to commit changes and trigger ‘fee assessment’. 
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CHECK ‘DECEASED’ INDICATOR ON SPAIDEN  
− Enter SPAIDEN. 
− Enter Student ID and ‘next block’ into the form. 
− Navigate to the Biographical tab. 
− Check the ‘Deceased’ checkbox. 
− Enter Deceased date. 
− Save changes. 

 

 

 

ENTER END-DATE ON GRANT FORM SZASGNT  
− Enter SZASGNT 
− Enter Student ID & Term and ‘next block’ into the form. 
− Enter deceased date of student as the End Date of the grant record 
− Save changes 

 

 

 

DECEASED GRADUATE 

On receipt of the Bereavement Protocol Form issued by the College Administrator advising that a graduate has died, 
you must update the graduate’s SPAIDEN record to reflect this. 

CHECK ‘DECEASED’ INDICATOR ON SPAIDEN  
− Enter SPAIDEN. 
− Enter Student ID and ‘next block. 
− Navigate to the Biographical tab. 
− Check the ‘Deceased’ checkbox. 
− Enter Deceased date. 
− Save changes. 

 

 

IN FORMING IN FORMATION SERVICES 
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Following updates to reflect a student / graduate’s status to ‘deceased’ in Banner, IS should be informed to ensure all 
other IS systems and data repositories are updated accordingly. A call should be logged with the IT Service Desk 
immediately to prompt this. Details should include: 

− Student ID Number 
− Student Name 
− Date of Birth 
− Date of Graduation (where applicable) 

 

SZANAVI – STUDENT NAVIGATION FORM 

To query student and registration related information, the first point of reference should be SZANAVI. This is a query 
‘read-only’ form and is useful for identifying and analysing any student and/or registration related queries. This form 
enables you to view a concise overview of Student Details, Financial Details, Address and Registration data. 

For further information on the use of SZANAVI, please refer to the ‘Introduction to Banner’ section. 
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PART-TIME REGISTRATIONS  
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Part-time students can also avail of the DIT Online Web Registration system. Online Registration for new students is 
covered under section ‘CAO & New Entrant Registrations’. Online registration for returning students is covered under 
section ‘Returning Student Registrations’. 

However in DIT, some part-time registrations are managed directly by the Registration offices and applicants are 
processed and registered directly in Banner. Consequently, part-time registrations QuickFlows have been designed to 
support this process. 

 
1ST YEAR STUDENTS – QUICKFLOW: PRG1 
PRG1 is the part-time registration QuickFlow used to process and register new part-time students to DIT. 

SAAQUIK – QUICK ENTRY 

The first form is SAAQUIK.  This form is used to create a new student record (including a newly generate Student ID). 

Before you generate a new ID, you should you should always search the database to see if a person record already exists 
for the student. You can search for a student by selecting the ID drop-down and then Person Search.  You can also use 
form SOAIDNS for a more specific search. GUIALTI (Alternate ID Search) allows you to search by PPS no. and Date 
of Birth. 

Note: As a caveat to this, you should never re-use a CAO ID from the current term (i.e. students who have also applied 
to CAO in the same term). These IDs should be kept distinct and a new direct application ID should always be created.  

The first form is SAAQUIK.  To create a new student record, select the Generate ID icon on the right. 

 

In the prompt box, enter the student’s last name and first name detail and then save.  Banner will generate a new student 
ID at this point.  Take note on the enrolment form of this number. 

Next, tab across to the ‘Term’ field and enter the academic term (e.g. 201213) and then to the level (e.g. UG).  The level 
is the level of the Programme the student is studying. Then select ‘next block’. 

 

When you ‘next block’, a dialogue box will appear. Select OK as this is just a note to inform you that certain values will 
be defaulted.  

Note that ‘Student Type’ defaults to the appropriate code depending on the Level entered in the key block. 
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AP – A (Apprentice) 
CE – C (Continuing) 
PD – D (Professional) 
PG – P (Postgraduate) 
PR – R (Research) 
UG – U (Undergraduate) 
 

However, if the student is entering a higher education programme for the first time, you must update the student level to 
reflect the fact that they are considered new entrants for the purpose of HEA returns. 

N – New Entrant 

Furthermore, if the student is transferring either from within DIT or from another higher education institution, you 
should update the student type as follows: 

X - Transfer-In from own institution 
I - Transfer-In from other higher education institution 
 

Now enter the following parameters: 

− Full or Part Time indicator (Part Time) 
− Rate: PART (Most part-time programmes have a PART rate code. However, some may have something 

different. Check this with your registrations officer if you are unsure.) 
 

 

Note: If you do not check the part-time indicator, then the payment options will not appear at registration point. 

You should also notice under the Application and Recruit Information section of SAAQUIK that the Admission Type 
defaults to DA.  

Assuming the student is a direct applicant (DA) into the 1st year of a part-time programme, no change is required here.  
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DA application into year 1 

However, if you are generating an Advanced Entry application for a student into 2nd or subsequent years of a part-time 
programme, the Admission Type should be updated to AE (Advanced Entry). This ensures that these students will be 
selected for paper ITRs as opposed to email ITRs. 

 

AE application into year 2 or subsequent years 

Next you navigate to the Curriculum section. To enter the Programme Code click on the Program field and enter the 
relevant Code and save. The other associated field entries will default in. 

 

Save at this point to create new student record. 
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Next you will need to enter the Address Information. Choose the Address tab. 

Note: You can also navigate between the tabs by use of the ‘next block’ and ‘previous block’ Icons 

From here, select the ‘return’ key and today’s date will automatically populate the ‘From date’ field. Enter HM in the 
address type field to record a Home Address for the student. Then enter the address details in the appropriate fields.  

When entering the address information you will need to enter the address under the Street Line fields as well as the 
City, County, Nation and Carrier Route fields.   

 

Address data as follow: 

− City: City of address 
− County Code: County codes including Dublin postal district codes. There is a look up table here. Double click 

to view 
− Nation Code: This is also a look up table. Double click to view. When entering the nation code enter the 

nation pertaining to the address, as opposed to the student’s nationality. 
− Carrier Route: This is used to record the accommodation type of the student for the purpose of HEA 

statistical returns. This is a free text field, but you must use the following two character codes only when 
entering this information: 

PH  Parental Home 
RA  Rented Accommodation 
OH  Own Home (house, apartment) 
OA  Other Accommodation  
NS Not Specified 
 

Note: You do not need to enter Sate or Zip code information. 

To enter another address at this point, you can enter a new record by selecting F6 and entering the relevant details as 
above. However, you should be aware that the most recent address entered will be the address used for written 
correspondence with the student. 

If an address record already exists but it is no longer valid, you can de-activate it and enter a new one. See the section 
on ‘Updating Student’s Address’ for more information. 

Finally on the Addresses tab, you can enter the student’s telephone details. You can select the Telephone Type (e.g. 
HM) from the drop-down list. 
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Save changes when complete. 

Next, select the Biographical Information tab. On this tab, you must enter Gender, Date of Birth, SSN (PPS no.) and 
Citizenship.  All are mandatory for the purpose of HEA statistical returns. 

− Gender 
− Date of birth in the format day-month-year this will automatically populate the age box 
− Citizenship 
− PPSN number should be added into the box labeled SSN/SIN/TFN. 

 

 

Save changes and exit the form. 

You have now completed the first form of this QuickFlow. To progress to the next form, simply exit this form by 
selecting the EXIT icon at the top right-hand corner. 

SPATELE – GENERAL PERSON TELEPHONE 

The next form is SPATELE. This allows you to add any additional telephone numbers you may not have previously 
entered on SAAQUIK.  

To enter telephone details, simply highlight a new ‘blank’ section. Enter the Telephone Type (e.g. MOBL) and tab 
across to enter the telephone number. Save upon completion and exit the form. 

 

GOAINTL – INTERNATIONAL IN FORMATION 

The next form available on the QuickFlow is GOAINTL and relates to Visa and Nationality Information.  
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First, you need to ‘next block’ to get to the Visa Information section. Use the VISA type code box to enter the visa type 
if available. 

Note: If the student is Irish, enter NS 

F10 to save changes. 

 

Now select the Nationality tab. 

 

Enter the Nation of Birth by selecting from the drop down list.  This field is mandatory and must be entered.  If you 
already know the code, you can enter it directly. 

Save (F10) and exit the Form. 
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SOAPCOL – PRIOR COLLEGE 

The next form is the Prior College SOAPCOL Form. This is where information about student’s prior third level 
education is held. Assuming the Student ID field is already populated, select ‘next block’ to enter the Prior College 
section.  

You can now enter the last college that the student attended.   

 

You can view a list of colleges by selecting F9 or selecting the search icon to the right of the Prior College field.  

 

You will be brought directly into the list of third level institutions (SOISBGI). This list will initially appear blank. 
Select the query function (F8) to retrieve the full list of institutions. Select the desired institution by double clicking in 
the ‘Code’ field cell of the desired row selection.  
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Your Prior College will be entered.  Once you have selected the relevant college code, you can now save at this point. 

You can also select and add information under the Degree Details section. If the student has graduated you should enter 
the relevant degree information including Degree, Degree Date and Year. 

 

 

Save (F10) and exit the Form. 
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SOAHSCH – HIGH SCHOOL IN FORMATION 

The next form is used to record information about student’s prior secondary level education.  Assuming the student ID 
field is already populated, select ‘next block’ to enter the High School Details section. 

 

You can now enter the secondary school that the student attended.  You can view a list of schools by selecting F9 or 
you can use the search icon which is to the right of the ‘High School’ field.  You will be brought directly into the list of 
secondary school institutions (SOISBGI) where you can search for a particular school by use of the search (F8) and % 
(wildcard) function.  
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Simply enter part of the school name in the ‘Name’ field and use the % (wildcard) character to assist (e.g. %Christian% 
to find all Christian Brother schools) 

 

Tip: The search is case-sensitive, so you should consider this when entering your search criteria (e.g. omit the first 
character of a word if you are unsure of its case.) 

Select F8 to execute the query. F7 clears the form for a new query. 

Note that these school codes are numeric. Once you have found the relevant school, double click on the ‘Code’ field 
and it will select the appropriate school and enter it on the main SOASCH form.  

Save (F10) when school details are entered and exit the form. 

 

SGASADD - ADDITIONAL STUDENT IN FORMATION FORM 

The next form is SGASADD.  Assuming the correct ‘Student ID’ and ‘Term’ has defaulted, you should ‘next block’ 
twice to enter the Student Attribute section.  

You will now need to record the correct student ‘year of study’. 

Simply enter the correct year under the Attribute Code and save. A warning prompt box will appear. 

 

 

Click OK, save and exit. 

SGASTDN – GENERAL STUDENT 
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The next form in the QuickFlow is the General Student Form SGASTDN.  

First, you need to ensure the ‘Term’ of entry for the student is correct and then select ‘next block’ to enter/view 
information. This is the Student Record.  This first Block/Tab is the Learner Block. This is used to view student 
information such as student status and student tab. All information such as Fee Assessment Rate, Student Type, 
Full/Part Indicator should already be there from entering it via the SAAQUIK form.  

However, you will also need to enter additional data in the Additional Information section 

− You should enter the relevant Block Code (Prog & Year) in the Block field.  
− Under Session field, you should also ensure exchange, distance, e-learning or visiting occasional students are 

flagged, where applicable. See section below for further information 
 

 

Save (F10) updates when complete. 

 

EXCHANGE, DISTANCE, E-LEARNING OR VISITING OCCASIONAL STUDENTS 

If the student belongs to one of the options listed below, you will need to update accordingly under the ‘Fees, Mail 
Submission, Withdrawal Data’ tab.  
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Session 
Code Exchange / Non Standard Attendance / Mode of Study Category 

S Exchange – Erasmus/ Socrates incoming exchange 
I Exchange – Other incoming exchange 
O Exchange – Outgoing Exchange 
C Distance Education 
L E-Learning 
N In-Service Education 
Q Postgraduate Qualifier 
V Visiting Occasional/JYA 1 Term 
J Visiting Occasional/JYA 2 Terms 
Y Visiting Occasional/JYA Full Year 
C Distance Education 
L E-Learning 
N In-Service Education 

  

Under the Additional Data section, select the appropriate option from the Session field. 

 

Save changes when complete. 

TSAACCT – ACCOUNT REVIEW FORM STUDENT 

The next form on the QuickFlow is TSAACCT. This is used to check what contracts the student is attached to for the 
current term. 

To enter the form, confirm the Student ID is correct in the key block and then ‘next block’ four times into the form. 
This will bring you to the Contracts section of the form. 

 

In most instances, you should expect this to be blank (i.e. no contracts attached to the student). 

DELETING CONTRACTS 
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However, if the student previously studied a full-time programme at DIT, it may be possible that they are incorrectly 
attached to a contract(s) for the current term (i.e. a contract from an old term inadvertently copied over to the new term). 

  

E.g. Student active on 3000-35 for the Term 201213.  

In most instances, part-time students are liable for their own fees and are not entitled to any funding from a third party 
(thus should not be attached to any contract). In order to delete a student from a contract simply enter a D against the 
Delete Indicator for the contract(s) in question and save changes. 

 

D indicator flagged against contracts for Term 201213 

Note: You do not need to ‘Delete’ contracts from previous terms. You should only be checking for any unexpected 
contracts for the current term that should be deleted. 

SFAREGS - STUDENT COURSE REGISTRATION FORM 

The final form is SFAREGS.  Again, ‘next block’ from the key block. 

 

Select the Student Term tab. If the Block Code has not already been entered, ensure you update it in the Block Schedule 
field.  Save and return to the Registration tab. 
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Where programme modules have fees attached, you should also ensure the student is registered on those modules before 
you process any payment. 

 

Saving twice on SFAREGS will then trigger ‘Fee Assessment’. 

Following this, you can generate an ITR (Invitation to Register) for the student so that the individual can register and 
pay fees online themselves. 

Alternatively, payment can be taken for a student (e.g. over the phone or in person).  Where appropriate, you should 
always set the student’s enrolment status to RE (registered) following a successfully payment. 

Note: The fee assessment process is triggered after making two saves on the Registration tab of the Student Record in 
SFAREGS. It is also updated automatically by a background process that runs daily. 
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2N D & SUBSEQUENT YEAR STUDENTS – QUICKFLOW: PRG2 

This PRG2 QuickFlow will manually progress a part-time student in Banner. Remember, students can also be 
progressed automatically as part of the progression process in the Progression section of this manual. 

SPAIDEN – GENERAL PERSON IDENTIFICATION 

The first form on this QuickFlow is SPAIDEN. This is used to update general person information such as a change of 
address or telephone information. 

To retrieve student details, enter the ID and select ‘next block’. You can then navigate to the relevant Tab (e.g. Address) 
and update data as required. 

 

UPDATING STUDENT’S ADDRESS 
In the case of updating the address details, be sure to insert new address records rather than over-typing the old address. 
To do this, simply select the Address tab. On the old address, enter a ‘to-date’ to reflect the end date of this address and 
check the Inactivate Address check-box.  

  

Then select F6 (to insert new record). Type in the relevant information such as Address Type, Street Line Details, City, 
County & Nation, Carrier Route. Then select F10 to save. You now have a new address record, but the old address 
record still exists as an inactive record. 

 

 

SGASADD – ADDITIONAL STUDENT IN FORMATION 
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The next form in the QuickFlow is SGASADD. This Form will enable you update the Student Attribute Code to reflect 
the correct Year of Study. 

Ensure the correct ‘ID’ and ‘Term’ is entered. The student ID will default from the previous screen. Your term should 
reflect the term the student is progressing to. Select ‘next block’ twice to enter the ‘Student Attribute’ section. You 
should notice the old term and Attribute Code.  You now need to update this to reflect the new attribute code for the 
new term. 

Select the Maintenance Icon. Choose Copy Student Attribute 

 

Select OK to the following prompt. 

 

You should now notice the old attribute code has been copied to the new term. You now need to remove this old 
attribute code. 

From the Menu, select Record -> Remove. 

 

Again, you will be prompted with the same previous ‘warning alert’. Select OK to proceed. Attribute Code should now 
be blank. 

Now enter the correct ‘Year of Study’ for the new term and save changes. Attribute Code should be updated for the new 
term. 
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Save changes and exit form. 

 

TSAACCT – ACCOUNT REVIEW FORM STUDENT 

The next form on the QuickFlow is TSAACCT. This is used to check what contracts the student is attached to for the 
current term. 

To enter the form, confirm the Student ID is correct in the key block and then ‘next block’ four times into the form. 
This will bring you to the Contracts section of the form. 

 

In most instances, you should expect this to be blank (i.e. no contracts attached to the student). 

DELETING CONTRACTS 
However, if the student previously studied a full-time programme at DIT, it may be possible that they are incorrectly 
attached to a contract(s) for the current term (i.e. a contract from an old term inadvertently copied over to the new term). 

 

 

E.g. Student active on 3000-35 for the Term 201213.  

In most instances, part-time students are liable for their own fees and are not entitled to any funding from a third party 
(thus should not be attached to any contract). In order to delete a student from a contract simply enter a D against the 
Delete Indicator for the contract(s) in question and save changes. 
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D indicator flagged against contracts for Term 201213 

Note: You do not need to ‘Delete’ contracts from previous terms. You should only be checking for any unexpected 
contracts for the current term that should be deleted. 

 

SFAREGS - STUDENT COURSE REGISTRATION FORM 

On entering the last form SFAREGS, ensure the correct term (i.e. Term student is progressing to) and student ID is in 
the key block field. Then select ‘next block’. 

 

PROGRESS STUDENT’S CURRICULA TO NEW TERM ON SAME PROGRAMME 
Firstly, you should navigate to the Curricula tab. You now need to manually progress the student’s registration record 
to the new term. To do this you need to select the ‘Duplicate’ icon.  

 

 

 

 

This creates a copy of the existing curricula record for the new Term. Save changes when complete. 
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PROGRESS STUDENT’S CURRICULA TO NEW TERM ON DIFFERENT PROGRAMME 
Where a student is progressing to a different Programme, you will need to replace the student’s curriculum with the new 
Programme. You must therefore select the ‘Replace’ icon.  

 

This copies the old curricula, makes it inactive and creates a new blank curriculum.  
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You should then update the curriculum details relevant to the new Programme codes. 

− Update the Catalog Term to reflect current Term (i.e. Term you are progressing to) 
− Ensure the Priority in set to 1. 
− Enter the new Program Code in the Program field. 
− Select ‘return’ and other Programme fields will default. 
− Save your changes. 

 

UPDATE BLOCK CODE 
Next, you should navigate to the Student Term tab. Update the Block Schedule field as appropriate for the new year of 
Study. 
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UPDATE STUDENT TYPE 
Under the same tab (i.e. Student Term) you may also need to update the Student Type. If the student was previously a 
new entrant (N) and is now being progressed the next term, then you must update the student type appropriately. 
Students continuing or re-enrolling on a particular programme of study will have a student type corresponding to their 
student level:  

A – Apprentice 
C – Continuing Education 
D – Professional Development 
U – Undergraduate 
P – Postgraduate 
R – Research 
However, as part of our obligation to return student data to the HEA annually, it is now required that where applicable, 
we also code students according to the criteria below. Therefore if Student Type is considered to be a ‘transfer’ or 
‘repeat’ student, the student type should be updated as follows: 

Student Type Description 
X Transfer-In from own institution 
I Transfer-In from other higher education institution 
B Repeat (Students repeating the same year of the same course for which they are primarily registered) 
 
Select the drop down list beside Student Type field to view list of available options. 
Note: You may also be required to update other fields on this tab if necessary (e.g. if the Rate Code is different for the 
new Term) 

You should now navigate to the Registration tab.  

Where programme modules have fees attached, you should also ensure the student is registered on those modules before 
you process any payment. 

Saving twice on SFAREGS will then trigger ‘Fee Assessment’ and the payment options should now appear at the 
bottom of the form. Payment can now be taken for a student.  

Alternatively, you can opt to save the registration record as EL (Eligible to Register). Following this, you can generate 
an ITR (Invitation to Register) for the student so that the individual can register and pay fees online themselves. 

 

SGASTDN – GENERAL STUDENT 

The final form in the QuickFlow is the General Student Form SGASTDN.  

Again, you need to ensure the term (i.e. progression term) for the student is correct and then select ‘next block’ to 
enter/view information. This is the Student Record.  This first Block/Tab is the Learner Block. This is used to view 
student information such as student status and student tab. All information such as Fee Assessment Rate, Student Type, 
Full/Part Indicator should already be there having just progressed the student from the previous term. 

The only thing you need to check on this form is to flag a student as exchange, distance, e-learning or visiting 
occasional students, where applicable. If this does not apply to this particular student, simply exit the form. 

 

Alternatively, if this was entered for a particular student on a previous term and no longer applies, ensure it is removed 
for the current term record. 
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EXCHANGE, DISTANCE, E-LEARNING OR VISITING OCCASIONAL STUDENTS 
If the student belongs to one of the options listed below, you will need to update accordingly on the Session field 
(Additional Information section).  

 

Session 
Code Exchange / Non Standard Attendance / Mode of Study Category 

S Exchange – Erasmus/ Socrates incoming exchange 
I Exchange – Other incoming exchange 
O Exchange – Outgoing Exchange 
C Distance Education 
L E-Learning 
N In-Service Education 
Q Postgraduate Qualifier 
V Visiting Occasional/JYA 1 Term 
J Visiting Occasional/JYA 2 Terms 
Y Visiting Occasional/JYA Full Year 
C Distance Education 
L E-Learning 
N In-Service Education 

  

Save (F10) when complete. 
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POSTGRADUATE TAUGHT 
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The Postgraduate Office is responsible for processing applications for postgraduate programmes in DIT. Applications 
are processed in Banner by using QuickFlows PGRD.  

If the student accepts their place on a DIT postgraduate programme, the postgraduate office can then process this in 
Banner. Following this, the student’s registration record should be created in SFAREGS for the coming term with a 
status of EL (Eligible to Register). The Registration Service should then be informed so that the process of inviting the 
student to register and pay fees online can commence 

 

PGRD - POSTGRAD STUDENT APPLICATION QUICKFLOW 

PGRD is the QuickFlow used to create a new postgraduate student application in Banner. The sequence of forms in this 
QuickFlow is as follows: 

 

SPAIDEN     

GOAINTL       

SOAPCOL         

SAAADMS 

SAADCRV       

     SGASTDN 

SGASADD 

       SFAREGS 

        SZASGNT 

            

 



BANNER OPERATIONAL USER GUIDE 

 

Page 103 of 351 

SPAIDEN – GENERAL PERSON IDENTIFICATION 

The first form in this QuickFlow chain is SPAIDEN (General Person Identification). This is used to add the student’s 
name and to generate an ID number.    

Before you generate a new ID, you should you should always search the database to see if a person record already exists 
for the student. You can search for a student by selecting the ID drop-down and then Person Search.  You can also use 
form SOAIDNS for a more specific search. GUIALTI (Alternate ID Search) allows you to search by PPS no. and Date 
of Birth. 

Note: As a caveat to this, you should never re-use a CAO ID from the current term (i.e. students who have also applied 
to CAO in the same term). These IDs should be kept distinct and a new direct application ID should always be created.  

− To generate a number for the current term (e.g. 201314); use the Generate ID button.   
− To acquire a number for the next term (e.g. 201415); use the New Year ID button.  

 

You will notice the GENERATED or GENERNEXT text appears in the ID Field, depending on which option you 
choose. Once you have generated a new ID or used an existing one, you then select ‘next block’ (or CRTL Page Down) 
to enter information.   

 

Assuming you generated a new ID, you can now enter the person’s Last Name, First Name and any other relevant 
details as required in the relevant fields. Save (F10) when complete. You should now notice that the student number has 
been allocated to this record.  It is important to make a note of this number for your own reference. 

Next you will need to enter the Address Information. Choose the Address tab. 

Note: You can also navigate between the tabs by use of the ‘next block’ and ‘previous block’ Icons 

From here, select the ‘return’ key and today’s date will automatically populate the ‘From date’ field. Enter HM in the 
address type field to record a Home Address for the student. Then enter the address details in the appropriate fields. 
When entering the address information you will need to enter the address under the Street Line fields as well as the 
City, County, Nation and Carrier Route fields.  

 

Address data as follow: 
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− City: City of address 
− County Code: County codes including Dublin postal district codes. There is a look up table here. Double click 

to view 
− Nation Code: This is also a look up table. Double click to view. When entering the nation code enter the 

nation pertaining to the address, as opposed to the student’s nationality. 
− Carrier Route: This is used to record the accommodation type of the student for the purpose of HEA 

statistical returns. This is a free text field, but you must use the following two character codes only when 
entering this information: 

PH  Parental Home 
RA  Rented Accommodation 
OH  Own Home (house, apartment) 
OA  Other Accommodation  
NS Not Specified 
 

Note: You do not need to enter Sate or Zip code information. 

Save changes when complete. 

To enter another address at this point, you can enter a new record by selecting F6 and entering the relevant details as 
above. However, you should be aware that the most recent address entered will be the address used for written 
correspondence with the student. 

If an address record already exists but it is no longer valid, you can de-activate it and enter a new one. See the section 
on ‘Updating Student’s Address’ for more information. 

Next, you click on the Telephone tab to enter the relevant telephone numbers for the student. You can enter a home, 
mobile or fax number here. 

Save (F10) this information when finished.  

 

The next tab is the Biographical information tab. On this tab, you must enter Gender, Date of Birth, SSN (PPS no.) 
and Citizenship.  All are mandatory for the purpose of HEA statistical returns. 

− Gender 
− Date of birth in the format day-month-year this will automatically populate the age box 
− Citizenship 
− PPSN number should be added into the box labeled SSN/SIN/TFN. 
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Save (F10) when complete. 

The next tab is the E-mail information tab. Select ‘next block’ to view/amend information. 

 

When inputting information, you must first enter an ‘email type’. The email type has a lookup table. You can view any 
look-up table by selecting the drop-down icon or simply selecting F9 (when the cursor is active in the relevant field). 
Once the type has been added, you can then enter the email address.  

Note: Never use the INST type as this is used for automatically generated DIT email addresses. Furthermore, this DIT 
student email address should never be manually changed from this form. 

Save (F10) when this information is entered. 

You have now completed the first form of this QuickFlow. To progress to the next form, simply exit this form by 
selecting the EXIT icon at the top right-hand corner. 
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GOAINTL – INTERNATIONAL IN FORMATION 

The next form available on the QuickFlow is GOAINTL and relates to Visa and Nationality Information.  

First, you need to ‘next block’ to get to the Visa Information section. Use the VISA type code box to enter the visa type 
if available. 

Note: If the student is Irish, enter NS 

F10 to save changes. 

 

Now select the Nationality tab. 

 

Enter the Nation of Birth by selecting from the drop down list.  This field is mandatory and must be entered.  If you 
already know the code, you can enter it directly. 

Save (F10) and exit the Form. 
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SOAPCOL – PRIOR COLLEGE 

The next form is the Prior College SOAPCOL Form. This is where information about student’s prior third level 
education is held. Assuming the Student ID field is already populated, select ‘next block’ to enter the Prior College 
section.  

You can now enter the last college that the student attended.   

 

You can view a list of colleges by selecting F9 or selecting the search icon to the right of the Prior College field.  

 

You will be brought directly into the list of third level institutions (SOISBGI). This list will initially appear blank. 
Select the query function (F8) to retrieve the full list of institutions. Select the desired institution by double clicking in 
the ‘Code’ field cell of the desired row selection.  
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Your Prior College will be entered.  Once you have selected the relevant college code, you can now save at this point. 

Note: Code 99 (Other) is used to record any third level institution outside of Ireland. 

You can also select and add information under the Degree Details section. If the student has graduated you should enter 
the relevant degree information including Degree, Degree Date and Year. 

 

 

Save (F10) and exit the Form. 
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SAAADMS – ADMISSIONS APPLICATION 

The next form that will open is SAAADMS.  This form is used to add the student’s application details. The first item 
that should be added to the key block is the correct Term (e.g. 201314). 

Note: Remember to use the following year term code if you are generating an admissions record for next term. 

This first Block/Tab on the form is the Application Block. It displays information describing the applicant type, such as 
admission type and student type. This Block also displays a summary of the information from the Curricula tab for the 
relevant application. The following information must be added on the Application tab: 

− Admission Type:DA - Direct Applicant 
− Student Type: P – Postgraduate 
− Residency:  E or N - European Union or Non European Union 
− The F/T (fulltime) or P/T (Part time) indicator 
− Application Date – Defaults to system date 
− Application Status – C (Complete ready for review) 

 

  

Next, you go to the Curricula tab. Enter 1 for the Priority field and enter the relevant Programme Code in Program 
field. The other significant Programme details will default in. The curricula tab is used to record details of the 
Programme the applicant in applying for (including Programme Code, Level & Degree Code). Save changes. 

Note: The application will not save until you enter the programme information on the Curricula tab 
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ATTRIBUTE CODE /  YEAR OF  STUDY 
Go to the Contacts, Cohorts and Attributes tab. Enter the programme year under Attribute field.  

 

F10 to save changes. 

Note: This data is very significant when it comes to student progression, e-mail generation and fee assessment and 
therefore must be entered. 

ADDITIONAL APPLICATIONS 
If you wish to add further applications to this student record, return to the Application tab. From the menu, select 
Record ->Insert (alternatively you can use the down arrow key until a new blank record exists).  

 

A new record will be created for the given Term. Enter the relevant information (as outlined previously) and then enter 
the relevant curricula information under the Curricula tab, attribute under Contacts, Cohorts, Attributes tab and other 
information required. F10 to save and you will now have two applications associated with this record. You can repeat 
the same process again for multiple applications. Each application can be reviewed from the Application tab by use of 
the scroll bar. 

F10 to save changes when complete.  Exit the form to proceed with the QuickFlow. 

 

SAADCRV – ADMISSIONS DECISION (GENERATING AN OFFER) 

The next form enables you to process the student’s application. First, ensure that both the ‘Student ID’ and the ‘Term’ 
of entry for the student are correct in the key block. Then select ‘next block’.  

All application details recorded on the previous form are recorded in Application Summary section.  If more than one 
application exists, you can scroll through the applications in the Application Summary section of the form.  Scroll down 
to find the Programme for which you wish to record an offer.  

Next, ensure you are active in the Decision Data (Application Decision) section of the form. When an offer is to be 
made to the student, a decision of IO (Offer Made by Institute) should be entered under Decision Code and saved 
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against the correct Programme.  Save (F10) and you will see the message Decision Processed appear. Select OK to 
confirm this. 

 

If you do not wish to process the applicant’s ‘acceptance’ at this point, you can choose to exit the QuickFlow 
completely by selecting from the menu File → Exit QuickFlow.  

 

 

Otherwise, proceed as outlined below. 

 

SAADCRV – ADMISSIONS DECISION (RECORDING AN ACCEPTANCE) 

If you wish to record an acceptance (assuming IO entry has already been recorded), simply enter AD (Applicant 
Accepted Offer) under previously entered IO Decision Code.  

Save using F10 and exit the form to proceed with the QuickFlow. 
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SGASTDN – GENERAL STUDENT  

The next in the QuickFlow is the General Student Form SGASTDN. Student details will only appear on this form if an 
accepted offer (AD) decision had previously been recorded against the student’s application. 

Before entering the form, ensure the ‘Term’ of entry and ‘Student ID’ are both correct and then select ‘next block’ to 
enter/view information. This is the Student Record.  This first Block/Tab is the Learner Block. This is used to view 
student information such as student status and student type. You will need to complete the following information: 

− Fee Assessment Rate – Full, Part or Overseas (Fees are assessed based on this coding). 
− F/P – F or P (this is the full or part-time indicator, indicating whether the student is studying this programme 

on a full or part-time basis). 
− In the Additional Information section, you should enter the relevant Block Code (Programme & Year of 

Study).  
 

 

Save (F10) when updates are completed. 
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SGASADD - ADDITIONAL STUDENT IN FORMATION FORM 

The next form is SGASADD.  Assuming the correct ‘Student ID’ and ‘Term’ has defaulted, you should ‘next block’ 
twice to enter the Student Attribute section. If you have already entered the correct year of study at the point of 
recording a student application (SAAADMS), you will see this recorded here. No further action is required and you can 
exit the form to proceed. 

However, if there is no entry under the Attribute Code, you will now need to record the correct student ‘year of study’. 

Simply enter the correct year under the Attribute Code and save. A warning prompt box will appear. 

 

 

Click OK, save and exit. 
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SFAREGS – CREATING NEW ‘EL’ REGISTRATIONS RECORD. 

Once a student has accepted a place on a DIT programme and has been processed accordingly in Banner, the student’s 
registrations record should then be saved in SFAREGS with an enrolment status of EL (Eligible to Register). 

Note: You can only create an active EL registrations record in SFAREGS for the current ‘active’ term. Therefore, if a 
student has accepted a place on a programme for the next academic term (i.e. in advance of the term roll process), 
Banner will not allow you to create the students registration record in SFAREGS. You must keep a list of these students 
and ensure that you create their ‘EL’ SFAREGS record and default grant record after term roll has completed. 

SFAREGS has a tabbed interface for easy navigation. Simply enter the ‘Term’ and ‘Student ID’ and select ‘next 
block’ to view / update details on the form. 

The form initially appears as follows: 

 

Under the Student Term tab, you can view / update detailed information about the student such as: 

− Student Type 
− Residence 
− Full or Part time indicator 
− Block schedule 
− Fee Assessment Rate. 
− Class (Attribute / Year of Study) 

 

Ensure that these details are entered correctly or make any amendments as required. 
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The Curricula tab allows you to view program related information for the student. You should also ensure that the 
details on this tab are as expected (i.e. Programme & Term data). 

 

Return to the Registration tab. The student’s status will be EL (Eligible to Register) at this point. Select ‘save’ twice. 
This will activate the student’s registrations record in Banner and trigger ‘Fee Assessment’.  

You should now expect to see the following message. Select OK to proceed. 

 

This will create the student’s registration record and the appropriate fees will be generated on the student’s account. 
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CREATING THE DEFAULT GRANT RECORD -  SZASGNT 

Having created the student’s ‘EL’ registrations record, the last step is to save the student’s default grant record. 

Note: This step is only required for Full-Time students. If a student is Part-Time, simply ignore this step and exit the 
form. 

To save a student’s default grant record, enter SZASGNT.  In the key block you enter the student’s ID and Term Code 
and ‘next block’ into the form. 

 

You will be prompted with messages ‘Setting Student Defaults’ and ‘Contract numbers cannot be established. Select 
OK to both prompts. 

The default funding codes for ‘postgraduate self-support’ will go against the student’s grant record. 

− Funding Category: 16 (Post Graduate Self Support) 
− Funding Maintenance: 20 (Non Aided) 

 

Note: More information in relation to grants can be found under the ‘Fees and Grants’ section of this manual 

Save to commit changes to the grant record. The Registration Service should then be informed so that process of 
inviting the student to formally register and pay fees online can commence. 
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CHANGING A STUDENT’S ACCEPTANCE RECORD 
If the student originally accepted an offer but has decided to not take up a place in DIT, you should update the student’s 
record in Banner as follows: 

− Enrolment status on SFAREGS change to PN (Person Not Attending)  
− Decision Code on SAADCRV updated to RO (Applicant Rejected Offer). 

 
Note: You should only update a student’s enrolment status to PN if it was previously flagged as EL (Eligible to 
Register) on SFAREGS. If a student has already registered (RE) at the time you wish to make this change, you will need 
to contract the Registration Service so that they can formally withdraw the student. 

From time to time, it may also be possible that an AD (accepted offer) was incorrectly recorded against a student 
application for a particular programme.  It may therefore be necessary to undo this and create a new AD (accepted 
offer) against a different programme application. Details of how this can be processed are noted under the Admitting 
Students section of this manual. 

PRODUCING WEB REGISTRATION INFORMATION PACK - SZAINFO 
Once postgraduate student records have been created with a status of EL, you can proceed with the production of Web 
Registration InfoPacks. However, you should note that you can only proceed with producing InfoPacks the day after the 
registrations record was initially created. Otherwise, their DIT email account will not yet be active and an InfoPack 
cannot be generated.  

Note: Before generating your first batch of InfoPacks, you should always ensure that your IE & Banner settings are 
configured correctly. Try generating a Student Details Report from SZANAVI to test that you can run reports from 
Banner in advance. Please see http://appupdates.dit.ie  for further details on the correct technical configuration for 
running Banner 8.5. 

SZAINFO is used to generate InfoPacks. 

 

Parameters to be entered on this form are as follows: 

http://appupdates.dit.ie/
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− Term Code (e.g. 201314) 
− Block Code (e.g. DT329/1) 
− Select checkbox for All Students (or enter individual student no.) 
− Signature & Title remain blank 
− Date parameters remain blank. 

 

The ‘Reprint?’ checkbox should only be checked if you wish to reprint InfoPacks for a block of students which have 
already been generated. 

When you are satisfied with the input parameters you have entered, simply select Generate Info Packs. 

You will then be prompted with the following message detailing the number of InfoPacks to be generated. You should 
expect all new postgraduate students to be selected for ‘paper’ web packs. 

 

Note: Returning Students will receive their InfoPacks by ‘email’. This will be covered further under section ‘Returning 
Students Registration’. 

Simply select Proceed to continue with the generation of the paper packs. At which point, a new browser window will 
open with a PDF of all the web registrations letters to be printed and sent to the relevant students. 

Simply select Proceed to continue with the generation of the paper packs. At which point, a new browser window will 
open with a PDF of all the web registrations letters. Each letter contains the student’s details and programme 
information along with instructions on how to logon to the DIT Programme Web Registration system. It will also 
include their logon details to their new DIT email account.  

This can then be printed out and posted to the student.   

Upon receipt of this InfoPack letter, the student will be able to go online and register for their respective programme. 
Further information regarding Programme Registration is available on the Registration website. An instructional user-
guide for students is also available from this website.  

Following the generation of InfoPacks you should then check the InfoPack Audit Report for any InfoPacks that did 
not generate as expected. Further instruction on this process can be found under the section Audit of InfoPacks. 

Sample student letter overleaf: 

 

 

 

Sample student letter as follows: 
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POSTGRADUATE RESEARCH 
STUDENTS 
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Postgraduate Research student applications and set-up are managed by the Postgraduate Research office. In order to 
simplify the process of setting up new postgraduate research student records in Banner, a QuickFlow has been 
developed. This QuickFlow will automatically bring users through the appropriate screens / forms in Banner. This 
QuickFlow is called PGRES.  

 

PGRES – POSTGRADUATE RESEARCH QUICKFLOW 

The sequence of forms in the PGRES QuickFlow is as follows: 

 

SAAQUIK     

GOAINTL       

SOAPCOL          

SGASADD                

SGASDTN 

     SFAREGS 

        SGAUSDF  

     

 

 

SAAQUIK – QUICK ENTRY 

The first form is SAAQUIK.  This form is used to create a new student record (including a newly generate Student ID). 

Before you generate a new ID, you should you should always search the database to see if a person record already exists 
for the student. You can search for a student by selecting the ID drop-down and then Person Search.  You can also use 
form SOAIDNS for a more specific search. GUIALTI (Alternate ID Search) allows you to search by PPS no. and Date 
of Birth. 

Note: As a caveat to this, you should never re-use a CAO ID from the current term (i.e. students who have also applied 
to CAO in the same term). These IDs should be kept distinct and a new direct application ID should always be created.  
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To generate a number for the current term (e.g. 201314); use the Generate ID button.   

  

In the prompt box, enter the student’s name details and then save. 

Banner will generate a new student ID at this point beginning with the letter D. The next two numbers will reflect the 
academic year of entry (e.g. D12 – Term 201213).  Take note of the student’s ID number for your own reference. 

 

Next, tab across to the ‘Term’ field and enter the academic term (e.g. 201213) and then to the level and enter PR for 
Postgraduate Research. Then select ‘next block’. 

When you ‘next block’, the following dialogue box will appear. 

 

Select OK as this is just a note to inform you that certain values will be defaulted. 

Note: Student Type defaults to R (Research), Residency defaults to E (European Union) and Rate Code to Zero. 

You should confirm that the defaulted data is correct and make any amendments where required (e.g. Student’s 
residency is Non EU). At this point, you should also update the Full or Part Time indicator accordingly.  
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Note: The Rate Code is used in determining the programme fee that a student is liable for. In the case of postgraduate 
students, there is no set programme fee. Thus, the ‘ZERO’ rate code. Instead of a standard programme fee, charges are 
applied manually to each individual’s student’s account. 

Next you need to navigate to the Curriculum section.  

The first field you must enter here is the Campus field. Then, you input the appropriate Program Code. When you 
select ‘return’ on the keyboard, other key programme information will default in. 

 

Note: The sequencing on entering Campus first and then Programme Code is important here, since PG Research 
programmes can be associated with any of the DIT Campuses. 

Save at this point. You should expect to see the message ‘Transaction complete: 3 records applied and saved’ at the 
bottom of the screen. 

Next you will need to enter the Address Information. Choose the Address tab. 

Note: You can also navigate between the tabs by use of the ‘next block’ and ‘previous block’ Icons 

From here, select the ‘return’ key and today’s date will automatically populate the ‘From date’ field. Enter HM in the 
address type field to record a Home Address for the student. Then enter the address details in the appropriate fields.  

When entering the address information you will need to enter the address under the Street Line fields as well as the 
City, County, Nation and Carrier Route fields.   
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Address data as follow: 

− City: City of address 
− County Code: County codes including Dublin postal district codes. There is a look up table here. Double click 

to view 
− Nation Code: This is also a look up table. Double click to view. When entering the nation code enter the 

nation pertaining to the address, as opposed to the student’s nationality. 
− Carrier Route: This is used to record the accommodation type of the student for the purpose of HEA 

statistical returns. This is a free text field, but you must use the following two character codes only when 
entering this information: 

PH  Parental Home 
RA  Rented Accommodation 
OH  Own Home (house, apartment) 
OA  Other Accommodation  
NS Not Specified 
 

Note: You do not need to enter Sate or Zip code information. 

To enter another address at this point, you can enter a new record by selecting F6 and entering the relevant details as 
above. However, you should be aware that the most recent address entered will be the address used for written 
correspondence with the student. 

If an address record already exists but it is no longer valid, you can de-activate it and enter a new one. See the section 
on ‘Updating Student’s Address’ for more information. 

Finally on the Addresses tab, you can enter the student’s telephone details. You can select the Telephone Type (e.g. 
MOBL) from the drop-down list. 

Save changes when complete. 
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Next, select the Biographical Information tab. On this tab, you must enter Gender, Date of Birth, SSN (PPS no.) and 
Citizenship.  All are mandatory for the purpose of HEA statistical returns. 

− Gender 
− Date of birth in the format day-month-year this will automatically populate the age box 
− Citizenship 
− PPSN number should be added into the box labeled SSN/SIN/TFN. 

 

 

Save changes and exit the form. 

 

GOAINTL – INTERNATIONAL IN FORMATION 

The next form available on the QuickFlow is GOAINTL and relates to Visa and Nationality Information.  

First, you need to ‘next block’ to get to the Visa Information section. Use the VISA type code box to enter the visa type 
if available. 

Note: If the student is Irish, enter NS 

F10 to save changes. 

 

Now select the Nationality tab. 
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Enter the Nation of Birth by selecting from the drop down list.  This field is mandatory and must be entered.  If you 
already know the code, you can enter it directly. 

Save (F10) and exit the Form. 

 

SOAPCOL – PRIOR COLLEGE 

The next form is the Prior College SOAPCOL Form. This is where information about student’s prior third level 
education is held. Assuming the Student ID field is already populated, select ‘next block’ to enter the Prior College 
section.  

You can now enter the last college that the student attended.   

 

You can view a list of colleges by selecting F9 or selecting the search icon to the right of the Prior College field.  
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You will be brought directly into the list of third level institutions (SOISBGI). This list will initially appear blank. 
Select the query function (F8) to retrieve the full list of institutions. Select the desired institution by double clicking in 
the ‘Code’ field cell of the desired row selection.  

 

Your Prior College will be entered.  Once you have selected the relevant college code, you can now save at this point. 

You can also select and add information under the Degree Details section. If the student has graduated you should enter 
the relevant degree information including Degree, Degree Date and Year. 

 

 

Save (F10) and exit the Form. 
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SGASADD - ADDITIONAL STUDENT IN FORMATION FORM 

The next form is SGASADD.  Assuming the correct ‘Student ID’ and ‘Term’ has defaulted, you should ‘next block’ 
twice to enter the Student Attribute section.  

You will now need to record the correct student ‘year of study’. 

Simply enter the correct year under the Attribute Code and save. A warning prompt box will appear. 

 

 

Click OK, save and exit. 
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SGASTDN – GENERAL STUDENT FORM 

The next form will be SGASTDN. Ensure that both the ‘ID’ and ‘Term’ in the key block are correct and then select 
‘next block’ to enter the form. 

This form details the student record and should reflect the correct student and programme information previously 
entered. There is still some additional information which should be entered at this point. 

 

Within the Learner tab, you need to enter the Block information. This can be found under Additional Information. 
Enter ‘Block Code’ and then save. 

You should now save again on SGASTDN and exit the form. 
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SFAREGS - STUDENT COURSE REGISTRATION FORM 

The next form is SFAREGS.  This form details the student’s registration record. It has a tabbed interface for easy 
navigation. It is used to update information on enrolment, registration, subject details and class details.  

Simply ensure that both the ‘ID’ and ‘Term’ in the key block are correct and then select ‘next block’ to enter the form. 

The form initially appears as follows: 

 

Note: At this point, we have not yet saved the registrations record in SFAREGS, so technically the student does not yet 
have an active registrations record. This is noted by the blank ‘Status Date’. 

To create the registrations record, select save. Then select save for a second time. This will trigger fee assessment. You 
will be prompted with the following message.  

 

This is simply a notification to let you know that any fees associated with this student and programme have been 
applied to the student’s account. Since postgraduate research students have a ZERO fee rate code, no programme fee 
will assess on the student’s account. Select OK to this message. 
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At this point, you have created the student’s registrations record with an enrolment status of EL (Eligible to Register). 
This should then be communicated to the Registration Service. It is the responsibility of the Registration Service to 
formally register each student (i.e. to update enrolment status to RE) and issue the students with an ID Card. When 
finished, simply exit the form. 

Note: While new PG Research students are formally registered (RE on SFAREGS) by the Registration Service, it is the 
responsibility of the Postgraduate Research Office to progress and re-register returning students. 
 

SGAUSDF – STUDENT INSTITU TIONAL REPORTING REQUIREMENTS 

The last and final form is SGAUSDF. This is used to record the ISCED code and HEA Subject Codes against the 
student record.  Upon entering the form, ensure the correct ID and Term have defaulted. Then select ‘next block’. 

 

− In the Element 3 field, enter the ISCED code (or choose code from the drop-down selection) to reflect the 
student’s area of study.  

− In the Element 4 field, enter the HEA subject code (or choose code from the drop-down selection) to reflect 
the subject of programme/qualification aim. 

F10 to save changes.  

You have now completed the set-up of a postgraduate research student using the PGRES QuickFlow. 
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International Students 
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International students may apply to DIT either directly via the International Office or through the CAO process, if 
eligible. 

CAO APPLICANTS 
International students applying through the CAO are processed in the same way as all other CAO applicants. However, 
those International students that are non-EU residents will have a different residency and fee rate coding to ensure they 
are assessed for the correct student fee. See section on Overseas Fee Rate Codes for further details. 

DIRECT APPLICATIONS 
International Students can also apply directly to the International Office. Similar 

ADMT ADMISSIONS DATA ENTRY QUICKFLOW 
International Students can also apply directly to the International Office. Similar to the direct admissions process, the 
QuickFlow ADMT is used to set-up new International student applications and to generate offers and acceptances. 

The sequence of forms in this QuickFlow is as follows: 

 

SPAIDEN     

GOAINTL       

SOAHSCH         

SOAPCOL                

SAAADMS 

     SAADCRV 

        SGASTDN  

       SFAREGS 

        SZASGNT  
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SPAIDEN – GENERAL PERSON IDENTIFICATION 
The first form in this QuickFlow chain is SPAIDEN (General Person Identification). This is used to add the student’s 
name and to generate an ID number.    

Before you generate a new ID, you should you should always search the database to see if a person record already exists 
for the student. You can search for a student by selecting the ID drop-down and then Person Search.  You can also use 
form SOAIDNS for a more specific search. GUIALTI (Alternate ID Search) allows you to search by PPS no. and Date 
of Birth. 

Note: As a caveat to this, you should never re-use a CAO ID from the current term (i.e. students who have also applied 
to CAO in the same term). These IDs should be kept distinct and a new direct application ID should always be created.  

 

− To generate a number for the current term (e.g. 201314); use the Generate ID button.   
− To acquire a number for the next term (e.g. 201415); use the New Year ID button.  

 

You will notice the GENERATED or GENERNEXT text appears in the ID Field, depending on which option you 
choose. 

 

Once you have generated a new ID or used an existing one, you then select ‘next block’ (or CRTL Page Down) to enter 
information. Assuming you generated a new ID, you can now enter the person’s Last Name, First Name and any other 
relevant details as required in the relevant fields. Save (F10) when complete. You should now notice that the student 
number has been allocated to this record.  It is important to make a note of this number for your own reference. 

Next you will need to enter the Address Information. Choose the Address tab. 

International students may very often have more than one address. For example, they may have a native ‘country of 
origin’ address, an ‘agency’ address and an ‘Irish’ address. Each address should be entered in Banner, where 
applicable. The sequence of how you enter these addresses is important here. The ‘country of origin’ address should 
always be entered first and the student’s Irish address should be entered last.  

E.g. 

1. Native ‘country of origin’ address:   Address type (HM - Home) 
2. ‘Agency’ address:    Address type (AG - Agency) 
3. Irish ‘home’ address:   Address type (HM – Home) 
 

To insert multiple home address records, simply select F6 to insert a new record from the address tab and a blank 
address record will appear for data entry. Save changes upon completion.  

To record a Home Address for the student, enter HM in the address type field. If you have an ‘Agency’ address, then 
you should also enter this address with type AG (Agency).  

When entering the address information you will also need to enter the address details under the Street Line fields as 
well as the City, County, Nation and Carrier Route fields.   

The latter four reflect the following: 
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− City: City of address 
− County Code: County codes including Dublin postal district codes. There is a look up table here. Double click 

to view 
− Nation Code: This is also a look up table. Double click to view. When entering the nation code enter the 

nation pertaining to the address, as opposed to the student’s nationality. 
− Carrier Route: This is used to record the accommodation type of the student for the purpose of HEA 

statistical returns. This is a free text field, but you must use the following two character codes only when 
entering this information: 

PH  Parental Home 
RA  Rented Accommodation 
OH  Own Home (house, apartment) 
OA  Other Accommodation  
NS Not Specified 
 

 

Note: You do not need to enter Sate or Zip code information. 

Save changes when complete. 

To enter another address at this point, you can enter a new record by selecting F6 and entering the relevant details as 
above. However, the most recent address entered will be the address used for written correspondence with the student. 
Thus the reason you want to create and save the Irish ‘home’ address last. 

Note: If you are entering more than one ‘HM’ address type, you should ensure that the earliest address has an end-date 
(To Date) and is inactivated, before you enter the latest HM address type. 

If an address record already exists but it is no longer valid, you can de-activate it and enter a new one. See the section 
on ‘Updating Student’s Address’ for more information. 

Next, you click on the Telephone tab to enter the relevant telephone numbers for the student. You can enter a home, 
mobile or fax number here. 
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Save (F10) this information when finished.  

The next tab is the Biographical information tab. On this tab, you must enter Gender, Date of Birth, SSN (PPS no.) 
and Citizenship.  All are mandatory for the purpose of HEA statistical returns. 

− Gender 
− Date of birth in the format day-month-year this will automatically populate the age box 
− Citizenship 

PPSN number should be added into the box labeled SSN/SIN/TFN 

 

Save (F10) when complete. 

The next tab is the E-mail information tab. Select ‘next block’ to view/amend information. 

 

When inputting information, you must first enter a type. The email type has a lookup table. You can view any look-up 
table by selecting the drop-down icon or simply selecting F9 (when the cursor is active in the relevant field). Once the 
type has been added, you can then enter the email address.   

Note: Never use the INST type as this is used for automatically generated DIT email addresses. Furthermore, this DIT 
student email address should never be manually changed from this form. 

Save (F10) when this information is entered. 

You have now completed the first Form of this QuickFlow. To progress to the next form, simply exit this form by 
selecting the EXIT icon at the top right-hand corner. 

GOAINTL – INTERNATIONAL IN FORMATION 
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The next form available on the QuickFlow is GOAINTL and relates to Visa and Nationality Information.  

First, you need to ‘next block’ to get to the Visa Information section. Use the VISA type code box to enter the visa type 
if available. 

Note: If the student is Irish, enter NS 

F10 to save changes. 

 

Now select the Nationality tab. 

 

Enter the Nation of Birth by selecting from the drop down list.  This field is mandatory and must be entered.  If you 
already know the code, you can enter it directly. 

Save (F10) and exit the Form.  
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SOAHSCH - HIGH SCHOOL IN FORMATION 

The next form is used to record information about student’s prior secondary level education.  Assuming the student ID 
field is already populated, select ‘next block’ to enter the High School Details section. 

 

You can now enter the secondary school that the student attended.  You can view a list of schools by selecting F9 or 
you can use the search icon which is to the right of the ‘High School’ field.  You will be brought directly into the list of 
secondary school institutions (SOISBGI) where you can search for a particular school by use of the search (F8) and % 
(wildcard) function.  
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Simply enter part of the school name in the ‘Name’ field and use the % (wildcard) character to assist (e.g. %Christian% 
to find all Christian Brother schools) 

 

Tip: The search is case-sensitive, so you should consider this when entering your search criteria (e.g. omit the first 
character of a word if you are unsure of its case.) 

Select F8 to execute the query. F7 clears the form for a new query. 

Note that these school codes are numeric. Once you have found the relevant school, double click on the ‘Code’ field 
and it will select the appropriate school and enter it on the main SOASCH form.  

Save (F10) when school details are entered and exit the form. 

 

SOAPCOL – PRIOR COLLEGE 

The next form is the Prior College SOAPCOL Form. This is where information about student’s prior third level 
education is held. Assuming the Student ID field is already populated, select ‘next block’ to enter the Prior College 
section.  

You can now enter the last college that the student attended.   

 

You can view a list of colleges by selecting F9 or selecting the search icon to the right of the Prior College field.  
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You will be brought directly into the list of third level institutions (SOISBGI). This list will initially appear blank. 
Select the query function (F8) to retrieve the full list of institutions. Select the desired institution by double clicking in 
the ‘Code’ field cell of the desired row selection.  

Note: Code 99 is used to record any Institution not listed on this form. 

 

Your Prior College will be entered.  Once you have selected the relevant college code, you can now save at this point. 

You can also select and add information under the Degree Details section. If the student has graduated you should enter 
the relevant degree information including Degree, Degree Date and Year. 

 

 

Save (F10) and exit the Form. 
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SAAADMS – ADMISSIONS APPLICATION 

The next form that will open is SAAADMS.  This form is used to add the student’s application details. The first item 
that should be added to the key block is the correct Term (e.g. 201314). 

Note: Remember to use the ‘following year’ term code if you are generating an admissions record for next term. 

This first Block/Tab on the form is the Application Block. It displays information describing the applicant type, such as 
admission type and student type. This Block also displays a summary of the information from the Curricula tab for the 
relevant application. The following information must be added on the Application tab: 

− Admission Type (e.g. DA - Direct Applicant) 
− Student Type – (e.g. N – New Entrant ; U – Undergraduate) 
− Residency – (N – Non European Union) 
− The F/T (fulltime) or P/T (Part time) indicator 
− Application Date – Defaults to system date 
− Application Status – C (Complete ready for review) 
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STUDENT TYPE 
The list of options for Student Type is as follows: 

N – New Entrant (An undergraduate student entering a Third Level education for the first time) 
U – Undergraduates (re-enrolling students on an undergraduate programme) 
P – Postgraduate Taught 
R – Postgraduate Research 
A – Apprentice 
C – Continuing Education 
D – Professional Development 
X - Transfer-In from own institution (This would apply to people who changed course within your institution) 
I - Transfer-In from other higher education institution (This would apply to people who changed courses from one 
institution to another) 
B - Repeat (Students repeating the same year of the same course for which they are primarily registered)  
 

Note: Most International Students are likely to be coded as N (New Entrants). However if an International student is 
not a ‘new-entrant’ (i.e. has previously attended a Third Level Institution), they should be coded according to their level 
(e.g. U – Undergraduate) 

Next, you go to the Curricula tab. Enter 1 for the Priority field and enter the relevant Programme Code in Program 
field. The other significant Programme details will default in. The curricula tab is used to record details of the 
Programme that the applicant is applying for (including Programme Code, Level & Degree Code). 

 

Note: The application will not save until you enter the programme information on the Curricula tab 
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EXCHANGE, DISTANCE, E-LEARNING OR VISITING OCCASIONAL STUDENTS 

If the student belongs to one of the options listed below, you will need to update accordingly under the ‘Fees, Mail 
Submission, Withdrawal Data’ tab.  

Session 
Code Exchange / Non Standard Attendance / Mode of Study Category 

S Exchange – Erasmus/ Socrates incoming exchange 
I Exchange – Other incoming exchange 
O Exchange – Outgoing Exchange 
C Distance Education 
L E-Learning 
N In-Service Education 
Q Postgraduate Qualifier 
V Visiting Occasional/JYA 1 Term 
J Visiting Occasional/JYA 2 Terms 
Y Visiting Occasional/JYA Full Year 
C Distance Education 
L E-Learning 
N In-Service Education 

  

Under the Additional Data section, select the appropriate option from the Session field. 

 

Save changes when complete. 

 
ATTRIBUTE CODE /  YEAR OF  STUDY 
Go to the Contacts, Cohorts and Attributes tab. Enter the programme year under Attribute field.  

 

F10 to save changes. 

Note: This data is very significant when it comes to student progression, e-mail generation and fee assessment and 
therefore must be entered. 
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ADDITIONAL APPLICATIONS 
If you wish to add further applications to this student record, return to the Application tab. From the menu, select 
Record ->Insert (alternatively you can use the down arrow key until a new blank record exists).  

 

A new record will be created for the given term. Enter the relevant information (as outlined above) and then enter the 
relevant curricula information under the Curricula tab, attribute under Contacts, Cohorts, Attributes tab and other 
information required. F10 to save and you will now have two applications associated with this record. You can repeat 
the same process over again for multiple applications .Each application can be reviewed from the Application tab by 
use of the scroll bar. 

F10 to save changes. Exit the form to proceed with the QuickFlow. 

 

SAADCRV – ADMISSIONS DECISION (GENERATING AN OFFER) 

The next form enables you to process the student’s application. First, ensure that both the ‘Student ID’ and the ‘Term’ 
of entry for the student are correct in the key block. Then select ‘next block’.  

All application details recorded on the previous form are recorded in Application Summary section.  If more than one 
application exists, you can scroll through the applications in the Application Summary section of the form.  Scroll down 
to find the Programme for which you wish to record an offer.  

Next, ensure you are active in the Decision Data (Application Decision) section of the form. When an offer is to be 
made to the student, a decision of IO (Offer Made by Institute) should be entered under Decision Code and saved 
against the correct Programme.  Save (F10) and you will see the message Decision Processed appear. Select OK to 
confirm this. 
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If you do not wish to process the applicant’s ‘acceptance’ at this point, you can choose to exit the QuickFlow 
completely by selecting from the menu File → Exit QuickFlow.  

 

 

Otherwise, proceed as outlined below. 

 

SAADCRV – ADMISSIONS DECISION (GENERATING AN ACCEPTANCE) 

If you wish to record an acceptance (assuming IO entry has already been recorded), simply enter AD (Applicant 
Accepted Offer) under previously entered IO Decision Code.  

Save using F10 and exit the form to proceed with the QuickFlow. 
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SGASTDN – GENERAL STUDENT 

The next in the QuickFlow is the General Student Form SGASTDN. Student details will only appear on this form if an 
accepted offer (AD) decision had previously been recorded against the student’s application. 

Before entering the form, ensure the ‘Term’ of entry and ‘Student ID’ are both correct and then select ‘next block’ to 
enter/view information. This is the Student Record.  This first Block/Tab is the Learner Block. This is used to view 
student information such as student status and student type. You will need to complete the following information: 

− Fee Assessment Rate –See section on Overseas Fee Rate Codes for further information on Rate Codes for 
Non-EU students. 

− F/P – F or P (this is the full or part-time indicator, indicating whether the student is studying this programme 
on a full or part-time basis). 

− In the Additional Information section, you should enter the relevant Block Code (Programme & Year of 
Study).  

− In the Additional Information section under Session field, you should also ensure exchange, distance, e-
learning or visiting occasional students is flagged, where applicable. See Exchange / Distance/E-Learning for 
further information of relevant codes. 

 

Save (F10) when updates are made and complete. 
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SFAREGS - Creating new ‘EL’ registrations record 

Once a student has accepted a place on a DIT programme and has been processed accordingly in Banner, the student’s 
registrations record should then be saved in SFAREGS with an enrolment status of EL (Eligible to Register). 

Note: You can only create an active EL registrations record in SFAREGS for the current ‘active’ term. Therefore, if a 
student has accepted a place on a programme for the next academic term (i.e. in advance of the term roll process), 
Banner will not allow you to create the students registration record in SFAREGS. You must keep a list of these students 
and ensure that you create their ‘EL’ SFAREGS record and default grant record after term roll has completed. 

SFAREGS has a tabbed interface for easy navigation. Simply enter the ‘Term’ and ‘Student ID’ and select ‘next 
block’ to view / update details on the form. 

The form initially appears as follows: 

 

Under the Student Term tab, you can view / update detailed information about the student such as: 

− Student Type 
− Residence 
− Full or Part time indicator 
− Block schedule 
− Fee Assessment Rate. 
− Class (Attribute / Year of Study) 

 

Ensure that these details are entered correctly or make any amendments as required 
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The Curricula tab allows you to view program related information for the student. You should also ensure that the 
details on this tab are as expected (i.e. Programme & Term data). 

 

Return to the Registration tab.  The student’s status will be EL (Eligible to Register) at this point. Select ‘save’ twice. 
This will activate the student’s registrations record in Banner and trigger ‘Fee Assessment. You should now expect to 
see the following message: 
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Select OK. 

This will create the student’s registration record and the appropriate fees will be generated on the student’s account. 

The Registration Service should then be informed in order to process the student’s registrations record further and to 
invite the student to register online where appropriate. 

 

SZASGNT - CREATIN G THE DEFAULT GRANT RECORD 

Having created the student’s ‘EL’ registrations record, you must now save the student’s grant record. 

Note: This step is only required for Full-Time students. If a student is Part-Time, simply ignore this step. 

To save a student’s grant record, enter SZASGNT.  In the key block you enter the student’s ID and Term Code and 
‘next block’ into the form. 

You will be prompted with the following message box. 

  

Select OK and the standard default funding codes for the programme will default against the student’s record.  

However, since the student is International, their funding codes should be updated to reflect the International grant 
funding codes as follows: 

− Funding Category: 09 (Overseas) 
− Funding Maintenance:    20 (Non Aided) 
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Save to commit changes.  You will be prompted with a message ‘Contract numbers cannot be established’. Select OK. 

You can now exit form and the QuickFlow. 

The Registration Service should then be informed so that process of inviting the student to formally register and pay 
fees online can commence. 

Note: More information in relation to grants can be found under the ‘Fees and Grants’ section of this manual 
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OVERSEAS FEE RATE CODES 
International students with a residency of non-EU are assessed for the relevant fee structure according to the following 
fee assessment criteria: 

− Has the student previously or partially completed a third level programme? 
− Is the student an EU national or a national or a national of an EEA member country or Switzerland, or have 

they been granted official refugee status? 
− Has the student been a resident in an EU Member State for at least 3 or the last 5 years? 

 

Depending on the student’s eligibility, non-EU students may be required to either pay the international programme fee 
(see below) or the standard EU programme fee. 

OVERSEAS NON-EU FEES 
The following International rate codes apply for non-EU students. 

Rate 
Code 

Programme Level 

O13CL Higher Certificate or PG Cert/Diploma (Laboratory) 
O13OD Ordinary Degree 
O13DN Honours Degree/Masters Degree (Non-Laboratory) 
O13DL Honours Degree/Masters Degree (Laboratory) 
O13CN PG Cert/Diploma (Non-Laboratory) 
O10CL Higher Certificate or PG Cert/Diploma (Laboratory) 
O10OD Ordinary Degree 
O10DN  Honours Degree/Masters Degree (Non-Laboratory) 
O10DL  Honours Degree/Masters Degree (Laboratory) 
O10CN  PG Cert/Diploma (Non-Laboratory) 
OV10 Special International Rate for specific programmes 
 

Depending on level of the programme, the relevant RATE code is added to the student’s record in Banner. 

Note: Returning Students will remain on the International Rate code applied at the time of admission.  International 
Rate Codes for terms prior to 2010/11 followed the format OVYY, where YY was the year of initial acceptance. (e.g. 
OV09 applied to international students who accepted a place on a programme commencing in term 200910) 

GRANT RECORD 
Students paying the full ‘International Programme Fee’ do not generally have any grant or awarding body fee 
entitlements. They are therefore personally liable for the own fees.  

As a result, their grant record in Banner should reflect this. On SZASGNT, they should be coded as follows: 

− Funding Category:  09 (Overseas) 
− Funding Maintenance:  20 (Non Aided) 

 

More information on grants can be found on ‘Grants’ section below. 

Overseas EU Fees 
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When a full-time non-EU student has been assessed and approved for EU fees, the student’s RATE code should be set 
to OVEU – Overseas EU fee. The OVEU rate code will process the standard EU programme fee on the student’s 
account. 

Note: non-EU students on a part-time programme have the same Rate Code as EU students (i.e. PART)  

 

GRANT RECORD 
International students paying the standard EU fee do not generally have any grant or awarding body fee entitlements. 
They are therefore personally liable for the own fees.  As a result, their grant record in Banner should reflect this. On 
SZASGNT, they should be coded as follows: 

− Funding Category:  15 (Overseas EU Fee) 
− Funding Maintenance:  20 (Non Aided) 

 

More information on grants can be found on Grants section below. 

INTERNATIONAL STUDENT REGISTRATIONS 
Non-EU students (paying the full international registration fee) cannot register using the DIT Programme Web 
Registration system. Instead, non-EU students are invited to register directly with the Registration Service on a given 
date each year. 

Each student is requested to pay any outstanding fees in advance of this date, in order to enable them to register and 
receive their ID card on the day. 

SFAREGS – STUDENT COURSE REGISTRATION  
SFAREGS is used to register students directly in Banner. Simply enter the ‘Term’ and ‘Student ID’ and select ‘next 
block’ to view / update details on the Form. 

The form appears as follows: 

 

Under the Student Term tab, you can view / update detailed information about the student such as: 



BANNER OPERATIONAL USER GUIDE 

 

Page 153 of 351 

− Student Type 
− Residence 
− Full or Part time indicator 
− Block schedule 
− Fee Assessment Rate. 
− Class (Attribute / Year of Study) 

 

Ensure that these details are entered correctly. 

 

The Curricula tab allows you to view program related information for the student. You should also ensure that the 
details on this tab are as expected (i.e. Programme & Term data). 

 

Return to the Registration tab. The student’s status will be EL (Eligible to Register) at this point. Save twice at this 
point to trigger fee assessment on the student’s account. 

TSAAREV – ACCOUNT DETAIL REVIEW FORM 
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You should now query the student account details in order to confirm that the correct fees have assessed on the 
student’s account. To do this, go to the options menu and select Review Account Detail [TSAAREV] 

 

This will bring you into the TSAAREV form.  To enter the form, select ‘next block’. All account transactions for all 
terms should appear on the form. You should immediately notice the Capitation and Tuition fee on the account for the 
current term. Remember, if the student is liable for the full non-EU fee you should expect the higher Tuition fee on the 
account. If the student is approved on EU fees, then the standard EU fee only should assess.  

 

You can also check for any payment transactions. This may be noted by a detail code of CARD (Credit or Debit Card) 
or EFFT (Electronic Funds Transfer) payment. Payment of fees is required before a student can formally register. 

To return to SFAREGS, simply exit the form. 

If the student’s fees have not assessed as expected, you should check the following list of items.  

− Is the student’s Residence correct (SFAREGS)? 
− Is the Fee Assessment Rate code correct (SFAREGS)? 
− Is the full/part indicator correct (SFAREGS)? 
− Is the student’s year of study entered correctly for the current term (SGASADD)? 
− Is the student’s curricula / programme / field of study information correct (SFAREGS)? 
− Has the student’s registrations record been saved and fee assessment triggered (SFAREGS)? 
− If the student is eligible for some form of grant funding. Is the student’s grant record (SZASGNT) or contract 

arrangements (TSAACCT) correct.  
− I funding from a third party applies, has the liability transfer been triggered (TSASPAY). 
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REGISTERING A STUDENT 
Assuming fees are correct and have been paid by the student, you can then formally register the student on SFAREGS. 
You can do this by simply updating the student enrolment status to RE (Registered). 

 

Select ‘save’ twice. This will save the student’s registrations record in Banner and trigger ‘Fee Assessment’. You 
should now expect to see the following message: 

 

Select OK. The student is now registered and will be eligible to receive their ID Card. 
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INTERNATIONAL STUDENT REPEATS 
This section relates to Full-Time International repeat students only. International Repeat students are categorised in 
Banner according to the following factors: 

− Is the student liable for the full International Fee or the standard EU fee? 
− Are they repeating the full year, a set number of modules or externally repeating? 

 
Based on the above criteria, International Repeat students should be updated in Banner as follows: 

 

INTERNAL REPEATS 
IN TERNATIONAL FEE 

− Student Type update to B (Repeat) 
− Rate Code reflects International Fee Rate Code 
− Where necessary, manually adjust student’s Tuition fee on TSAAREV to reflect International repeat fee based 

on number of modules being repeated. 
− Grant Funding Codes updated to: 20 (Overseas Repeat Half) / 20 (Non Aided) 

EU FEE 
− Student Type update to B (Repeat) 
− Rate Code update to RCRED 
− Manually adjust student’s Tuition fee charge on TSAAREV to reflect no. of repeat modules  
− Grant Funding Codes updated: 12 / 20 (Repeat / Non Aided) 

 

 
EXTERNAL REPEATS (XR) 
IN TERNATIONAL FEE 

− Enrolment Status updated to XR 
− Rate Code update to XR 
− Remove Grant Record 

EU FEE 
− Enrolment Status updated to XR 
− Rate Code update to XR 
− Remove Grant Record 

 

More information in relation to coding repeat students can be found under section ‘Repeat Students’. 
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ERASMUS/SOCRATES STUDENTS  
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The ERASMUS/SOCRATES programme enables students to study or work between 3 and 12 months in another EU 
state (or in Iceland, Lichtenstein, Norway or Turkey).  

Therefore, in the context of DIT, outgoing ERASMUS/SOCRATES are DIT students who have been approved to study 
/ work in another EU university that has a bilateral agreement with DIT.  

Similarly, incoming ERASMUS/SOCRATES students will have been nominated by their respective university to come 
and study at DIT for a period of time. 

The Erasmus Office in DIT looks after the application and set-up of incoming ERASMUS/SOCRATES student records 
using QuickFlow ERAS. 

 

ERAS – ERASMUS QUICKFLOW 

The sequence of forms in the ERAS QuickFlow is as follows: 

 

SAAQUIK     

GOAINTL       

SGASADD                

SGASDTN 

SFAREGS 

       SZASGNT 

 

SAAQUIK – QUICK ENTRY 

The first form is SAAQUIK.  This form is used to create a new student record (including a newly generate Student ID). 

To generate a number for the current term (e.g. 201314); use the Generate ID button.   
 

 

In the prompt box, enter the student’s name details and then save. 
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Banner will generate a new student ID at this point beginning with the letter D. The next two numbers will reflect the 
academic year of entry (e.g. D12 – Term 201213).  Take note of the student’s ID number for your own reference. 

 

Next, tab across to the ‘Term’ field and enter the academic term (e.g. 201213) and then to the level (e.g. UG). Then 
select ‘next block’. 

When you ‘next block’, the following dialogue box will appear. 

 

Select OK as this is just a note to inform you that certain values will be defaulted. 

Note that ‘Student Type’ defaults to the appropriate code depending on the Level entered in the key block. 

UG – U (Undergraduate) 
PR – R (Research) 
AP – A (Apprentice) 
CE – C (Continuing) 
PD – D (Professional) 
PG – P (Postgraduate) 
 

You should confirm that the defaulted data is correct and make any amendments where required (e.g. if Student’s 
residency is Non EU).  

At this point, you should also update the Full or Part Time indicator accordingly. The Rate Code should be updated to 
SOCRS 

 

Next you need to navigate to the Curriculum section.  

The first field you must enter here is the Campus field. Then, you input the appropriate Program Code. When you 
select ‘return’ on the keyboard, other key programme information will default in. 
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Save at this point. You should expect to see the message ‘Transaction complete: 3 records applied and saved’ at the 
bottom of the screen. 

Next you will need to enter the Address Information. Choose the Address tab. 

Note: You can also navigate between the tabs by use of the ‘next block’ and ‘previous block’ Icons 

From here, select the ‘return’ key and today’s date will automatically populate the ‘From date’ field. Enter HM in the 
address type field to record a Home Address for the student. Then enter the address details in the appropriate fields.  

When entering the address information you will need to enter the address under the Street Line fields as well as the 
City, County, Nation and Carrier Route fields.   

 

To enter another address at this point, you can enter a new record by selecting F6 and entering the relevant details as 
above. However, you should be aware that the most recent address entered will be the address used for written 
correspondence with the student. 

If an address record already exists but it is no longer valid, you can de-activate it and enter a new one. See the section 
on ‘Updating Student’s Address’ for more information. 
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Address data as follow: 

− City: City of address 
− County Code: County codes including Dublin postal district codes. There is a look up table here. Double click 

to view 
− Nation Code: This is also a look up table. Double click to view. When entering the nation code enter the 

nation pertaining to the address, as opposed to the student’s nationality. 
− Carrier Route: This is used to record the accommodation type of the student for the purpose of HEA 

statistical returns. This is a free text field, but you must use the following two character codes only when 
entering this information: 

PH  Parental Home 
RA  Rented Accommodation 
OH  Own Home (house, apartment) 
OA  Other Accommodation  
NS Not Specified 
 

Note: You do not need to enter Sate or Zip code information. 

Finally on the Addresses tab, you can enter the student’s telephone details. You can select the Telephone Type (e.g. 
MOBL) from the drop-down list. 

Save changes when complete. 

Next, select the Biographical Information tab. On this tab, you must enter Gender, Date of Birth, SSN (PPS no.) and 
Citizenship.  All are mandatory for the purpose of HEA statistical returns. 

− Gender 
− Date of birth in the format day-month-year this will automatically populate the age box 
− Citizenship 
− PPSN number should be added into the box labeled SSN/SIN/TFN. 

 

Note: Where a student is not Irish, PPS no. is not required. 

 

Save changes and exit the form. 
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GOAINTL – INTERNATIONAL IN FORMATION 

The next form available on the QuickFlow is GOAINTL and relates to Visa and Nationality Information.  

First, you need to ‘next block’ to get to the Visa Information section. Use the VISA type code box to enter the visa type 
if available. 

 

F10 to save changes. 

Now select the Nationality tab. Enter the Nation of Birth by selecting from the drop down list.  This field is mandatory 
and must be entered.  If you already know the code, you can enter it directly. 

 

Save (F10) and exit the Form. 

 

SGASADD - ADDITIONAL STUDENT IN FORMATION FORM 

The next form is SGASADD.  Assuming the correct ‘Student ID’ and ‘Term’ has defaulted, you should ‘next block’ 
twice to enter the Student Attribute section.  You will now need to record the correct student ‘year of study’. 

Simply enter the correct year under the Attribute Code and save. A warning prompt box will appear. 
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Click OK, save and exit. 

. 

SGASTDN – GENERAL STUDENT FORM 

The next form will be SGASTDN. Ensure that both the ‘ID’ and ‘Term’ in the key block are correct and then select 
‘next block’ to enter the form. 

This form details the student record and should reflect the correct student and programme information previously 
entered.  

However, you will also need to enter additional data in the Additional Information section 

− You should enter the relevant Block Code in the Block field.  
− Under Session field, you should also ensure the student is flagged as S - (Erasmus / Socrates Incoming Exch) 

or I - (Other Incoming Exchange), where applicable. 
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You should now save on SGASTDN and exit the form. 

 

SFAREGS - STUDENT COURSE REGISTRATION FORM 
The next form is SFAREGS.  This form details the student’s registration record. It has a tabbed interface for easy 
navigation. It is used to update information on enrolment, registration, subject details and class details.  

Simply ensure that both the ‘ID’ and ‘Term’ in the key block are correct and then select ‘next block’ to enter the form. 

 

Note: At this point, we have not yet saved the registrations record in SFAREGS, so technically the student does not yet 
have an active registrations record. This is noted by the blank ‘Status Date’. 

To create the registrations record, select save. Then select save for a second time. This will trigger fee assessment. You 
will be prompted with the following message.  
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This is simply a notification to let you know that any fees associated with this student and Programme have been 
applied to the student’s account. No fee is associated with the SOCRS rate code and therefore, Erasmus students will 
not have any fees assessed on their account. Select OK to this message. 

At this point, you have created the student’s registrations record with an enrolment status of EL (Eligible to Register). 
This should then be communicated to the Registration Service. It is the responsibility of the Registration Service to 
formally register each student either manually or by invitation to register online and to subsequently issue the students 
with an ID Card. When finished, exit the form. 

 

SZASGNT – STUDENT GRANT MAINTENANCE FORM 

The last form in the QuickFlow is SZASGNT.  

 

Upon entering the student ID and term, the grant information will default accordingly. You should ensure this is correct. 
Erasmus students should be coded with either of following funding codes: 

Funding Category: 10 (Incoming Socrates 3 mth)  
Funding Maintenance: 20 (Non-aided) 
 
Funding Category: 11 (Incoming Socrates 1 yr)  
Funding Maintenance: 20 (Non-aided)  
 
Funding Category: 14 (Incoming Socrates 1 sem)  
Funding Maintenance: 20 (Non-aided) 
 

Save changes and exit. 
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APPRENTICE STUDENTS  
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DIT receives confirmation of the list of Apprentice students each year from the relevant statutory authority such as FÁS 
or Fáilte Ireland. Upon receipt of such, the Registration Service generates and registers each new apprentice student 
record in Banner on the relevant programme code. This set-up is handled by the QuickFlow APR1. 

 

APPRENTICE STUDENT SET-UP – QUICKFLOW: APR1 

The sequence of forms in the APR1 QuickFlow is as follows: 

 

SAAQUIK 

 GOAINTL 

SGASADD  
 

 TSAACCT 

      
       SFAREGS 

 
      

SZASGNT 
 

SAAQUIK – QUICK ENTRY 

The first form is SAAQUIK.  To create a new student record, select the Generate ID icon on the right. 

Before you generate a new ID, you should you should always search the database to see if a person record already exists 
for the student. You can search for a student by selecting the ID drop-down and then Person Search.  You can also use 
form SOAIDNS for a more specific search. GUIALTI (Alternate ID Search) allows you to search by PPS no. and Date 
of Birth. 

Note: As a caveat to this, you should never re-use a CAO ID from the current term (i.e. students who have also applied 
to CAO in the same term). These IDs should be kept distinct and a new direct application ID should always be created.  
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 In the prompt box, enter the student’s last name and first name detail and then save.   

Banner will generate a new student ID at this point beginning with the letter D. The next two numbers will reflect the 
academic year of entry (e.g. D13 – Term 201213).  Take note of the student’s ID number for your own reference. 

Next, tab across to the ‘Term’ field and enter the academic term (e.g. 201213) and then to the level and enter AP for 
Apprentice students. Then select ‘next block 

 

 

When you ‘next block’, a dialogue box will appear. Select OK as this is just a note to inform you that certain values will 
be defaulted.  Note that ‘Student Type’ defaults to A (Apprentice). 

 

You must now enter the following parameters: 

− Full or Part Time indicator should be checked accordingly.  
− Rate: For FÁS apprentices, this should be set to BLKYY, where YY represents the calendar year of entry of the 

student   
E.g.  September 2012 intake: Rate Code BLK12 

January 2013 intake: Rate Code BLK13 
March 2013 intake:  Rate Code BLK13   

 

Note: The Rate Code ensures the correct fee is assessed on the apprentice student’s account.  

To enter the Programme Code click on the Program field and enter the relevant Code and save. The other associated 
field entries will default in. 

 

Save at this point to create new student record. 

Next you will need to enter the Address Information. Choose the Address tab. 
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Note: You can also navigate between the tabs by use of the ‘next block’ and ‘previous block’ Icons 

From here, select the ‘return’ key and today’s date will automatically populate the ‘From date’ field. Enter HM in the 
address type field to record a Home Address for the student. Then enter the address details in the appropriate fields.  

When entering the address information you will need to enter the address under the Street Line fields as well as the 
City, County, Nation and Carrier Route fields.   

 

Address data as follow: 

− City: City of address 
− County Code: County codes including Dublin postal district codes. There is a look up table here. Double click 

to view 
− Nation Code: This is also a look up table. Double click to view. When entering the nation code enter the 

nation pertaining to the address, as opposed to the student’s nationality. 
− Carrier Route: This is used to record the accommodation type of the student for the purpose of HEA 

statistical returns. This is a free text field, but you must use the following two character codes only when 
entering this information: 

PH  Parental Home 
RA  Rented Accommodation 
OH  Own Home (house, apartment) 
OA  Other Accommodation  
NS Not Specified 
 

Note: You do not need to enter Sate or Zip code information. 

To enter another address at this point, you can enter a new record by selecting F6 and entering the relevant details as 
above. However, you should be aware that the most recent address entered will be the address used for written 
correspondence with the student. 

If an address record already exists but it is no longer valid, you can de-activate it and enter a new one. See the section 
on ‘Updating Student’s Address’ for more information. 

Finally on the Addresses tab, you can enter the student’s telephone details. You can select the Telephone Type (e.g. 
MOBL) from the drop-down list. 

Save changes when complete. 
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Next, select the Biographical Information tab. On this tab, you must enter Gender, Date of Birth, SSN (PPS no.) and 
Citizenship.  All are mandatory for the purpose of HEA statistical returns. 

− Gender 
− Date of birth in the format day-month-year this will automatically populate the age box 
− Citizenship 
− PPSN number should be added into the box labeled SSN/SIN/TFN. 

 

 

Save changes and exit the form. 

 

GOAINTL – INTERNATIONAL IN FORMATION 

The next form available on the QuickFlow is GOAINTL and relates to Visa and Nationality Information. First, you 
need to ‘next block’ to get to the Visa Information section. Use the VISA type code box to enter the visa type if 
available. 

Note: If the student is Irish, enter NS 

F10 to save changes. 

 

Now select the Nationality tab. 
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Enter the Nation of Birth by selecting from the drop down list.  This field is mandatory and must be entered.  If you 
already know the code, you can enter it directly. 

Save (F10) and exit the Form. 

 

SGASADD – ADDITIONAL STUDENT IN FORMATION 

The next form is SGASADD. This is where you need to enter the student’s phase information. Assuming the correct 
‘Student ID’ and ‘Term’ have defaulted, you should ‘next block’ twice to the Student Attribute section. Under the 
Attribute Code, enter the appropriate phase for the student. 

 

Note: Apprentice students are not coded are per year of study, but rather by phase. Available options are: 

− Phase 2 (P2) 
− Phase 4 (P4) 
− Phase 6 (P6) 

 

Once you have entered the relevant phase, save you changes. Select OK to the prompt message and exit the form. 
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TSAACCT – ACCOUNT REVIEW FORM STUDENT 

The next form on the QuickFlow is TSAACCT. This is used to check what contracts the student is attached to for the 
current term. 

To enter the form, confirm the Student ID is correct in the key block and then ‘next block’ four times into the form. 
This will bring you to the Contracts section of the form. 

 

In most instances, you should expect this to be blank (i.e. no contracts attached to the student). 

DELETING CONTRACTS 
However, if the student previously studied a full-time programme at DIT, it may be possible that they are incorrectly 
attached to a contract(s) for the current term (i.e. a contract from an old term inadvertently copied over to the new term). 

  

E.g. Student active on 3000-35 for the Term 201213.  

In order to delete a student from a contract simply enter a D against the Delete Indicator for the contract(s) in question 
and save changes. 

 

D indicator flagged against contracts for Term 201213 

Note: You do not need to ‘Delete’ contracts from previous terms. You should only be checking for any unexpected 
contracts for the current term that should be deleted. 
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SFAREGS - STUDENT COURSE REGISTRATION FORM 

The final form is SFAREGS.  Again, ‘next block’ from the key block assuming the ‘Student ID’ and ‘Term’ have 
defaulted correctly. 

 

Go to the Student Term tab first. You must now enter the Block Code in the Block Schedule field. Save changes at this 
point. You can ignore the Warning prompt by selecting OK. 

 

Note: Apprentice Block codes have been set-up to group students according to their Semester of Study and Phase. 

E.g. Electrical Apprentices SBE 

SBE4AAU SBE Phase 4 Group A Autumn 
SBE4ASP SBE Phase 4 Group A Spring 
SBE4ASU SBE Phase 4 Group A Summer 
SBE6AAU SBE Phase 6 Group A Autumn 
SBE6ASP SBE Phase 6 Group A Spring 
SBE6ASU SBE Phase 6 Group A Summer 
 

Return to the Registration tab.  Assuming you wish to proceed with registering the student; update the student 
enrolment status from EL to RE (Registered).  
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Note: You should not process any payment at this point. The student’s grant record must be set-up first. Save changes 
when complete and exit SFAREGS. 

SZASGNT – STUDENT GRANTS MAINTENANCE FORM 

The final form in the QuickFlow is SZASGNT. Only FÁS apprentices require a grant record set-up on this form. FÁS 
apprentices will have a Tuition fee and an Exam fee initially charged to their account. In order to reflect the 
contractually and fee arrangement between FÁS, DIT and any other Third Party, the set-up of the student’s grant record 
is important here. 

Other apprentice students such as Fáilte Ireland do not require any set-up here. 

Ensure both the Student ID and Term is both correct in the key block. Then ‘next block’ into the form. You should 
expect the see the following two messages: 

  

 

 
 

Select OK to both messages.  You should then expect to see both the Funding Category and Funding Maintenance 
codes default to 59. The Awarding Body FAS is also noted as the background contract which is configured to cover the 
Tuition component of the fee. 

If an agreement is also in place with another Third Party to cover the student’s Exam fee, this Third Party’s ID must be 
entered against the Awarding Body field. Assuming a contract has been set-up for the Third Party; then the liability for 
the student’s Exam fee will transfer to this Third Party. 

 

E.g. Apprentice Student, where FAS is covering the Tuition fee and ESB covering the Exam fee. 

Save at this point. Again, you will be prompted with the message ‘Contract numbers cannot be established’. Select OK 
to this message. Exit the form. The APR1 QuickFlow is now complete. 
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STAFF & ALUMNI REGISTRATIONS 
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STAFF REGISTRATIONS 

DIT Staff may also decide to study at DIT. Assuming the person has been accepted on the programme and approved for 
the staff fee waiver, the student can be set-up in Banner. QuickFlows have been designed to facilitate this process. 

Set-up of staff student records is generally carried out by the Staff Training & Development Office. The Registrations 
Offices will then process any payment and formally register (RE) the student once the individual has been approved and 
any outstanding fees paid in full.  

 

1S T YEAR STUDENTS – QUICKFLOW: STF1 

 

SAAQUIK – QUICK ENTRY 

The first form is SAAQUIK.  To create a new student record, select the ‘Generate ID’ icon on the right. 

Note: Before creating a new student ID, you should check if a record already exists in Banner for this student. By 
selecting the ID drop-down option and then Person Search, you can perform the search you require. You can also use 
form SAOIDNS for a more specific search. 

 

In the prompt box, enter the student’s last name and first name detail and then save. Banner will generate a new student 
ID at this point.  Take note on the enrolment form of this number. 

Next, tab across to the ‘Term’ field and enter the academic term (e.g. 201213) and then to the level (e.g. UG).  The level 
is the level of the Programme the student is studying. Then select ‘next block’. 

 

When you ‘next block’, a dialogue box will appear. Select OK as this is just a note to inform you that certain values will 
be defaulted.  

Note that ‘Student Type’ defaults to the appropriate code depending on the Level entered in the key block. 

AP – A (Apprentice) 
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CE – C (Continuing) 
PD – D (Professional) 
PG – P (Postgraduate) 
PR – R (Research) 
UG – U (Undergraduate) 
 

However, if the student is entering a higher education programme for the first time, you must update the student level to 
reflect the fact that they are considered new entrants for the purpose of HEA returns. 

N – New Entrant 

Furthermore, if the student is transferring either from within DIT or from another higher education institution, you 
should update the student type as follows: 

X - Transfer-In from own institution 
I - Transfer-In from other higher education institution 
 

Now enter the following parameters: 

− Full or Part Time indicator (Part Time) 
− Rate: PART (Most part-time programmes have a PART rate code. However, some may have something 

different. Check this with your registrations officer if you are unsure.) 
 

 

Note: If you do not check the part-time indicator, then the payment options will not appear at registration point. 

You should also notice under the Application and Recruit Information section of SAAQUIK that the Admission Type 
defaults to DA.  

Assuming the student is a direct applicant (DA) into the 1st year of a part-time programme, no change is required here.  
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However, if you are generating an Advanced Entry application for a student into 2nd or subsequent years of a part-time 
programme, the Admission Type should be updated to AE (Advanced Entry). This ensures that these students will be 
selected for paper ITRs as opposed to email ITRs. 

 

AE application into year 2 or subsequent years 

Next you navigate to the Curriculum section. To enter the Programme Code click on the Program field and enter the 
relevant Code and save. The other associated field entries will default in. 

 

Save at this point to create new student record. 

Next you will need to enter the Address Information. Choose the Address tab. 

Note: You can also navigate between the tabs by use of the ‘next block’ and ‘previous block’ Icons 

From here, select the ‘return’ key and today’s date will automatically populate the ‘From date’ field. Enter HM in the 
address type field to record a Home Address for the student. Then enter the address details in the appropriate fields.  

When entering the address information you will need to enter the address under the Street Line fields as well as the 
City, County, Nation and Carrier Route fields.   

 

Address data as follow: 
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− City: City of address 
− County Code: County codes including Dublin postal district codes. There is a look up table here. Double click 

to view 
− Nation Code: This is also a look up table. Double click to view. When entering the nation code enter the 

nation pertaining to the address, as opposed to the student’s nationality. 
− Carrier Route: This is used to record the accommodation type of the student for the purpose of HEA 

statistical returns. This is a free text field, but you must use the following two character codes only when 
entering this information: 

PH  Parental Home 
RA  Rented Accommodation 
OH  Own Home (house, apartment) 
OA  Other Accommodation  
NS Not Specified 
 

Note: You do not need to enter Sate or Zip code information. 

To enter another address at this point, you can enter a new record by selecting F6 and entering the relevant details as 
above. However, you should be aware that the most recent address entered will be the address used for written 
correspondence with the student. 

If an address record already exists but it is no longer valid, you can de-activate it and enter a new one. See the section 
on ‘Updating Student’s Address for more information. 

Finally on the Addresses tab, you can enter the student’s telephone details. You can select the Telephone Type (e.g. 
HM) from the drop-down list. Save changes when complete. 

Next, select the Biographical Information tab. On this tab, you must enter Gender, Date of Birth, SSN (PPS no.) and 
Citizenship.  All are mandatory for the purpose of HEA statistical returns. 

− Gender 
− Date of birth in the format day-month-year this will automatically populate the age box 
− Citizenship 
− PPSN number should be added into the box labeled SSN/SIN/TFN. 

 

 

Save changes and exit the form. 

You have now completed the first form of this QuickFlow. To progress to the next form, simply exit this form by 
selecting the EXIT icon at the top right-hand corner. 
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GOAINTL – INTERNATIONAL IN FORMATION 

The next form available on the QuickFlow is GOAINTL and relates to Visa and Nationality Information.  

First, you need to ‘next block’ to get to the Visa Information section. Use the VISA type code box to enter the visa type 
if available. 

Note: If the student is Irish, enter NS 

F10 to save changes. 

 

Now select the Nationality tab. 

 

Enter the Nation of Birth by selecting from the drop down list.  This field is mandatory and must be entered.  If you 
already know the code, you can enter it directly. 

Save (F10) and exit the Form. 

 

SOAPCOL – PRIOR COLLEGE 

The next form is the Prior College SOAPCOL Form. This is where information about student’s prior third level 
education is held. Assuming the Student ID field is already populated, select ‘next block’ to enter the Prior College 
section.  
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You can now enter the last college that the student attended.   

 

You can view a list of colleges by selecting F9 or selecting the search icon to the right of the Prior College field.  

 

You will be brought directly into the list of third level institutions (SOISBGI). This list will initially appear blank. 
Select the query function (F8) to retrieve the full list of institutions. Select the desired institution by double clicking in 
the ‘Code’ field cell of the desired row selection.  
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Your Prior College will be entered.  Once you have selected the relevant college code, you can now save at this point. 

You can also select and add information under the Degree Details section. If the student has graduated you should enter 
the relevant degree information including Degree, Degree Date and Year. 

 

Save (F10) and exit the Form. 

 

  



BANNER OPERATIONAL USER GUIDE 

 

Page 183 of 351 

SOAHSCH – HIGH SCHOOL IN FORMATION 

The next form is used to record information about student’s prior secondary level education.  Assuming the student ID 
field is already populated, select ‘next block’ to enter the High School Details section. 

 

You can now enter the secondary school that the student attended.  You can view a list of schools by selecting F9 or 
you can use the search icon which is to the right of the ‘High School’ field.  You will be brought directly into the list of 
secondary school institutions (SOISBGI) where you can search for a particular school by use of the search (F8) and % 
(wildcard) function.  
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Simply enter part of the school name in the ‘Name’ field and use the % (wildcard) character to assist (e.g. %Christian% 
to find all Christian Brother schools) 

 

Tip: The search is case-sensitive, so you should consider this when entering your search criteria (e.g. omit the first 
character of a word if you are unsure of its case.) 

Select F8 to execute the query. F7 clears the form for a new query. 

Note that these school codes are numeric. Once you have found the relevant school, double click on the ‘Code’ field 
and it will select the appropriate school and enter it on the main SOASCH form.  

Save (F10) when school details are entered and exit the form. 

 

SGASADD - ADDITIONAL STUDENT IN FORMATION FORM 

The next form is SGASADD.  Assuming the correct ‘Student ID’ and ‘Term’ has defaulted, you should ‘next block’ 
twice to enter the Student Attribute section.  

You will now need to record the correct student ‘year of study’. 

Simply enter the correct year under the Attribute Code and save. A warning prompt box will appear. 

 

 

Click OK, save and exit. 

SGASTDN – GENERAL STUDENT 
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The next form in the QuickFlow is the General Student Form SGASTDN.  

First, you need to ensure the ‘Term’ of entry for the student is correct and then select ‘next block’ to enter/view 
information. This is the Student Record.  This first Block/Tab is the Learner Block. This is used to view student 
information such as student status and student tab. All information such as Fee Assessment Rate, Student Type, 
Full/Part Indicator should already be there from entering it via the SAAQUIK form.  

However, you will also need to enter additional data in the Additional Information section 

− You should enter the relevant Block Code (Prog & Year) in the Block field.  
− Under Session field, you should also ensure exchange, distance, e-learning or visiting occasional students are 

flagged, where applicable. See section below for further information 
 

 

Save (F10) updates when complete. 

 

EXCHANGE, DISTANCE, E-LEARNING OR VISITING OCCASIONAL STUDENTS 

If the student belongs to one of the options listed below, you will need to update accordingly under the ‘Fees, Mail 
Submission, Withdrawal Data’ tab.  
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Session 
Code Exchange / Non Standard Attendance / Mode of Study Category 

S Exchange – Erasmus/ Socrates incoming exchange 
I Exchange – Other incoming exchange 
O Exchange – Outgoing Exchange 
C Distance Education 
L E-Learning 
N In-Service Education 
Q Postgraduate Qualifier 
V Visiting Occasional/JYA 1 Term 
J Visiting Occasional/JYA 2 Terms 
Y Visiting Occasional/JYA Full Year 
C Distance Education 
L E-Learning 
N In-Service Education 

  

Under the Additional Data section, select the appropriate option from the Session field. 

 

Save changes when complete. 

TSAACCT – ACCOUNT REVIEW FORM STUDENT 

The next form on the QuickFlow is TSAACCT. This is used to check what contracts the student is attached to for the 
current term. 

To enter the form, confirm the Student ID is correct in the key block and then ‘next block’ four times into the form. 
This will bring you to the Contracts section of the form. 

 

In most instances, you should expect this to be blank (i.e. no contracts attached to the student). 

DELETING CONTRACTS 
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However, if the student previously studied a full-time programme at DIT, it may be possible that they are incorrectly 
attached to a contract(s) for the current term (i.e. a contract from an old term inadvertently copied over to the new term). 

 

 

E.g. Student active on 3000-35 for the Term 201213.  

In most instances, part-time students are liable for their own fees and are not entitled to any funding from a third party 
(thus should not be attached to any contract). In order to delete a student from a contract simply enter a D against the 
Delete Indicator for the contract(s) in question and save changes. 

 

D indicator flagged against contracts for Term 201213 

Note: You do not need to ‘Delete’ contracts from previous terms. You should only be checking for any unexpected 
contracts for the current term that should be deleted. 
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SFAREGS - STUDENT COURSE REGISTRATION FORM 

The next form is SFAREGS.  Again, ‘next block’ from the key block. 

 

Select the Student Term tab. If the Block Code has not already been entered, ensure you update it in the Block Schedule 
field.  Save and return to the Registration tab. 

 

Where programme modules have fees attached, you should also ensure the student is registered on those modules before 
you process any payment. 

Save two times to process fees and all amendments to the record.  
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TSAEXPT - EXEMPTION AUTHORIZATION FORM 

The next form is TSAEXPT and is used to manage the students eligible for Staff discounts.  Enter the Exemption Code 
as designated for the relevant Term. (e.g. 8012 is used for Staff Waivers 201213). Ensure the Term is correct. Then 
select ‘next block’. You will notice the Description ‘Staff Waivers…’. 

 

Now, you ‘next block’ a further four times until you are brought to the ‘Person Authorization’ Block. In this section 
you will notice a list of students.  You will need to enter your student details here.  To enter a new record, select F6 and 
enter the student ID. Save and exit. 

 

Maximum amount: If a student is not receiving 100% fee discount, you can enter the maximum fee DIT is going to 
discount for the student. 
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TSASPAY – STUDENT PAYMENT FORM 

When you’ve entered this form, ensure the key block details are correct and select ‘next block’.  

The following pop-up box will appear. Click on the ‘Return’ button and you will notice that a discount is applied to the 
students account. 

 

You can now exit this form. 

SFAREGS – STUDENT COURSE REGISTRATION FORM (SFAREGS) 

The final form will be the Student Course Registration Form (SFAREGS) again.  Select ‘next block’ when you enter 
the form.  

Saving twice on SFAREGS will trigger ‘Fee Assessment’. The payment options should now appear at the bottom of the 
form. Payment can now be taken for a student, where applicable.  

Alternatively, you can opt to save the registration record as EL (Eligible to Register). Following this, you can generate 
an ITR (Invitation to Register) for the student so that the individual can register and pay fees online themselves. 
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2N D & SUBSEQUENT YEAR STUDENTS – QUICKFLOW: STF2 

This QuickFlow will manually progress students who are DIT Staff and are entitled to the DIT Staff waiver.  

 

TSAACCT – ACCOUNT REVIEW FORM STUDENT 

The first form of the SFT2 QuickFlow is TSAACCT. This is used to check if a student is incorrectly attached to a 
contract(s) for the current term. 

To enter the form, confirm the Student ID is correct in the key block and then ‘next block’ four times into the form. 
This will bring you to the Contracts section of the form. 

 

In most instances, you should expect this to be blank (i.e. no contracts attached to the student). 

DELETING CONTRACTS 
However, if the student previously studied a full-time programme at DIT, it may be possible that they are incorrectly 
attached to a contract(s) for the current term (i.e. a contract from an old term inadvertently copied over to the new term). 

 

 

E.g. Student active on 3000-35 for the Term 201213.  

In most instances, part-time students are liable for their own fees and are not entitled to any funding from a third party 
(thus should not be attached to any contract). In order to delete a student from a contract simply enter a D against the 
Delete Indicator for the contract(s) in question and save changes. 
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D indicator flagged against contracts for Term 201213 

Note: You do not need to ‘Delete’ contracts from previous terms. You should only be checking for any unexpected 
contracts for the current term that should be deleted. 

 

SGASADD – ADDITIONAL STUDENT IN FORMATION 

The next form in the QuickFlow is SGASADD. This Form will enable you update the Student Attribute Code to reflect 
the correct Year of Study. 

Ensure the correct ‘ID’ and ‘Term’ is entered. The student ID will default from the previous screen. Your term should 
reflect the term the student is progressing to.  

Select ‘next block’ twice to enter the ‘Student Attribute’ section. You should notice the old term and Attribute Code.  
You now need to update this to reflect the new attribute code for the new term. 

Select the Maintenance Icon. Choose Copy Student Attribute 

 

Select OK to the following prompt. 

 

You should now notice the old attribute code has been copied to the new term. You now need to remove this old 
attribute code. 

 

From the Menu, select Record -> Remove. 



BANNER OPERATIONAL USER GUIDE 

 

Page 193 of 351 

 

Again, you will be prompted with the same previous ‘warning alert’. Select OK to proceed. Attribute Code should now 
be blank. 

Now enter the correct ‘Year of Study’ for the new term and save changes. Attribute Code should be updated for the new 
term. 

Save changes and exit form. 

 

SFAREGS – STUDENT COURSE REGISTRATION FORM 

Next form is SFAREGS, enter the correct ‘term’ and ‘student ID’ in the key block field. Then select ‘next block’. 

On entering the last form SFAREGS, ensure the correct term (i.e. Term student is progressing to) and student ID is in 
the key block field. Then select ‘next block’. 

PROGRESS STUDENT’S CURRICULA TO NEW TERM ON SAME PROGRAMME 
Firstly, you should navigate to the Curricula tab. You now need to manually progress the student’s registration record 
to the new term. To do this you need to select the ‘Duplicate’ icon.  

 

This creates a copy of the existing curricula record for the new Term. Save changes when complete. 
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UPDATE BLOCK CODE 
Next, you should navigate to the Student Term tab. Update the Block Schedule field as appropriate for the new year of 
Study. 

 

 
UPDATE STUDENT TYPE 
Under the same tab (i.e. Student Term) you may also need to update the Student Type. If the student was previously a 
new entrant (N) and is now being progressed the next term, then you must update the student type appropriately. 
Students continuing or re-enrolling on a particular programme of study will have a student type corresponding to their 
student level:  
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A – Apprentice 
C – Continuing Education 
D – Professional Development 
U – Undergraduate 
P – Postgraduate 
R – Research 
 
However, as part of our obligation to return student data to the HEA annually, it is now required that where applicable, 
we also code students according to the criteria below. Therefore if Student Type is considered to be a ‘transfer’ or 
‘repeat’ student, the student type should be updated as follows: 

Student Type Description 
X Transfer-In from own institution 
I Transfer-In from other higher education institution 
B Repeat (Students repeating the same year of the same course for which they are primarily registered) 
 
Select the drop down list beside Student Type field to view list of available options. 
Note: You may also be required to update other fields on this tab if necessary (e.g. if the Rate Code is different for the 
new Term) 

You should now navigate to the Registration tab.  

Where programme modules have fees attached, you should also ensure the student is registered on those modules before 
you process any payment. 

Saving twice on SFAREGS will then trigger ‘Fee Assessment’ and the payment options should now appear at the 
bottom of the form. Payment can now be taken for a student.  

Alternatively, you can opt to save the registration record as EL (Eligible to Register). Following this, you can generate 
an ITR (Invitation to Register) for the student so that the individual can register and pay fees online themselves. 

Exit SFAREGS to continue with QuickFlow. 

 

SGASTDN – GENERAL STUDENT 

The final form in the QuickFlow is the General Student Form SGASTDN.  

Again, you need to ensure the term (i.e. progression term) for the student is correct and then select ‘next block’ to 
enter/view information. This is the Student Record.  This first Block/Tab is the Learner Block. This is used to view 
student information such as student status and student tab. All information such as Fee Assessment Rate, Student Type, 
Full/Part Indicator should already be there having just progressed the student from the previous term. 

The only thing you need to check on this form is to flag a student as exchange, distance, e-learning or visiting 
occasional students, where applicable. If this does not apply to this particular student, simply exit the form. 

Alternatively, if this was entered for a particular student on a previous term and no longer applies, ensure it is removed 
for the current term record. 
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EXCHANGE, DISTANCE, E-LEARNING OR VISITING OCCASIONAL STUDENTS 
If the student belongs to one of the options listed below, you will need to update accordingly on the Session field 
(Additional Information section).  

 

Session 
Code Exchange / Non Standard Attendance / Mode of Study Category 

S Exchange – Erasmus/ Socrates incoming exchange 
I Exchange – Other incoming exchange 
O Exchange – Outgoing Exchange 
C Distance Education 
L E-Learning 
N In-Service Education 
Q Postgraduate Qualifier 
V Visiting Occasional/JYA 1 Term 
J Visiting Occasional/JYA 2 Terms 
Y Visiting Occasional/JYA Full Year 
C Distance Education 
L E-Learning 
N In-Service Education 

  

Save (F10) when complete. 
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TSAEXPT - EXEMPTION AUTHORIZATION FORM 

The next form is TSAEXPT and is used to manage the students eligible for Staff discounts.  Enter the Exemption Code 
as designated for the relevant Term. (e.g. 8012 is used for Staff Waivers 201213). Ensure the Term is correct. Then 
select ‘next block’. You will notice the Description ‘Staff Waivers…’. 

 

Now, you ‘next block’ a further four times until you are brought to the ‘Person Authorization’ Block. In this section 
you will notice a list of students.  You will need to enter your student details here.  To enter a new record, select F6 and 
enter the student ID. Save and exit. 

 

Maximum amount: If a student is not receiving 100% fee discount, you can enter the maximum fee DIT is going to 
discount for the student. 
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TSASPAY – STUDENT PAYMENT FORM 

When you’ve entered this form, ensure the key block details and correct and select ‘next block’.  

The following pop-up box will appear. Click on the Return button and you will notice that a discount has been applied 
to the student’s account. 

 

You can now exit this Form. 

 

SFAREGS – STUDENT COURSE REGISTRATION FORM (SFAREGS) 

Saving twice on SFAREGS will trigger ‘Fee Assessment’. The payment options should now appear at the bottom of the 
form. Payment can now be taken for a student, where applicable.  

Alternatively, you can opt to save the registration record as EL (Eligible to Register). Following this, you can generate 
an ITR (Invitation to Register) for the student so that the individual can register and pay fees online themselves. 
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 ALUMNI REGISTRATIONS 
An Alumni Student has studied in DIT before and is a member of DIT’s Graduate Network - Alumni Association. 
Assuming they present their Alumni card at registration they are entitled to receive a discount on tuition fees for part-
time programmes only. 

As with the part-time registrations, QuickFlows have been set-up in Banner to handle Alumni registrations. 

Since the student is a member of the DIT Alumni, we can assume the student studied at DIT previously. Therefore, they 
will most likely have a previous student record in Banner. You should always reference and use the same student 
number when processing new application details for a student in Banner, rather than generating a new ID. If the student 
graduated from DIT pre-2001, then the student’s details may not exist in Banner. Either way, you should always search 
for the student’s details before generating a new ID. 

Before entering the ALM1 QuickFlow, you can search for the student in the form SOAIDNS. 

Note: GUIALTI (Alternate ID Search) is an alternative search form with allows you to search by PPS no. and Date of 
Birth. 

 

SOAIDNS – PERSON SEARCH DETAIL 
Enter the form. Enter the search information in any of the following fields: 

− ID 
− Last Name 
− First Name 
− Middle Name 
− Birth Date 
− Gender 

 

You should also use the % (wildcard) option in order to broaden or narrow your search criteria. Note also that the text is 
‘case-sensitive’, so you are advised to use the % character in place of any character you are unsure of case (e.g. 
%urphy% to search for Murphy). 

 

You can enter text in any number of combinations. To query the data, simply select F8 and all corresponding data will 
be returned. Along with the student’s name, gender and date of birth, you will also see the student’s address details and 
curricula information. This should help you identify the correct student.  

If you wish to perform a new search, simply select F7 to clear the form. Enter new search criteria and select F8 again to 
execute the search query.  

  

http://www.dit.ie/graduatenetwork/
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1S T YEAR ALUMNI STUDENTS – QUICKFLOW: ALM1 

 

SAAQUIK – QUICK ENTRY 

The first form of the ALM1 QuickFlow is SAAQUIK.   

 

If you know the student ID, enter it in the ID field.  Next, tab across to the term field and enter the academic term (e.g. 
201011) and then the level (e.g. PG).  The level is the level of the Programme the student is studying. Then select ‘next 
block’. 

 

 

If there is no record of the student in Banner and you have to create a new student record, select the ‘Generate ID’ icon 
on the right. 

 

  

  

In the prompt box, enter the student’s last name and first name detail and then save. 

Banner will generate a new student ID at this point.  Take note on the enrolment form of this number. Next, tab across 
to the term field and enter the academic term (e.g. 201213) and then to the level (e.g. (PG).  The level is the level of the 
Programme the student is studying. Then select ‘next block’. 

Once the student ID and key block information has been established, you ‘next block’ into the form and a dialogue box 
will appear. Select OK as this is just a note to inform you that certain values will be defaulted. 

Note that ‘Student Type’ defaults to the appropriate code depending on the Level entered in the key block. 
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AP – A (Apprentice) 
CE – C (Continuing) 
PD – D (Professional) 
PG – P (Postgraduate) 
PR – R (Research) 
UG – U (Undergraduate) 
 

Note: Since the student is part of DIT Alumni, it is assumed that these students will never be coded as N (New 
Entrants). 

However, as part of our obligation to return student data to the HEA annually, it is also required that where applicable 
we code students according to the criteria below. Therefore if Student Type is considered to be a ‘transfer’ or ‘repeat’ 
student, the student type should be updated as follows: 

Student Type Description 
X Transfer-In from own institution 
I Transfer-In from other higher education institution 
B Repeat (Students repeating the same year of the same course for which they are primarily registered) 
  

Select the drop down list beside Student Type field to view list of available options. 

Now enter the following parameters: 

− Full or Part Time: (e.g. P) 
− Rate: (e.g. PART) 

 

Next you navigate to the Curriculum section. To enter the Programme Code click on the Program field and enter the 
relevant Code and save. The other associated field entries will default in. 

 

Save at this point to create new student record. 
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Next you will need to enter the Address Information. Choose the Address tab. 

Note: You can also navigate between the tabs by use of the ‘next block’ and ‘previous block’ Icons 

You will now need to validate any previous address record(s) for the student. In the case of updating the address details, 
be sure to insert new address records rather than over-typing the old address. To do this, simply select the Address tab. 
On the old address, enter a ‘to-date’ to reflect the end date of this address and check the Inactivate Address check-box.  

  

Where required, a new Home address for the student must be entered.  Select on the Address Tab 

From here, select the ‘return’ key and today’s date will automatically populate the ‘From date’ field. Enter HM in the 
address type field to record a Home Address for the student. Then enter the address details in the appropriate fields.  

When entering the address information you will need to enter the address under the Street Line fields as well as the 
City, County, Nation and Carrier Route fields.   

 

Address data as follow: 

− City: City of address 
− County Code: County codes including Dublin postal district codes. There is a look up table here. Double click 

to view 
− Nation Code: This is also a look up table. Double click to view. When entering the nation code enter the 

nation pertaining to the address, as opposed to the student’s nationality. 
− Carrier Route: This is used to record the accommodation type of the student for the purpose of HEA 

statistical returns. This is a free text field, but you must use the following two character codes only when 
entering this information: 

PH  Parental Home 
RA  Rented Accommodation 
OH  Own Home (house, apartment) 
OA  Other Accommodation  
NS Not Specified 
 

Note: You do not need to enter Sate or Zip code information. 
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To enter another address at this point, you can enter a new record by selecting F6 and entering the relevant details as 
above. However, you should be aware that the most recent address entered will be the address used for written 
correspondence with the student. 

Finally on the Addresses tab, you can enter the student’s telephone details. You can select the Telephone Type (e.g. 
HM) from the drop-down list. 

Save changes when complete. 

Next, select the Biographical Information tab. On this tab, you must enter Gender, Date of Birth, SSN (PPS no.) and 
Citizenship.  All are mandatory for the purpose of HEA statistical returns. 

− Gender 
− Date of birth in the format day-month-year this will automatically populate the age box 
− Citizenship 
− PPSN number should be added into the box labeled SSN/SIN/TFN. 

 

 

Save changes and exit the form. 

You have now completed the first form of this QuickFlow. To progress to the next form, simply exit this form by 
selecting the EXIT icon at the top right-hand corner. 
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GOAINTL – INTERNATIONAL IN FORMATION 

The next form available on the QuickFlow is GOAINTL and relates to Visa and Nationality Information.  

First, you need to ‘next block’ to get to the Visa Information section. Use the VISA type code box to enter the visa type 
if available. 

Note: If the student is Irish, enter NS 

F10 to save changes. 

 

Now select the Nationality tab. 

 

Enter the Nation of Birth by selecting from the drop down list.  This field is mandatory and must be entered.  If you 
already know the code, you can enter it directly. 

Save (F10) and exit the Form. 
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SOAPCOL – PRIOR COLLEGE 

The next form is the Prior College SOAPCOL Form. This is where information about student’s prior third level 
education is held. Assuming the Student ID field is already populated, select ‘next block’ to enter the Prior College 
section.  

You can now enter the last college that the student attended.   

 

You can view a list of colleges by selecting F9 or selecting the search icon to the right of the Prior College field.  

 

You will be brought directly into the list of third level institutions (SOISBGI). This list will initially appear blank. 
Select the query function (F8) to retrieve the full list of institutions. Select the desired institution by double clicking in 
the ‘Code’ field cell of the desired row selection.  
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Your Prior College will be entered.  Once you have selected the relevant college code, you can now save at this point. 

You can also select and add information under the Degree Details section. If the student has graduated you should enter 
the relevant degree information including Degree, Degree Date and Year. 

 

 

Save (F10) and exit the Form. 

 

SOAHSCH – HIGH SCHOOL IN FORMATION 

The next form is used to record information about student’s prior secondary level education.  Assuming the student ID 
field is already populated, select ‘next block’ to enter the High School Details section. 
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You can now enter the secondary school that the student attended.  You can view a list of schools by selecting F9 or 
you can use the search icon which is to the right of the ‘High School’ field.  You will be brought directly into the list of 
secondary school institutions (SOISBGI) where you can search for a particular school by use of the search (F8) and % 
(wildcard) function.  

 

 

Simply enter part of the school name in the ‘Name’ field and use the % (wildcard) character to assist (e.g. %Christian% 
to find all Christian Brother schools) 
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Tip: The search is case-sensitive, so you should consider this when entering your search criteria (e.g. omit the first 
character of a word if you are unsure of its case.) 

Select F8 to execute the query. F7 clears the form for a new query. 

Note that these school codes are numeric. Once you have found the relevant school, double click on the ‘Code’ field 
and it will select the appropriate school and enter it on the main SOASCH form.  

Save (F10) when school details are entered and exit the form. 

 

SGASADD - ADDITIONAL STUDENT IN FORMATION FORM 

The next form is SGASADD.  Assuming the correct ‘Student ID’ and ‘Term’ has defaulted, you should ‘next block’ 
twice to enter the Student Attribute section.  

You will now need to record the correct student ‘year of study’. 

Simply enter the correct year under the Attribute Code and save. A warning prompt box will appear. 

 

 

Click OK, save and exit. 
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SGASTDN – GENERAL STUDENT 

The next form in the QuickFlow is the General Student Form SGASTDN.  

First, you need to ensure the ‘Term’ of entry for the student is correct and then select ‘next block’ to enter/view 
information. This is the Student Record.  This first Block/Tab is the Learner Block. This is used to view student 
information such as student status and student tab. All information such as Fee Assessment Rate, Student Type, 
Full/Part Indicator should already be there from entering it via the SAAQUIK form.  

However, you will also need to enter additional data in the Additional Information section 

− You should enter the relevant Block Code (Prog & Year) in the Block field.  
− Under Session field, you should also ensure exchange, distance, e-learning or visiting occasional students are 

flagged, where applicable. See section below for further information 
 

 

Save (F10) updates when complete. 

 

EXCHANGE, DISTANCE, E-LEARNING OR VISITING OCCASIONAL STUDENTS 

If the student belongs to one of the options listed below, you will need to update accordingly under the ‘Fees, Mail 
Submission, Withdrawal Data’ tab.  
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Session 
Code Exchange / Non Standard Attendance / Mode of Study Category 

S Exchange – Erasmus/ Socrates incoming exchange 
I Exchange – Other incoming exchange 
O Exchange – Outgoing Exchange 
C Distance Education 
L E-Learning 
N In-Service Education 
Q Postgraduate Qualifier 
V Visiting Occasional/JYA 1 Term 
J Visiting Occasional/JYA 2 Terms 
Y Visiting Occasional/JYA Full Year 
C Distance Education 
L E-Learning 
N In-Service Education 

  

Under the Additional Data section, select the appropriate option from the Session field. 

 

Save changes when complete. 

 

TSAACCT – ACCOUNT REVIEW FORM STUDENT 

The next form on the QuickFlow is TSAACCT. This is used to check what contracts the student is attached to for the 
current term. 

To enter the form, confirm the Student ID is correct in the key block and then ‘next block’ four times into the form. 
This will bring you to the Contracts section of the form. 

 

In most instances, you should expect this to be blank (i.e. no contracts attached to the student). 
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DELETING CONTRACTS 
However, if the student previously studied a full-time programme at DIT, it may be possible that they are incorrectly 
attached to a contract(s) for the current term (i.e. a contract from an old term inadvertently copied over to the new term). 

 

 

E.g. Student active on 3000-35 for the Term 201213.  

In most instances, part-time students are liable for their own fees and are not entitled to any funding from a third party 
(thus should not be attached to any contract). In order to delete a student from a contract simply enter a D against the 
Delete Indicator for the contract(s) in question and save changes. 

 

D indicator flagged against contracts for Term 201213 

Note: You do not need to ‘Delete’ contracts from previous terms. You should only be checking for any unexpected 
contracts for the current term that should be deleted. 
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SFAREGS - STUDENT COURSE REGISTRATION FORM 

The final form is SFAREGS.  Again, ‘next block’ from the key block. 

 

Select the Student Term tab. If the Block Code has not already been entered, ensure you update it in the Block Schedule 
field.  Save and return to the Registration tab. 

 

Where programme modules have fees attached, you should also ensure the student is registered on those modules before 
you process any payment. 

Save two times to process fees and all amendments on the student record.  
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TSAEXPT - EXEMPTION AUTHORIZATION FORM 

The next form is TSAEXPT and is used to manage the students eligible for Alumni discounts.  Enter the Exemption 
Code 8050 and ensure the Term is correct. Then select ‘next block’. You will notice the Description ‘Alumni Discount - 
25%’. 

 

Now, you ‘next block’ a further four times until you are brought to the Person Authorization block. In this section you 
will notice a list of students.  You will need to enter your student details here.   

To enter a new record, select F6 and enter the student ID. 

Save updates and exit the form. 

 

TSASPAY – STUDENT PAYMENT FORM 

When you’ve entered this form, ensure the key block details are correct and select ‘next block’.  

The following pop-up box will appear. Click on the Return button and you will notice that a discount of 25% has been 
applied to the students account. 

 

You can now exit this form. 
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SFAREGS – STUDENT COURSE REGISTRATION FORM (SFAREGS) 

The final form will be the Student Course Registration Form (SFAREGS) again.   

‘Next block’ when you enter the form.  

Saving twice on SFAREGS will trigger ‘Fee Assessment’. The payment options should now appear at the bottom of the 
form. Payment can now be taken for a student, where applicable. 

Alternatively, you can opt to save the registration record as EL (Eligible to Register). Following this, you can generate 
an ITR (Invitation to Register) for the student so that the individual can register and pay fees online themselves. 
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2N D & SUBSEQUENT YEAR STUDENTS – QUICKFLOW: ALM2 

This QuickFlow will manually progress ‘Alumni’ students to the next academic term.  

 

TSAACCT – ACCOUNT REVIEW FORM STUDENT 

The first form on the QuickFlow is TSAACCT. This is used to check if a student is incorrectly attached to a contract(s) 
for the current term. 

To enter the form, confirm the Student ID is correct in the key block and then ‘next block’ four times into the form. 
This will bring you to the Contracts section of the form. 

 

In most instances, you should expect this to be blank (i.e. no contracts attached to the student). 

DELETING CONTRACTS 
However, if the student previously studied a full-time programme at DIT, it may be possible that they are incorrectly 
attached to a contract(s) for the current term (i.e. a contract from an old term inadvertently copied over to the new term). 

 

 

E.g. Student active on 3000-35 for the Term 201213.  

In most instances, part-time students are liable for their own fees and are not entitled to any funding from a third party 
(thus should not be attached to any contract). In order to delete a student from a contract simply enter a D against the 
Delete Indicator for the contract(s) in question and save changes. 
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D indicator flagged against contracts for Term 201213 

Note: You do not need to ‘Delete’ contracts from previous terms. You should only be checking for any unexpected 
contracts for the current term that should be deleted. 

 

SGASADD – ADDITIONAL STUDENT IN FORMATION 

The next form in the QuickFlow is SGASADD. This Form will enable you update the Student Attribute Code to reflect 
the correct Year of Study. 

Ensure the correct ‘ID’ and ‘Term’ is entered. The student ID will default from the previous screen. Your term should 
reflect the term the student is progressing to.  

Select ‘next block’ twice to enter the ‘Student Attribute’ section. You should notice the old term and Attribute Code.  
You now need to update this to reflect the new attribute code for the new term. 

Select the Maintenance Icon. Choose Copy Student Attribute 

 

Select OK to the following prompt. 

 

You should now notice the old attribute code has been copied to the new term. You now need to remove this old 
attribute code. 

 

From the Menu, select Record -> Remove. 
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Again, you will be prompted with the same previous ‘warning alert’. Select OK to proceed. Attribute Code should now 
be blank. 

Now enter the correct ‘Year of Study’ for the new term and save changes. Attribute Code should be updated for the new 
term. 

Save changes and exit form. 

 

SFAREGS – STUDENT COURSE REGISTRATION FORM 

Next form is SFAREGS, enter the correct ‘term’ and ‘student ID’ in the key block field. Then select ‘next block’. 

On entering the last form SFAREGS, ensure the correct term (i.e. Term student is progressing to) and student ID is in 
the key block field. Then select ‘next block’. 

PROGRESS STUDENT’S CURRICULA TO NEW TERM ON SAME PROGRAMME 
Firstly, you should navigate to the Curricula tab. You now need to manually progress the student’s registration record 
to the new term. To do this you need to select the ‘Duplicate’ icon.  

 

This creates a copy of the existing curricula record for the new Term. Save changes when complete. 
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UPDATE BLOCK CODE 
Next, you should navigate to the Student Term tab. Update the Block Schedule field as appropriate for the new year of 
Study. 

 

 
UPDATE STUDENT TYPE 
Under the same tab (i.e. Student Term) you may also need to update the Student Type. If the student was previously a 
new entrant (N) and is now being progressed the next term, then you must update the student type appropriately. 
Students continuing or re-enrolling on a particular programme of study will have a student type corresponding to their 
student level:  
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A – Apprentice 
C – Continuing Education 
D – Professional Development 
U – Undergraduate 
P – Postgraduate 
R – Research 
 
However, as part of our obligation to return student data to the HEA annually, it is now required that where applicable, 
we also code students according to the criteria below. Therefore if Student Type is considered to be a ‘transfer’ or 
‘repeat’ student, the student type should be updated as follows: 

Student Type Description 
X Transfer-In from own institution 
I Transfer-In from other higher education institution 
B Repeat (Students repeating the same year of the same course for which they are primarily registered) 
 
Select the drop down list beside Student Type field to view list of available options. 
Note: You may also be required to update other fields on this tab if necessary (e.g. if the Rate Code is different for the 
new Term) 

You should now navigate to the Registration tab.  

Where programme modules have fees attached, you should also ensure the student is registered on those modules before 
you process any payment. 

Saving twice on SFAREGS will then trigger ‘Fee Assessment’ and the payment options should now appear at the 
bottom of the form. Payment can now be taken for a student.  

Alternatively, you can opt to save the registration record as EL (Eligible to Register). Following this, you can generate 
an ITR (Invitation to Register) for the student so that the individual can register and pay fees online themselves. 

Exit SFAREGS to continue with QuickFlow. 

 

SGASTDN – GENERAL STUDENT 

The final form in the QuickFlow is the General Student Form SGASTDN.  

Again, you need to ensure the term (i.e. progression term) for the student is correct and then select ‘next block’ to 
enter/view information. This is the Student Record.  This first Block/Tab is the Learner Block. This is used to view 
student information such as student status and student tab. All information such as Fee Assessment Rate, Student Type, 
Full/Part Indicator should already be there having just progressed the student from the previous term. 

The only thing you need to check on this form is to flag a student as exchange, distance, e-learning or visiting 
occasional students, where applicable. If this does not apply to this particular student, simply exit the form. 

Alternatively, if this was entered for a particular student on a previous term and no longer applies, ensure it is removed 
for the current term record. 
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EXCHANGE, DISTANCE, E-LEARNING OR VISITING OCCASIONAL STUDENTS 
If the student belongs to one of the options listed below, you will need to update accordingly on the Session field 
(Additional Information section).  

 

Session 
Code Exchange / Non Standard Attendance / Mode of Study Category 

S Exchange – Erasmus/ Socrates incoming exchange 
I Exchange – Other incoming exchange 
O Exchange – Outgoing Exchange 
C Distance Education 
L E-Learning 
N In-Service Education 
Q Postgraduate Qualifier 
V Visiting Occasional/JYA 1 Term 
J Visiting Occasional/JYA 2 Terms 
Y Visiting Occasional/JYA Full Year 
C Distance Education 
L E-Learning 
N In-Service Education 

  

Save (F10) when complete. 
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TSAEXPT - EXEMPTION AUTHORIZATION FORM 

The next form is TSAEXPT and is used to manage the students eligible for Alumni discounts.  Enter the Exemption 
Code 8050 and ensure the Term is correct. Then select ‘next block’. You will notice the Description ‘Alumni Discount - 
25%’. 

 

Now, you ‘next block’ a further four times until you are brought to the Person Authorization block. In this section you 
will notice a list of students.  You will need to enter your student details here.   

To enter a new record, select F6 and enter the student ID. 

Save updates and exit the form. 

 

TSASPAY – STUDENT PAYMENT FORM 

When you’ve entered this form, ensure the key block details are correct and select ‘next block’.  

The following pop-up box will appear. Click on the Return button and you will notice that a discount of 25% has been 
applied to the students account. 

 

You can now exit this form. 
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SFAREGS – STUDENT COURSE REGISTRATION FORM (SFAREGS) 

The final form will be the Student Course Registration Form (SFAREGS) again.   

‘Next block’ when you enter the form.  

Saving twice on SFAREGS will trigger ‘Fee Assessment’. The payment options should now appear at the bottom of the 
form. Payment can now be taken for a student, where applicable.  

Alternatively, you can opt to save the registration record as EL (Eligible to Register). Following this, you can generate 
an ITR (Invitation to Register) for the student so that the individual can register and pay fees online themselves. 
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JUNIOR CONSERVATORY OF 
MUSIC REGISTRATIONS  
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The Conservatory of Music & Drama offers individual and/or class tuition in vocal, instrumental and musicianship 
studies. This part-time programme offers students the option to study a variety of tuition and practical classes. The 
Programme Code associated with this Course is A001. 

Because of the uniqueness and varied options offered on this programme, the processes for setting up modules, CRNs, 
enrolling, registering students and calculating fees are unique for A001.  

A001 TUITION & PRACTICAL MODULES / CRNS 
There are two types of modules for programme A001. These include ‘Theory Related’ and ‘Practical Instrumental’ 
classes. Each of these modules usually relate to ‘Flat Fee’ and ‘Billing Hours Fees’ respectively. 

 
BILLING HOUR MODULES & CRNS 
Billing Hour modules are set-up in Banner for the A001 programme to represent practical instrumental classes. These 
classes are unique from any other module within DIT in that the class may be offered over varying durations. For this 
very reason, ‘billing hour’ modules are set-up in Banner with a billing hour range associate with them. 

SCACRSE – BASIC COURSE IN FORMATION 
SCACRSE is used to create the basic module course information. Module data is set-up and created similar to any other 
module in Banner. The key difference is in relation to the input of Billing Hours range. This is set-up with a Range 0-3. 
Further information unique to these Modules includes the following: 

College – 00 (Dublin Institute of Technology) 
Department – AT01 (School of Conservatory of Music & Drama) 
Billing – Range 0 to 3 
CEU or Credit - 0 
Level – CE 
Grade Mode – G 
Schedule Type – MP (note: this code is ignored by the CMIS interface and is therefore not set-up in the Timetabling 
system Furthermore, MP or Music Practical is the Schedule Type used for these Billing Hours Module) 
 

 

e.g. Module VION 5026 - Example of A001 Billing Hour Module in Banner 
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Note: Historically (i.e. pre re-org of DIT Colleges and Schools), the College Code against Junior Music modules would 
have been 45 (College of Applied Arts) and the Department Code would have reflected the instrument of study, as 
opposed to School Code.   
 

SSASECT – SCHEDULE 
SSASECT is used create and maintain the CRN (course reference numbers) associated with the module. Again, the set-
up is similar to creating any CRN in Banner. Most information will be inherited from the module it has been set-up 
against (i.e. Subject & Course No.). The following data input is unique to this type of CRN: 

Campus – ADL 
Credit Hours – 0 
Billing Range – 0 To 3 
Schedule Type – MP 
Part of Term – 1 year 
Meeting Type – CLAS 
 

As with any Active CRN, Section Enrolment Information should be set to a Maximum of 999. 

Note also that Meeting Time Block needs to be updated prior to adding lecturer information to the Instructor Block.  

Note: As part of Term Roll, CRN are progressed to the new Term with the same Lecturer as previous Term. This must 
be updated where appropriate following changes to Lectures on these Modules. It must also be update prior to 
registering Students on a given CRN. If unknown, it may be set to the relevant TBA option. 

 

 

CRN 4087 - Example of A001 Billing Hour CRN in Banner 
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FLAT FEE MODULES & CRNS 
Theory related modules are set-up with a flat fee structure. In other words, there is no ‘billing hours range’ associated 
with these modules. Instead a flat fee is associated directly with the CRN. 

 

SCACRSE – BASIC COURSE IN FORMATION 
SCACRSE is used to create the basic module course information. The Schedule Type for a ‘flat fee’ module will be MT 
(Music Theory). Further information unique to these Modules includes the following: 

College – 00 (Dublin Institute of Technology) 
Department – e.g. AT01 (School of Conservatory of Music) 
CEU or Credit – 0 
Billing - 0 
Level – CE 
Grade Mode – G 
Schedule Type – MT 
 
Note: Historically (i.e. pre re-org of DIT Colleges and Schools), the College Code against Junior Music modules would 
have been 45 (College of Applied Arts) and the Department Code would have reflected Academic Studies department, 
as opposed to School Code.   
 

 

GSMU 5005 is an example of a ‘flat fee’ Module in Banner. 

 

SCADETL – COURSE DETAIL IN FORMATION 
To assign a set flat fee against a Module, form SCADETL is used.  Enter the Subject, Course and Term Code in the key 
block and next block in the form. Select the Fee Codes tab.  
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Detail Code of MPRT should be entered along with an Amount. Fee Type will default to FLAT.  

 

 

 

Note: The fee set in this form is ‘Term Effective'. Therefore each year following the Term Roll, the Fees & Income 
Office will update this form with the new fee and ‘From Term’ information. This is necessary for Fee Assessment to 
process against any students registered on the CRN.  

Any CRN subsequently created from a fee module will automatically inherit that module fee. It is therefore important 
the fees are associated with the Module prior to setting up the CRN. 

 
SSASECT – SCHEDULE 
SSASECT is used create and maintain the CRN (course reference numbers) associated with the module. Ensure you 
enter the Subject & Course No as per your previously created Module data on SCACRSE.  

Note also that ‘flat fee’ CRNs will have no billing range set. The following data input is unique to this type of CRN: 

Campus – ADL 
Status - A 
Schedule Type – MT 
Part of Term – 1 year 
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Upon saving the new CRN details, you must enter the Section Enrolment Information. This should be set according 
to the number of places allocated to the CRN.  

The default Maximum Enrolment Count is 999.  

However, if the CRN is a musicianship class which is made available online for slot selection, you must ensure that the 
maximum enrolment count reflects accurately the number of places available on this class. Thus ensuring the class is 
not over subscribed. 

 

Next, go to the Meeting Times tab.  A Meeting Type of CLAS will default. Simply tab across each field on the record 
(start date and end date will default in) and enter Hours per Week of 0.  

In the case of musicianship classes which are part of the Online Musicianship Enrolment, you must also enter the Day, 
Start Time, End Time, Building and Room flag, thus ensuring these details are viewable to the students when selecting 
their slots online.  
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Now navigate to the bottom section to enter Lecturers/instructors IDs  

 

Note: As part of Term Roll, CRN are progressed to the new Term with the same Lecturer as previous Term. This must 
be updated where appropriate following changes to Lectures on these Modules. It must also be update prior to 
registering students on a given CRN. If unknown, it may be set to the relevant TBA option. 

 

SSATEXT – SECTION COMMENTS 
If the CRN being set-up is the ‘generic’ Grade CRN, which is used to ensure the correct CRN fee is assessed on the 
student’s account (in advance of slot enrolment), then you must also add long text detailing the requirements of the 
class. 

SSATEXT is used to add long text and can be accessed from within SSASECT’s menu: Options -> Course Section 
Comments. 

Enter the Form. Ensure the Term and CRN data are correct in the key block and next block twice to the Section Long 
Text. Enter required text and save. 

Text will be made available to students online when selecting a musicianship slot. 
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SSADETL – COURSE SECTION DETAIL 
Since the fee was set-up at the module level, the CRN will have automatically inherited that fee. To view the fee 
associated with the CRN, you need to access Form SSADETL. Again this can be accessed directly from the Menu: 
Options -> Course Section Detail [SSADETL]. You will notice a Fee Code (MPRT) and Amount in the Section Fees 
Block. 
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MUSICIANSHIP CLASSES - SLOT ENROLMENT 
Musicianship classes are offered at a number of different times and locations each week. Students must therefore select 
their preferred timeslot based on a first come, first served basis. Traditionally this was managed directly by the 
administrative staff within with the College of Arts and Tourism. In 2011, a slot enrolment facility was developed to 
enable students to select their preferred timeslot online. The principle of first come, first served still applies. However, 
only registered students with no outstanding fees may avail of this online facility. 

To support this process, a ‘generic’ Grade CRN is created for each unique type of musicianship class. CRNs are then 
replicated based on this ‘generic’ CRN reflecting each of the specific timeslots and enrolment capacities.  

The link between ‘generic’ Grade CRN and its associated timeslots is managed via from SZRMUSC in Banner 

 

To configure data on this form, you first enter the Term Code and ‘Grade CRN’ in the key block and ‘next block’ into 
the form. 

You then enter each CRN related to this Grade CRN in the Slots field. All data associated with each CRN will default in 
(i.e. Course Details, Day, Start & End Time, Lecturer, Max Enrolments, Building and Room). 

Once you are satisfied that the slot you entered is correct, you must validate it by checking the ‘Valid’ checkbox. This 
will ensure that the CRN is available to students online for selection. 

Any student registered on the Grade CRN (who has previously programme registered and paid any outstanding fees) 
will see the available slots for selection online. Upon selection of a given CRN, the student will then be registered on 
that CRN slot. 
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A001 CREATING NEW STUDENT RECORD - FIRST TIME ENTRANTS 
First time entrants to A001 can be set-up in Banner with an initial enrolment record using the following forms in Banner 

SAAQUIK – QUICK ENTRY 
In setting up new first time enrolments to Programme A001, the first Form is SAAQUIK.  This form is used to create a 
new student record (including a newly generate Student ID). 

Before you generate a new ID, you should you should always search the database to see if a person record already exists 
for the student. You can search for a student by selecting the ID drop-down and then Person Search.  You can also use 
form SOAIDNS for a more specific search. GUIALTI (Alternate ID Search) allows you to search by PPS no. and Date 
of Birth. 

To create a new student record, select the Generate ID icon on the right. 

 

In the prompt box, enter the student’s last name and first name detail and then save.  Banner will generate a new student 
ID at this point.  Take note on the enrolment form of this number. 

Next, tab across to the ‘Term’ field and enter the academic term (e.g. 201213) and then to the level ‘CE’.  This relates to 
the level of the Programme the student is studying (i.e. A001).  Then select ‘next block’. 

 

When you ‘next block’, a dialogue box will appear. Select OK as this is just a note to inform you that certain values will 
be defaulted. 

Now enter the following parameters: 

• Set Full or Part Time to P 
• Enter Program Code A001 in Program field 
 

F10 to save at this point. 
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Next you navigate to the Curriculum section. To enter the Programme Code click on the Program field and enter the 
relevant Code and save. The other associated field entries will default in. 

 

Save at this point to create new student record. 

Next you will need to enter the Address Information. Choose the Address tab. 

Note: You can also navigate between the tabs by use of the ‘next block’ and ‘previous block’ Icons 

From here, select the ‘return’ key and today’s date will automatically populate the ‘From date’ field. Enter HM in the 
address type field to record a Home Address for the student. Then enter the address details in the appropriate fields.  

When entering the address information you will need to enter the address under the Street Line fields as well as the 
City, County, Nation and Carrier Route fields.   

 

Address data as follow: 
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− City: City of address 
− County Code: County codes including Dublin postal district codes. There is a look up table here. Double click 

to view 
− Nation Code: This is also a look up table. Double click to view. When entering the nation code enter the 

nation pertaining to the address, as opposed to the student’s nationality. 
− Carrier Route: This is used to record the accommodation type of the student for the purpose of HEA 

statistical returns. This is a free text field, but you must use the following two character codes only when 
entering this information: 

PH  Parental Home 
RA  Rented Accommodation 
OH  Own Home (house, apartment) 
OA  Other Accommodation  
NS Not Specified 
 

Note: You do not need to enter Sate or Zip code information. 

To enter another address at this point, you can enter a new record by selecting F6 and entering the relevant details as 
above. However, you should be aware that the most recent address entered will be the address used for written 
correspondence with the student. 

If an address record already exists but it is no longer valid, you can de-activate it and enter a new one. See the section 
on ‘Updating Student’s Address’ for more information. 

Finally on the Addresses tab, you can enter the student’s telephone details. You can select the Telephone Type (e.g. 
HM) from the drop-down list. 

Save changes when complete. 

Next, select the Biographical Information tab. On this tab, you must enter Gender, Date of Birth, SSN (PPS no.) and 
Citizenship.  All are mandatory for the purpose of HEA statistical returns. 

− Gender 
− Date of birth in the format day-month-year this will automatically populate the age box 
− Citizenship 
− PPSN number should be added into the box labeled SSN/SIN/TFN. 

 

 

Save changes and exit the form. 
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SGASADD - ADDITIONAL STUDENT IN FORMATION FORM 

The next form is SGASADD.  Assuming the correct ‘Student ID’ and ‘Term’ has defaulted, you should ‘next block’ 
twice to enter the Student Attribute section.  

You will now need to record the correct student ‘year of study’. 

Simply enter the correct year under the Attribute Code and save. A warning prompt box will appear. 

  

Click OK, save and exit. 

 

SFAREGS - STUDENT COURSE REGISTRATION FORM 

The next form is SFAREGS.  Upon entering the form, ensure the correct ‘Term’ and ‘Student ID’ are entered. ‘Next 
Block’ from the key block. 

 

Select the Student Term tab. Enter A001/1 into the Block code in the Block Schedule field. Save and return to the 
Registration tab. 
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REGISTERING STUDENT ON CRNS 
Now you need to update the students Module choices by registering the student on the relevant CRNs. From within the 
Registration tab enter the Course Information Block. Now enter the relevant CRN number and select ‘return’. The other 
field details will default in automatically. 

If you are entering a Billing Hour CRN, you will need to update the Bill Hours fields to the appropriate unit (e.g. 0.3 for 
30 mins; 0.45 for 45 mins etc) 

 

F10 to save any changes 

Save twice to process fees and all amendments to the record.  

The new student has now been set up as EL (eligible to register) on Programme A001 with the relevant CRNs.  
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A001 GENERATE MUSIC PART TIME RE-ENROLMENT FORMS 

 

NEW STUDENTS 
Once ‘first-time’ students have been provisionally enrolled on A001, it is then necessary to print out the Enrolment 
Form for these students. These Forms will confirm what modules the student opts to take. 

Upon entering TZSENMU, you have the option to select / de-select various checks.  

− All Teachers allows you to choose students registered on a CRN for a particular Teacher 
− All Students gives you the option to select a single or multiple students 
− All Subjects give you the option to select against a single or multiple subjects. 

 

As we are printing enrolment forms only for those new first-time students, ensure you select the checkbox ‘Enrolment 
Form for New Students?’ 

 

 

Once you are happy with your selection, select Print Music Re-Enrolment Form. You may be prompted with a 
message indicating the process may be time consuming. Select 'Yes' as appropriate. 
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RETURNING STUDENTS 
For those students with the option to return to A001 Programme, Re-enrolment Forms are also printed from TZSENMU 
and posted to existing students. 

Again the user has the option to select the following: 

− All Teachers 
− All Students 
− All Subjects 

 

You can also select the preferred Print-out order. And if necessary, select the Re-Print Option (if Forms where already 
Printed).Assuming the relevant checkboxes are selected, simply select Print Music Re-Enrolment Form. 
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A001 UPDATING STUDENT RECORDS & PROGRESSING RETURNING 

STUDENTS  
Upon receipt of the completed Enrolment Forms back to the office, it is first necessary to check for any changes to 
Personal Student data such as Address or Phone details. Following this, the students are then ‘progressed’ into A001 for 
the new Term. 

 

SPAIDEN – GENERAL PERSON IDENTIFICATION 

SPAIDEN is used to update general person information such as address details or phone no. etc. 

To retrieve student details, enter the ID and select ‘Next Block’. You can then navigate to the relevant Tab (e.g. 
Address) and update data as appropriate. 

 

In the case of updating the address details, be sure to insert new address records rather than over-typing the old address. 

To do this, simply select the Address tab. Check the Inactivate Address check-box on the address which is now 
redundant or old. Then select F6 (to insert new record). Type in the relevant information such as Address Type, Street 
Line Details, City, County, Nation and Carrier Route (Accommodation Type). Then select F10 to save. You now have a 
new address record, but the old address record still exists as an inactive record. 

 

  



BANNER OPERATIONAL USER GUIDE 

 

Page 241 of 351 

SZASPRF – STUDENT PROGRESSION MAINTENANCE FORM 

Next it is then necessary to ‘Progress’ the relevant students back into A001/1 for the new Term. This is done using 
Form SZASPRF. Upon entering the Form, you will need to enter the following parameters into the key block.  They are 
as follows: 

− Term Code - The Term you are progressing FROM 
− The Campus - ADL 
− Programme Code – A001 

 
When you have entered the parameters above, continue by choosing ‘Next Block’. 

All students registered on A001 will appear in alphabetical order. 

 

You may wish to view all the students in this Form or perhaps simply look at an individual student records. To view 
only a particular student record: 

− Firstly select F7 to clear records and enter a query. 
− Then enter the Student ID under Student Field 
− Select F8 to execute query and retrieve student record. 

 

In order to flag students for progression, you simply enter a Y against the Roll Ind (Roll Indicator) for a given student. 
Once you have updated this list, you then save using F10. 

From within Business Objects, you can validate this list by running the Student Progression Proof Listing report. This 
will print-out a list of the students who are due to progress to the next year of the Programme.  This report is found the 
General Student Reports Category. 
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The following are the parameters require input: 

− Current Programme – A001 
− Current Year 
− Full-Time / Part-Time - P (& Term) 
− Progression Ind - Y 
− Term 

 

 

NB: It is important at this stage that you run the report for the Progression Indicator of Y. 

Once you have cross checked this report your list, then you are in a position to run the progression roll. 

Once this roll is preformed, a student record for the next term will automatically be created.  You will not be able to 
delete this once it has been completed. 

 

SZRSPRF - STUDENT PROGRESSION RUN MODE 2 

SZRSPRF is used to run the actual Student Progression Roll. This is the Form used to run the process which 
‘Progresses’ Students to the ‘next block’ and creates a new Student Record for the new Term. This process is known as 
Student Progression Run Mode 2. 

The following parameters must be inserted: 

 

− Printer: DATABASE 
− Run Mode: 2 
− Current Term: (e.g. 201213) 
− Camp Code: ADL 
− Level: ‘leave blank’ 
− Program: A001 
− Student ID: ‘leave blank’ 
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The Level and the Student ID may be left blank. 

Note: it is possible to run this Progression Roll for an individual student. In this case, simply input the relevant Student 
number in the Student ID parameter. 

When you have entered the relevant parameter information, make sure to ‘Next Block’ to the Submission section and 
select the checkbox Save Parameter Set as. Now select F10 to save and the Student Progression Roll will commence. 

Note: At the bottom of the screen you should see a job number created for this process. It is worth taking a note of this 
no. to view the output and ensure the job ran successfully. 

If you return to SZASPRF (Student Progression Form), you will be able to see that all of your students who previously 
had a Roll Indicator of Y will now have a Roll Indicator of R.  This means that a new record is created for the coming 
term. 

You can now run a new Student Progression Proof listing report in Business Objects with Progression Indicator of R. 

You can also run a ‘Class Listing’ report for the coming term.   You can find these reports in the General Student 
Reports Category. The most commonly used is ‘Class Listing by Block (Standard)’.   

Parameters entered include: 

− Block Code: A001/1 
− Enrolment Status: EL 
− Term: (e.g. 201314) 

 

Note: At this stage all students will have a registration record of EL only and you are running the report for the next 
academic year. 

A001 REGISTERING STUDENTS ON MODULES / CRNS 
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Assuming you have received returned enrolment forms and progressed students where appropriate, it is now necessary 
to add and amend the CRN registration details on the Students’ registration record. This process applies to both new 
entrants and existing returning students. 

 

SFAREGS – STUDENT COURSE REGISTRATION 

To add, remove or update the registration record for a given Student on CRNs, you use SFAREGS.  When in the Form, 
enter the current Term and Student ID. Then select ‘Next Block’ twice. Under Course Information, enter the relevant 
CRN number and select ‘return’.  

For new students, you will need to confirm that the enrolment form matches the Module choices selected on this Form. 
For students who are returning to A001 (assuming they have already been progressed back into the same Programme 
and Year for the new Term), they will have been automatically registered with the same Modules / CRN as the previous 
Term. It is therefore necessary to check for any changes to the student’s registration record for the New Term. 

Upon entering the Course Information Block, you can then amend details such as: 

− Dropping students from CRNs (i.e. enter DD under Status field) 
− Adding New CRNs to student record (as above) 
− Amending Billing Hours on a particular CRN (i.e. Update Bill Hours field) 

 

 
 

If you are entering a Billing Hour CRN, you will need to update the Bill Hours fields to the appropriate unit (e.g. 0.3 for 
30 mins; 0.45 for 45 mins etc) 

Note: In terms of Billing Hours ranges, you should consult with you supervisor regarding the appropriate Bill Hours 
unit to be entered. For example 0.9 and 1.3 both relate to the same Unit of time of 90 mins, but Fee Charges will 
dependent on which one you choose. 

F10 to save any changes 
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FEE ASSESSMENT & TSSAREV 
Once changes have been made and updated in SFAREGS, selecting save twice on SFAREGS processes the online Fee 
Assessment. This means that any charges relating to the CRNs and / or Programme the student has now registered on 
will be charged against the Student’s account. 

Note: During the course of the year, Fee Assessment runs daily as an automated background job in Banner. This 
ensures that Fee Assessment occurs regularly against all Student records. However, there is a period shortly after Term 
Roll where this automated Fee Assessment is temporarily switched off (this is while the Fees & Income Office await 
confirmation for new Fees for the New Term). It is however possible for MIS to run this job manually upon request, thus 
triggering a mass Fee Assessment for A001 students (if required by the Conservatory of Music & Drama). 

To review and verify that the appropriate Fees have been triggered on the student’s account you can use the Form 
TSAAREV. 

 

 

 

Upon entering the Form, enter the Student ID and then ‘Next Block’. This will retrieve all Detail Charges, Payments 
and Refunds etc against the Student’s account for all Terms. You can query for a particular Term by selecting F7 to 
enter the query. Then enter the preferred Term Code and select F8 to execute the query. 

 

A001 - WEB REGISTRATIONS INFORMATION PACKS 

Assuming, you registered all students against the relevant CRNs and all fees and charges have been processed 
accordingly, you are now in a position to print Web Registration Information Packs. This enables students to formally 
register on-line for Programme A001 

When you are ready to generate the first Web Registration InfoPacks, you will need to confirm that the relevant student 
PINS are re-enabled. See section on ‘Student PINs’ for further details. 

Assuming all relevant PINs are re-enabled, you can proceed with generating ‘Web Registration Information Packs 
(InfoPacks)’ letters for A001 students. 

Note: Before generating your first batch of InfoPacks, you should always ensure that your IE & Banner settings are 
configured correctly. Try generating a Student Details Report from SZANAVI to test that you can run reports from 
Banner in advance. Please see http://appupdates.dit.ie  for further details on the correct technical configuration for 
running Banner 8.5. 

 

  

http://appupdates.dit.ie/
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SZAINFO -  WEB REGISTRATION IN FORMATION PACK 
The Form to use is SZAINFO. 

 

 

Parameters to be entered on this form are as follows: 

− Term Code (e.g. 201314) 
− Block Code (A001/1) 
− Select checkbox for All Students (or enter individual student no.) 
− Signature & Title remains blank 

 
The ‘Reprint?’ checkbox should only be checked if you wish to reprint InfoPacks for students (or single student) which 
have already been generated. 

When you are satisfied with the input parameters you have entered, simply select Generate Info Packs. 

You will then be prompted with the following message detailing the number of InfoPacks to be generated.  
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For A001 students, you should expect all InfoPack to be ‘paper’ web packs. 

Simply select Proceed to continue with the generation of the paper packs. At which point, a new browser window will 
open with a PDF of all the web registrations letters. Each letter contains the student’s details and programme 
information along with instructions on how to logon to the DIT Online Web Registration system. It will also include 
their logon details to their new DIT email account.  

Further information regarding Online Programme Registration is available on the Registration website 
(www.dit.ie/registration). An instructional user-guide is also available. 

Note: The text used on the A001 InfoPacks is updated each year in agreement with School of Music and MIS Office. 
This text must be updated and agreed prior to production of Packs. 

 

EMERGENCY CONTACT – SPAEMRG 
As part of the online registration process, A001 students are requested to enter emergency contact information. This 
information is captured so that the student’s parent or guardian can be contracted in case of an emergency. 

In order to review/amend these details in Banner, simply go to SPAEMRG.  

Enter the students ID and ‘next block’ into the form to review the student’s emergency contact details. Data can be 
amended as required.  Additional emergency contact details can also be added as required by inserting a new record 
(F6). 
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A001 – MUSIC REPORTS 
Banner provides a variety of reports specifically for Conservatory of Music A001 Programme. 

TZAMURP – CONSERVATORY OF MUSIC REPORTS 

The Form TZAMURP is used to access the various reports for A001.  

To run reports, simply select: 

− Term 
− Report Type 
− Registration Status’.  
− Teacher (You can run for All Teacher’s or for a particular Teacher’s module) 

 
Select Produce Report to run. A new window will open with the PDF report which can be saved locally or printed as 
preferred. 

The list of reports available is: 

− Tutor Class Listing 
− All Fee Details by Student 
− Fee Summary by Subject & Tutor 
− Fee Summary by Subject 
− Fee Summary by Subject & Tutor (Gender) 
− Fee Summary by Subject (Gender) 
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A001 – SZANAVI 
Finally, to query a particular Student record in Banner, the most appropriate Form to use is SZANAVI. 

This form holds all registration and personal details for a student.   

 

To query an existing student for the term 201213, ensure the Term Code is 201213. Then enter the student number in 
the Student ID field. 

Note: If you don’t know the Student ID, you can search for this under the drop-down menu beside Student ID and then 
select Person Search. This will bring you into another Form SOAIDNS. By entering the relevant information and 
utilising %, select F8 and you should be able to find the required record. 

Once the Term Code and Student ID data is entered correctly, select ‘next block’ to view information pertaining to this 
student. 

The immediate Block of information you will see is Student Personal Details.  To navigate and view information on 
each Block, simply click on the relevant tab (i.e. Financial Details, Address or Registration) or select ‘next block’ in 
turn. 

Some important information to note includes: 

− Blank record: If programme data on the form is blank, the student has no registration record for the term. This 
will impact the creation of the student’s email account, AD account as well as their ability to register. 

− Registration Status: A registered student has an RE status. 
− Date of Birth: A blank date of birth will impact the student’s default PIN code when reset. 
− Student Year: If no year exists here, the student has not been correctly progressed or set-up. 
− Address: A blank or inactive address may cause issues for admin users trying to generate reports for the 

student (e.g. transcripts etc) 
− Telephone Number: Reference for contacting the student 
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Click on the Financial Details Tab and you will be able to see all financial transactions for that student.  This includes 
Fee charges and payments.  

 

The last section of the Form holds CRN details for student.  This does not automatically populate, if you wish to view 
these click on the Retrieve CRNs tab on the bottom right of the screen. In the Address Details tab you will be able to 
view all stored address for the student, their telephone numbers and email addresses. 

 

The final tab holds other relevant Academic/Registration details such as how they were admitted to DIT. 

If you wish to print information, click on the Student Details Report on the bottom left of every page. 

 

If you wish to review information for another Term Code or even to query another student, simply select the Roll-Back 
function. 
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MODULE REGISTRATION  
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The term module registration relates to the process of assigning the appropriate modules from the programme of study 
to the corresponding student records registered on that programme.  

METHODS OF MODULE REGISTRATION 
The methods of assigning modules to student records are as follows:  

Self Service – SoS (Scheme of Subjects) Module Registration: Modules are linked to stages of a programme. These 
modules are subsequently authorised. Following the commencement of the SoS process, authorised modules are 
automatically assigned to the students registered for that stage of that programme. 

The SoS process runs twice during the Academic Year as follows: 
i. ‘Semester 1’ & ‘Year Long’ module registration. 

ii. ‘Semester 2 module registration. 
 

Processing the Block: Blocks of modules are set-up in Banner. Each block represents a stage of a programme which is 
streamed. By processing the block against an individual student records, all modules on that block / stream will be 
assigned to that student record. 

Self Service – Manual Module Registration: Students log on to the Student Self-Service system and manually attach 
modules to their student record.  

Manual Module Registration: In some instances, fees are associated with modules as opposed to the programme. 
Consequently, students need to be manually registered on these modules in Banner. Once registered on the module, 
liability for that module fee will assess on the student’s account and payment can be processed. This method is 
primarily used for part-time programmes and CPD programmes. Where a student is invited to register and pay fees 
online, fee linked modules must be assigned on the student’s account in advance of this. 

 

SOS MODULE REGISTRATION 

In advance of module registration, all modules should be approved and set-up in Banner. Those modules that are 
common to all students on a given programme and year can be authorised against SZRPGMD in advance of the SoS 
Module Registration process.  

The SoS Module Registration process runs twice a year. The first run checks for all ‘Semester 1’ and ‘Year Long’ 
modules and registers students on those authorised modules. The second run checks for authorised ‘Semester 2’ 
modules.  As part of this process, students then log on to the self-service system via http://modularisation.dit.ie to 
confirm their module selection. 

Note: The terms Module and CRN (Course Reference Number) are often used to refer to the same entity. A CRN is an 
instance of a module. For the purpose of understanding the module registration process in Banner, we will primarily 
make reference to CRN.  

http://modularisation.dit.ie/
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PROGRAMME MODULARISATION MANAGEMENT FORM – SZRPGMD 

SZRPGMD is used to link and authorise CRNs against programmes and years. 

Upon entering the form, you must first enter the relevant ‘Term’ (e.g. 201011), ‘Programme’ & ‘Year’. Then select 
‘next block’. 

 

From within the form, you can: 

− Add or Remove CRNs 
− Update Module Type to Core, Optional or Elective 
− Authorise CRNs 
− Set-up Programme Streams 

 

ADD OR REMOVE CRNS 
To add a new CRN, simply select a blank row and enter the CRN in the appropriate field. When you select return, the 
Semester, Subject and Course Number will automatically populate. By default the Module Type will be Core. 

Save changes upon completion. 

To remove a CRN, simply select the row you wish to delete. Then select Record -> Remove from the menu. Save 
changes upon completion. 

Note: By removing an authorised CRN from SZRPGMD, you are simply ensuring that no further module registrations 
will occur on this CRN. Therefore, if the SoS process has already commenced, then any existing registrations on this 
CRN will need to be either manually removed from SFAREGS or by use of the Registration Mass Entry - SFAMREG 
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CHANGE MODULE TYPE 
By default, any new CRN added to SZRPGMD is added as a CORE module type. This infers that the module must be 
taken by all students on that programme and year. OPTIONAL modules are those modules which can be dropped by the 
student via Self-Service Banner. ELECTIVE modules are those modules which must be selected / added by the student 
themselves via Self-Service Banner. ELECTIVE modules will not be automatically added to a student’s record by the 
SoS process.  

Students on a given programme and year will be automatically registered on all CORE and OPTIONAL authorised 
modules on SZRPGMD.  When a student logs on to the Self-Service System they will be able drop OPTIONAL or add 
ELECTIVE modules. No action is required from students for those modules that are CORE. 

Note: Only students who are RE (registered) for the current term will be selected for the SoS Module Registration 
process. The only exception to this rule is students with a RATE code of RCRED (i.e. students repeating a select number 
of modules). These students are excluded on the basis that they need to be manually registered on repeat modules. 

 
AUTHORISE CRNS 
CRNs should only be authorised on SZRPGMD once they have been approved to run for a given programme and year.  

At term roll each year; all CRNs set-up on SZRPGMD from the previous year will be copied to the new term record. 
However, by default they will be un-authorised. The process of reviewing and re-authorising those CRNs must occur in 
advance of the module registration process. 

The Validation - R27 Approved Modules report in Business Objects can be used to support this authorisation process. 
This report lists all modules linked to the programme and year on SZRPGMD as well as a flagging if the module is 
authorised or not.  

When the SoS process commences, any authorised CRNs on SZRPGMD will be automatically populated on all student 
records registered for the given programme and year. The process cannot be easily reversed, thus the reason to ensure 
all CRNs have been accurately validated and only authorised where appropriate. 

As well as having their records updated with the relevant authorised modules, students will also receive an email 
requesting them to review their modules using the online Self-Service system. It is therefore imperative that you ensure 
that student PINs are re-enabled prior to the commencement of the SoS Module Registration process. More information 
can be found under the ‘Student PINs’ section. 

Not all CRNs will be registered against student records by means of the SoS module registration process. Some students 
are registered on CRNs by mean of the other three methods outlined below. 

In general, CRNs can be authorised against a programme and year on SZRPGMD if they meet the following criteria: 

1. All students in the programme and year are eligible to take the module. 
2. There is no fee associated with the CRN which should have been billed to the student prior to the 

commencement of the SoS Module Registration process. 
3. The programme is not a ‘streamed’ programmed which utilises the ‘process block’ method of the module 

registration. 
4. The students are not being asked to manually select their own modules on the Self-Service system. 

 

To authorise a CRN on SZRPGMD, simply check the ‘Authorised’ flag beside the appropriate CRNs. You can also 
authorise all CRNs by checking the ‘Authorise All’ flag. Save changes upon completion.  

 
STREAMED PROGRAMMES 



BANNER OPERATIONAL USER GUIDE 

 

Page 255 of 351 

While the primary function of SZRPGMD is to manage the authorisation of modules for the purpose of module 
registration, it can also be used to track and keep a record of which modules are associated with which Programmes. By 
not authorising modules on SZRPGMD, module registration will not be invoked. Therefore SZRPGMD simply acts as a 
reference or link for modules and programme data. The DIT Programme and Module Catalogue (www.dit.ie/catalogue) 
reflects the SZRPGMD programme/module data, irrespective of whether modules are authorised or not. 

Streamed Programmes may use SZRPGMD for this very purpose. A streamed programme is one where there may be 
multiple groups of study within a given stage of a programme. The most common example of a streamed programme is 
one which is run through various languages. For each language, a separate stream may be required with a different set 
of CRNs.  

Streams are usually set-up in Banner as a unique ‘Block Code’ at the point of programme set-up. However, for the 
purpose of referencing which modules are associated with which stream, each stream can also be set-up via SZRPGMD. 

To set-up a stream from SZRPGMD, select Options -> Programme Streams [SZRPGST] from the menu. This will bring 
you into the Programme Streams form. 

 

First you must enter the Programme Code and the Year for which you wish to associate the stream. Then select ‘next 
block’. 

Enter the Stream No., Stream Name and save. Repeat as many times as required. You can create multiple streams 
against a given programme and year. Save changes and exit when complete. 

 

To attach CRNs to a particular stream within a programme and year from SZRPGMD, you simply select Term Code, 
Programme, Year and Stream from the key block and then ‘next block’ into the form. 

Note: The selection of Stream is important here. If no stream is selected, you will be simply querying / updating 
modules against the whole programme and year.  

 

http://www.dit.ie/catalogue
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Streamed CRNs on SZRPGMD against a Programme & Year 

You can then add or remove modules here as normal. Save changes upon completion. 

As mentioned previously, it is most likely that you will not be authorising the CRNs on a given stream as they are 
unlikely to be common across the programme and year. However, it may be plausible that some CRNs are in fact 
common across all streams on a given programme year. In which case, these CRNs can be authorised. These CRNs 
should be linked to the programme and year (ignoring the stream selection from the key block) and authorised from 
there. Save changes upon completion 

Remember modules that have been linked to streams via SZRPGMD are for reference purposes only. In order to 
register students on those streamed modules, you will need to set-up the same modules against the block stream and 
‘process the block’ against each student’s registration’s record. This process is covered further under ‘Processing the 
Block’ section below. 

 

PROCESSING THE BLOCK 

Modules can also be added to individual student records by means of a process known as ‘processing the block’. This 
process is usually used for those programmes that are ‘streamed’.  

As outlined in section on Streamed Programmes, modules can be set-up on streams from SZRPGMD. However, the set-
up of streamed modules on SZRPGMD is for reference only. In order to actually link a set of modules on a given stream 
to a student’s registration record the following two processes must occur: 

1. Modules must be linked to a Block Code / Stream on SSABLCK. 
2. The ‘Block of Modules’ is then processed against individual Student records on SFAREGS 
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ATTACHING MODULES TO A BLOCK – SSABLCK 

SSABLCK is used to attach / link modules to a Block / Stream.  

Enter the ‘Term’ and ‘Block’ in the key block and then ‘next block’ into the form.  

 

Note: You can search for blocks by selecting the drop-down menu beside the block field. Block Codes are usually set-up 
at the point of programme creation. Block Codes will normally reflect the programme stage (i.e. programme year), but 
can also be created to reflect the streams of a programme. 

To add new modules to a Block / Stream, simply select F6 to insert a new record and enter the relevant CRN. When you 
select return, the other CRN details will default in. You should repeat this process until all required CRNs have been 
added. If a CRN was added in error and needs to be removed, simply highlight the relevant CRN row and select 
‘Record -> Remove’ from the menu. Save changes upon completion. 

 

PROCESS BLOCK (SFAREGS) 

Once all CRNs have been attached to the block / stream on SSABLCK, it is then possible to process the block of 
modules on SFAREGS. This process will in effect attach all modules linked to a given block / stream onto the student’s 
registrations record. 

To process the block, ensure the correct block / stream code is entered in the Block Schedule field under the Student 
Term field in SFAREGS 
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Return to the Registration tab. You should notice that same block / stream is displayed in the Process Block field.  To 
attach the modules that are set-up against that block to the student registrations record, simply check the Process Block 
checkbox. 

 

CRNs attached to that block / stream will automatically register on the student’s record. Save twice in order commit 
changes and trigger fee assessment. 

 

Note: CRNs are set-up according a given semester. CRNs may be ‘Semester 1’, ‘Semester 2’ or ‘Year Long’ modules. If 
you try to register a student on a CRN outside of the semester range, you will receive an error message: ‘Course status 
dates not within range for part of term’. If you do need to retrospectively register a student on CRNs on a past date, 
ensure the effective date in SFAREGS is within the CRN range.  

 

You have now successfully processed a block of modules on a given stream against an individual student record. This 
process should be repeated for all students on a particular stream. The next step is to email students on that particular 
stream to inform them to confirm their module registration using the Self-Service system. 

Note: If students on a particular programme stream are going to be registered on modules via a combination of both 
the SoS Module Authorisation process (for shared modules) and the manual ‘processing the block’ process (for specific 
streamed modules), you should ensure that the students are registered on the specific streamed modules prior to 
authorising the shared modules on SZRPGMD. This ensures that when students receive their communication to logon to 
the Self-Service system, they will see all modules that they are registered on. 
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EMAIL STUDENTS ON STREAMED PROGRAMMES – SZPEMAL 

After all modules have been set-up for students on streamed programmes by ‘processing by block’ and authorising 
those shared modules on SZRPGMD, an email should be sent to those students requesting them to review their modules 
using the online Self-Service system. This email communication also includes the student’s username (student number) 
and PIN.  

SZPEMAL is used to generate emails to groups of students for various communications. One email type / option is to 
email students on ‘streamed’ programmes informing them of the module registration process and their logon details to 
the Self-Service system. 

To generate this email to students on streamed programmes, enter the Term Code, Email Type (Streams Reminders), 
Programme and Year information. You must also check the ‘All students’ checkbox. Then select Create Emails. 

 

The ‘Student Email Generation Audit’ box will appear displaying ‘Total No of Student Emails’. If the ‘Total No’ is as 
expected, then select Proceed or Cancel to enter new criteria. The next popup confirms that emails have been sent.  
Simply select OK this message. 

If this email has already been sent for a particular streamed programme and year, you can opt to resend it by selection 
the ‘ReSend Student Email’ checkbox. You can also choose to resend to an individual student by entering the Student 
ID and ensuring All Students is unchecked. 

Ensure you always select Streams Reminders as the email type, as the other options are used by the Exams function for 
reminding students about exams and supplemental results. 
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Note: The selection for students on streamed programmes is dependent on the programme stream being set-up on 
SZRPGST. If a stream is not set-up on this form against the relevant programme and year, no email will generate for 
those students.  More information on the set-up of streams on SZRPGST is covered under section on Streamed 
Programmes. 

This form also has an audit trail of all emails generated from it. To view an audit report of e-mails send to selected 
Programmes, select Options -> Email Audit Trail from the menu. 

 

In the ‘Print Email Audit’ box, select the Term Code, Email Type, Programme and Year. Select ‘Print Email Audit’ to 
generate audit log.   

. 

An Audit Report will display listing each student an email was sent to, when it was sent and the user who generated the 
email. 

 

SELF SERVICE – MANUAL MODULE REGISTRATION 

In some instances, students may be requested to add certain modules themselves using the Online Self-Service system. 
Rather than having these modules authorised via SZRPGMD, the students are informed locally of the CRNs which they 
should select. When the student logs on to the self-service system via http://modularisation.dit.ie, they can manually 
attach the CRN to their record. 

 

Note: These students may have some of their modules authorised via SZRPGMD, but the other modules they will have 
to add manually themselves. As a result of the authorised modules, they should expect to receive an email 
communication detailing their Self-Service logon details. 

http://modularisation.dit.ie/
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MANUALLY REGISTERING STUDENTS ON CRNS 

In some instances, students will need to be manually registered on modules directly from SFAREGS. Usually this is 
required for modules that have fees associated with them.  Once registered on the module, liability for that module fee 
will assess on the student’s account and payment can be processed. This method is primarily used for part-time 
programmes and CPD programmes.  

Ensuring that students are registered on modules which have fees is of particular importance for those students who are 
eligible to programme register online. The correct modules must be assigned to the student’s registration record in 
advance of the student receiving their invitation to programme register online communication. Thus ensuring the 
student is assessed for the correct registration fee when they are asked to programme register and pay online. 

Modules may also need to be manually applied to a student’s registration record for any other number of reasons. For 
example, students carrying modules into the next academic year will require manual module registration via SFAREGS. 
Either way, the process of registering a student manually on a module is the same. 

To attach a module to the Student Course Registration Form SFAREGS, you should first enter the ‘Term’ and ‘Student 
ID’ in the key block and select ‘next block’ twice. This brings you directly into the Course Information section. To 
register the student on a module, enter the CRN code. This is typically a 5 character number. When you select ‘return’, 
the other CRN information will default in. 

If you need to add more than one CRN, select F6 and enter the new code. Repeat this process until all required CRNs 
have been added. 
 

 

Upon completion, save changes. When you save twice, ‘Fee Assessment’ will be triggered. This will ensure that any 
modules with fees associated with them will be added to the student’s account.  Payment can then be processed by 
means of the payment options made available at the end of the form.  

Note: CRNs are set-up according a given semester. CRNs may be ‘Semester 1’, ‘Semester 2’ or ‘Year Long’ modules. If 
you try to register a student on a CRN outside of the semester range, you will receive an error message: ‘Course status 
dates not within range for part of term’. If you do need to retrospectively register a student on CRNs on a past date, 
ensure the effective date in SFAREGS before you enter the form reflect the date within the CRN range.  
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MODULE REGISTRATION FOR REPEAT STUDENTS 
Students who are repeating may require additional attention to their module registration record as each record will 
require individual review.  

Student repeating the entire academic year and re-attending are managed as normal. Once they are registered on the 
correct programme and year, they should expect to register on their modules via one of the four methods outlined 
above. However, students who are repeating a set number of modules, carrying modules into the next academic term or 
repeating externally will require special attention. Each category is outlined below. 

 

STUDENTS INTERNALLY REPEATING MODULES 

Students re-attending and repeating fall into this category. These students should have an active registrations record for 
the new academic term, albeit with the same ‘year of study’ as the previous term. Their Block Code should also reflect 
their repeat year.  

Since these students are only repeating one or more of their modules, they will be automatically excluded from the 
‘SOS Module Registration’ process. You must therefore manually register the student on their selected repeat modules 
as outlined in the ‘Manually Registering Students on CRNs’ section above. 

 

STUDENTS CARRYING MODULES 

If a student is carrying modules into the next academic term, you will need to ensure that the student is manually 
registered on those carried modules.  

You should expect the student to be registered on the standard programme and year modules as per normal. However, to 
manually register the student on additional carried modules, you will need to add the module manually on SFAREGS. 
The process is the exact same as outlined in the ‘Manually Registering Students on CRNs’ section above. 

Other key information should also be updated on the student’s record. This is covered in further detail under the section 
on ‘Student Repeating or Carrying Modules’. 

 

STUDENTS EXTERNALLY REPEATING MODULES 

An External Repeat student is one who does not attend classes for the particular module. The student is not studying 
other than the modules he/she is externally repeating for that Academic Year.  External Repeats will have an active 
registrations record for the term. Students who are externally repeating should be coded as XR on the both Enrolment 
Status and the CRN level. 

Depending on the sequencing, you may decide to update either CRN status or ‘Enrolment Status’ first. Either way, you 
should always ensure that all statuses reflect XR. An XR student cannot repeat any modules internally. All modules on 
an XR student must be flagged as XR. 

The best method to update an XR student is to add the modules first. Assuming the student’s status is initially EL, you 
‘next block’ to the Course Information section and add those modules that the student is externally repeating.  Initially 
the student enrolment status will be EL and the CRN statuses will be RE.  

Return to the key block and ‘next block’ into the form again. Now you should update the enrolment status to ‘XR’. 
When you ‘next block’ into the Course Information section, you should expect all CRN status to automatically update 
to XR also.  
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Save changes twice upon completion to commit changes and to trigger fee assessment. 

Note: If the student’s enrolment status was already set to XR prior to adding CRN to the record, the status of the CRNs 
will not automatically default to XR. You should therefore ensure that you manually update the CRN status to XR after 
adding the required modules to the record. 

Other key information should also be updated on the student’s record. This is covered in further detail under the section 
on ‘Student Repeating or Carrying Modules’. 

 

DROPPING MODULES FROM SFAREGS 
Occasionally, it may be necessary to drop students from modules they were incorrectly registered on. You can manually 
drop students from module(s) in SFAREGS. 

In the key block, enter the Student ID and Term and ‘next block’ into the form. Within the Course Information section, 
you should notice all CRNs that the student is registered on. To drop modules, simply select the CRNs you wish to drop 
and update the status to DD. Repeat this process until all required CRNs to be dropped have a status of DD. 

 

Save changes twice upon completion to commit changes and to trigger fee assessment. 

The student will no longer be registered on those dropped modules and will not appear for marks entry selection in EGB 
against those modules. You can now exit the form. 

DROPPING MODULES USING SFAMREG (REGISTRATION MASS 

ENTRY) 
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If however, a whole cohort of students were incorrectly registered on a particular CRN, you can drop students from that 
CRN using the SFAMREG (Registration Mass Entry) form.  

The form replaces the old SFAMASS form and offers and wider scope of functionality. SFAMREG allows users to find 
a cohort of students based on particular registration criteria (e.g. registered on a particular CRN). With this selection, it 
is then possibly to perform a selected task, such as adding or dropping a CRN from all selected student records. 

Note: There may be any number of reasons why a group of students were incorrectly registered on a particular CRN. 
However, the most likely reason would be that a CRN was incorrectly authorised against a programme on SZRPGMD. 
If this is the case, you should also ensure that the CRN is removed from SZRPGMD to ensure no further registrations 
are processed against it. 

To add/drop a CRN from a whole cohort of students using SFAMREG, proceed as follows: 

 Under the Search Tab, you set out your selection criteria to find all relevant students. You need to enter data in the 
following fields: 

− Registration Term: Term you wish to make the update against (normally the current term) 
− Registration Date: Date you wish to make the update against (normally today’s date, but you may need 

to make this a retrospective date if dropping/registering students against a closed ‘part of term’.) 
− Search Term:  Term you are searching against 
− Currently in CRN:  CRN that students are enrolled on 
− Registration Status: Status of CRN that students are registered on (may be RE or XR) 
− Block:   Programme Block which students are registered on. 

There are other fields which you can enter data against to limit your search further, but the above list will most likely 
find the group of student you are looking for. 

 

***Note:  When searching for a particular cohort of students, you should always enter a CRN as part of 
your search criteria (even if that CRN is not part of the update).  This ensures you are limiting the scope 
of your search to the correct group of students for a particular term. If you do not enter a CRN (and 
decide to search on block code only), the search criteria will pick up records which are term effective from 
previous terms. The consequence of this would be incorrectly updating student records from the wrong 
term. Adding a CRN to the search criteria will mitigate this risk. *** 

Once you are satisfied with your search criteria, navigate to the Update tab. From here, you will enter the criteria which 
reflects the ‘update’ you want to make against the selected students. In the case of dropping a CRN from student 
records, you should enter the following data under the Registration Course Drop Values section: 
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− CRN:   CRN you wish to drop from the student records.  
Note: All other CRN related data will automatically default in 

− Registration Status: Should reflect DD 

 

Note: In a similar fashion to dropping a CRN, you can enter data in the Registration Course Add Values section to add 
a CRN registration to student records. 

Next, you proceed to the Results tab. On this tab, you should see the list of students that were selected based on your 
Search criteria. At this point, you should pay careful attention to the list of students selected. You should validate the 
list against the appropriate ‘Class’ or ‘CRN listing’ report from Business Objects.  You should also take note of the 
number of records selected from the bottom of the form. 

 

If this number is much greater or much less than expected, you will immediately know that the search criteria used is 
incorrect.  In which case, you should return to the Search tab and refine your search criteria. 

Note also at this point, you may also manually add student records to your listing. This may be applicable if you have 
other students that you also wish to drop CRNs from, but they are not in the main search listing (e.g. some students 
taking a CRN on a different block code to the main cohort). To enter new student records, simply select F6 and enter 
the student ID. 

Note: You may notice that whenever you navigate away from the Results tab, you will get the message 
 ‘WARNING: All non-manually added results will be removed’.  
This means that those records you manually added will no longer be there when you return to the Results tab. 
Therefore, you should always manually add additional records last, just before you are about the process the 
registration mass entry. 
 
Assuming you are happy with your listing of students selected for the update, you can process the action of dropping / 
adding CRNs to the student records as follows: 
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− Select ‘All students’. You will notice the checkbox active beside each student 
Note: if you wish to exclude some student’s simply uncheck the selected tick box beside the 
individual record. 

− On the Submission section, check the ‘Submit’ tick box. 
− To process, select Save from toolbar 

 

 
 

You will be able to determine if the job was successful by noting the YES, NO or NONE radio button against each 
record.  A message providing further information is also available. This should be checked to ensure you are satisfied 
with the student records that you expect to be updated. 

 

You have now successfully added/dropped a CRN ‘en masse’ from a group of student records.   
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QUERY AND DISPLAY CRNS – SSASECQ 
If you wish to search for a particular CRN or simply query a given CRN, you can do so by using the form SSASECQ.  

To utilise this form, simply enter the information you know about a given CRN. For example, you may know the Term, 
part of the Module Code and the Description on a given CRN, but not the actual CRN id.  

 

Tip: If you are searching for part of a word, you can use to % (wildcard) character to assist your search (e.g. 
%ccounting% to search for CRN title with that text). Since the search is case-sensitive, you should consider this when 
entering your search criteria (e.g. omit the first character of a word if you are unsure of its case.) 

To execute your query, simply select F8. All CRNs should be returned which meet the criteria entered. Where more 
than two records are returned, simply use the scroll bar to review the full list. You should also notice the Actual 
Enrolment figure. This refers to the number of students registered on a given CRN. It may be useful to know if a CRN 
is actually running or not (i.e. a figure of 0 may infer that CRN is not active, but this does depend on the time of year 
since most module registration will not occur until after November). 

To clear your query, simply select F7. You can re-query again as required. 

 

STUDENT COURSE REGISTRATION AUDIT - SFASTCA 
SFASTCA allows you to query the module registration audit for individual students. It includes an audit from initial 
module registration right through to the entry of grades by lecturers against that module. If a student is dropped from a 
module, you will also see that transaction. 

To query a student record, simply enter the ‘Term Code’ and ‘Student ID’ in the key block and ‘next block’ into the 
form. Ever transaction for every module related to the student will appear.  

If you wish to query all transactions on a single module only; simply select F7 to clear the query, enter the CRN you 
wish to query and then select F8 to execute to query again. You should now only see those transactions for that 
particular CRN. 

 

 

When reviewing module transactions on SFASTCA, you should also be aware of the different ‘User’ IDs that appear 
beside each record entry. The following IDs reflect the scenario associated with a given transaction: 
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− Banner User ID: When a Banner user updates a student’s module registration (e.g. register / drop a student 
from a module on SFAREGS), that Banner User ID will appear against the record entry on SFASTCA.  

− DITMGR: If the student is automatically registered on a module by means of the SoS process the user 
DITMGR will appear.  

− WWW_USER (Student): If the student manually registers themselves on a module from with Self-Service, 
the user WWW_USER will appear.  

− WWW_USER (Lecturer): If a lecturer enters all grade components for a particular module through EGB, you 
should see an entry with user WWW_USER also. 

MODULE AUDIT EXAMPLES 

 

⇒ Student registered on CRN 7252 on 5th Jan 2010 by means of the SoS process (user DITMGR). 
⇒ Student then dropped from CRN on 15th April 2010 by Banner user. 
 

 

⇒ Student registered on CRN 7551 on 5th Jan 2010 by means of the SoS process (user DITMGR). 
⇒ Student then withdrawn (WS) on 28th April 2010 by Banner user. 
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⇒ Student registered on CRN 12598 on 05th March 2009 by means of SoS process (user DITMGR). 
⇒ Grade entered for all components of module by lecturer in EGB (user WWW_USER) on 3rd June 2009.  
⇒ Grade then updated again on 9th June 2009 by Banner user. 
 

 

CLASS ROSTER – SFASLST 
 

The Class Roster form SFASLST is primarily used by the Exams function for the purpose of reviewing student’s marks 
entry against a given CRN and then rolling all marks on that CRN to student’s academic history. 

However, for the purpose reviewing / querying what students are registered on a particular CRN, SFASLST can be 
utilised. 

When you query a CRN on SFASLST, you should expect to see all students registered on that CRN for the given term. 
SFASLST will also show students who were withdrawn or deferred from that CRN. It will not show students who have 
been dropped. 

To query a CRN, enter the term and CRN in the key block and ‘next block’ into the form. You should then expect to see 
all students on that CRN appear in alphabetical order. You can scroll though the list by use of the scroll bar on the right. 
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Note that where marks have been entered in EGB for students on that CRN, you may also see that mark entry on this 
form. The ‘Rolled’ indicator also indicates if the student marks have been rolled to Academic History. 

Note: The primary function of SFASLST for registration staff is to enable users to review student registrations on a 
given CRN. The Exams function will utilise this form for the purpose of managing and rolling exam marks to student’s 
academic history. You should be aware that the mark you see on this form is not necessarily the final grade that was 
approved and validated at the relevant module /exam board. Once the grades have been rolled, all results are then 
viewed and maintained in Academic History (SHATCKN). 
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REPEAT STUDENTS  
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There are three categories of repeat students. They are as follows: 

1. Internal Repeats 
2. External Repeats 
3. Carries 
 

INTERNAL REPEATS 
Any student who is repeating internally and attending classes falls into this category. The student may be repeating the 
entire year or a specific number of modules. These students should have an active registrations record for the new 
academic term, albeit with the same ‘year of study’ as the previous term. Block Code and attribute code should reflect 
their repeat year.  

These students are liable to pay the part-time Capitation fee and a Tuition fee rate based on the number of modules they 
are repeating. The modules fees are applied manually and are based on number of ECTS credits per module.  

GRANT RECORD 
Students repeating a set number of modules are not eligible for TLT or HEA Free Fees Funding.  

Their grant record on SZASGNT should be flagged as: 

− Funding Category: 12 (Repeat) 
− Funding Maintenance: 20 (non-aided) 

Note: If a grant record already existed for this current term you should remove the old one first by selecting from the 
menu: Record -> Remove.  

More information can be found on the ‘Fees and Grants’ section regarding updates and changes to students grant 
records. 

RATE CODE & STUDENT TYPE 
Student repeating a set number of modules should have their rate code updated to RCRED (Repeat Credit) and student 
type to B (Repeat). Both these updates can be made from the Student Term tab on SFAREGS. 

 

After updates are made, return to the Registrations tab and save twice. This will trigger ‘Fee Assessment’ which will 
apply the part-time Capitation charge to the student’s account. The Tuition fee still needs to be manually applied at this 
point. 

APPLYING TUITION FEE 
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Students repeating a set number of modules are charged based on the number of ECTS credits per repeated module. 
Since this will vary from student to student, it necessary to manually tabulate and apply the appropriate tuition fee on 
TSAAREV.  

Note: Some CRNs already have a fee charge set-up against them in Banner. These CRNs should therefore be excluded 
from the calculation of Tuition charges. 

The method for tabulating the Tuition fee is noted on the Finance Student Registration policy.  Once you are satisfied 
that the overall fee has been correctly tabulated, it can be applied on TSAAREV as follows: 

− From the Menu, select Record -> Insert to create a new transaction 
− Input detail code of TUIT (tuition).  Tab into the Description field and include the total number of credits the 

student is being charged for (e.g. 5 ECTS credits).   
− Tab to the Term field to input the Term code. 
− Tab to the Charge field and input the total charge applicable and save. 

 

 

CARRIES 
Students who are carrying module(s) but are still progressing forward will fall into this category. These students should 
have an active registrations record for the new academic term having been progressed to the next year of study.  

The student’s fees and eligibility for a local authority grant are handled as normal. However the student (as opposed to 
the local authority) will be liable for carried module(s) fee.  

Furthermore the student’s Rate Code should not change. It should reflect the appropriate Rate code for the programme 
& year (e.g. FULL or PART). 

APPLYING CARRY FEE TO THE STUDENT’S ACCOUNT 
Students carrying modules into the new academic term should be charged for these modules in addition to their normal 
programme fees. This fee is manually tabulated based on ECTS credit and a set exam fee. This fee is then manually 
applied to the students account with a detail code of CARY.  

Where the student is not attending lecturers but is sitting the exam, then the CARY fee applied should reflect exam fee 
only. Further information is available on the Finance Student Registration policy. 

To apply the CARY fee on TSAAREV: 

− From the Menu, select Record -> Insert to create a new transaction. 
− Input detail code of CARY (Carry Fee). Tab into the Description field and include the total number of credits 

the student is being charged for (e.g. 20 ECTS credits).   
− Tab to the Term field to input the Term code. 
− Tab to the Charge field and input the total charge applicable and save. 
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Note: If the student is re-registered on the carried module and there is a fee directly attached to the module in Banner, 
you need to ensure that the student is not ‘double’ charged for the carried module. To rectify this you should still apply 
the carry charges based on ECTS credits as above. However, you will also need to manually apply a negative Tuition 
charge to reverse out the CRN ‘tuition’ fee which was automatically applied during CRN registration. See sequence of 
steps below as an example. 

 

Carry Fee tabulated based on ECTS 
credits for all carried modules into 
new academic year. 

Student re-registered on CRN with a fee 
which is applied automatically to 
student’s account. 

Manually apply reverse Tuition charge 
to cancel the CRN fee applied 
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EXTERNAL REPEAT (XR) 
An External Repeat student is one who does not attend classes for the particular module. However the student is sitting 
one or more components of the module. The student is not studying other than the modules he/she is externally 
repeating for that Academic Year. External Repeats refer only to DIT students and excludes those students who may be 
physically sitting exams in DIT (e.g. Professional body or apprentice exams where the student is not a registered DIT 
student). 

External Repeats should have an active registrations record for the term. Their enrolment status should be flagged as 
XR (External Repeat) on both the programme and CRN(s) level. They are liable for an exam fee only. 

REMOVE GRANT RECORD 
Any student who is externally repeating is generally liable for their own fees. They will therefore not have a grant 
record. If a grant record exists against the student for the term on SZASGNT, you should remove it from the menu: 
Record -> Remove. 

ENROLMENT STATUS, RATE CODE 
Students who are externally repeating should have the following updates made to the registrations record on SFAREGS: 

− Rate code updated to XR (External Repeat) 
− Enrolment Status updated to XR (External Repeat) 

 

 

 

 

 

 

 

 

 

 

Note: Student type is not updated to B (Repeat) for XR students Student type should reflect appropriate student level as 
normal. 

After updates are made, save twice from the Registrations tab. This will trigger ‘Fee Assessment’ which will apply the 
XR fee on the student’s account. 
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FEES & GRANTS  



BANNER OPERATIONAL USER GUIDE 

 

Page 277 of 351 

All Programmes offered by the DIT are subject to a fee. The fee charged includes a Student Registration Charge 
(Capitation Fee) and a Tuition Fee. The fee is determined by a number of factors such as: 

− Type of Programme (Undergraduate, Postgraduate, etc.) 
− Level of the Programme (Level 6 - Higher Certificate, Level 7 - Ordinary Degree, Level 8 - Honours Degree, 

Level 9 - Masters Degree, etc.) 
− Whether the student entering DIT is a EU or Non-EU student 

 

Under the Irish Government’s Free Fee Scheme the student may be eligible to funding towards their tuition fee. 

Furthermore, depending on the student’s status or the type and level of Programme, the student may be eligible for 
financial assistance from SUSI (the Central Grant Awarding Body) or another Local Authority such as a County 
Council or a Vocational Educational Committee (VEC). 

The type of grant/allowance the student is entitled to receive will be determined by a combination of the programme 
type and the student’s own personal circumstances.  

Banner is configured to manage fee rules and grant eligibility for each and every student. As a rule, all whole time 
undergraduate students are initially set-up with either a ‘Standard’ or ‘TLT’ non aided grant record. This infers that the 
student’s tuition fee will be covered by the relevant government fees scheme. The student will be initially liable for 
their own capitation fee until such time that confirmation of grant approval is provided by the student. 

Part-time students do not generally fall within the remit of any government or local authority funding. However, some 
part-time programmes are run in conjunction with external third parties whereby an agreement may be in place for 
student fees to be paid by the third party. Where this is the case, funding rules and a Third Party contract should be set-
up in Banner to reflect this arrangement.  

DIT now facilitates a payment option to allow students pay their fees by Installments. This is available to all students 
via the Online Web Registration system. A student can make an online payment of any amount at any time over the 
course of the year (providing it is at least €100). However, it should also be noted that the student will not be formally 
registered until they pay a minimum of 50% of their total outstanding fee.  Academic year students are obliged to pay 
this minimum amount and register before the 31st October. Calendar year student must pay and register by 28th 
February. 

Further information on the regulations governing the student fee policy is available from the registration website. 
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STUDENT FEE ASSESSMENT 
Before a new student registers for a full-time programme at DIT, they must be assessed for the correct Third Level fees. 
This assessment is carried out as part of the online web registration process. 

Each student will be asked to answer the following questions online: 

1. Are you an Irish National? 
2. Are you an EU National? 
3. Are you a national of an EEA Member Country? 
4. Are you a national of Switzerland? 
5. Have you been granted official refugee status in Ireland? 
6. Have you previously completed or partially completed a third level programme?  
7. Have you been resident in an EU Member State for at least 3 of the last 5 years? 
 

Irish nationals are required to answer Qs 1, 6 and 7. All other national must answer all questions. 

 

SAAADMS – ADMISSIONS APPLICATION 

 

The answers to all questions are saved on the Checklist tab of the SAADMS form in Banner. 

You should notice a Y or N to each answered question inferring a response of Yes or No respectively. The FEE4 
question is simply a declaration that all answers were answered correctly and in good faith. 
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The full list of codes recorded on SAAADMS is as follows: 

Request  Question  

FEE1  Have you previously completed or partially completed a third level course?  

FE2A  Are you an Irish National? 

FE2B  Are you an EU National? 

FE2C  Are you a national of an EEA Member Country? 

FE2D  Are you a national of Switzerland? 

FE2E  Have you been granted official refugee status? 

FEE3  Have you been resident in an EU Member State for at least 3 of the last 5 years?  

FEE4  Declaration checkbox  
 

Note: Where FE2A is Y (Yes), student is not required to answer to FE2B to FE2E. 

Depending on the student’s answer to these questions, they student may be: 

− Eligible for free tuition fees under one of the Dept. of Education grants schemes. 
− Required to pay the standard EU programme fee, but without grant support. 
− Required to pay the full international programme fee. 

 

DEPT OF EDUCATION FREE FEES SCHEME 
The Higher Education Grant scheme is applicable to Higher Degree/ Level 8 programme. Eligible students on these 
programmes will inherit a default Grant Code of: 

− Funding Category  00 (Standard) 
− Funding Maintenance  20 (Non Aided) 

 
Students with these funding codes against their grant record on SZASGNT will be automatically set-up against the Dept 
of Education (5000) contract. As a result, the Department of Education will be liable for the student’s tuition fee.   The 
student will still be liable for the capitation fee while they are coded as Non-Aided (20). 

On TSAAREV, a DESP (Dept. of Education & Science) payment will reconcile against the TUIT (Tuition Fee) charge.  

 

 

  



BANNER OPERATIONAL USER GUIDE 

 

Page 280 of 351 

TUITION SUPPORT GRANT 
New students may apply to a SUSI for third level financial assistance. Returning students who are still part of the older 
grant schemes will continue to apply to their local authority for third level financial assistance.  If they are successful, 
you should expect to receive written confirmation from the grant authority outlining the student’s grant entitlements. 

Students can now declare that they have applied for a grant using the DIT Online Web Registration facility. Note 
however that this declaration of a grant application does not automatically entitle a student to a grant.  A student’s grant 
record in Banner remains coded as ‘non-aided’ until such time that the student produces a ‘letter of award’. 

By provided this information the student can register on the premise that they have applied for a grant. 

CHANGES TO STUDENTS GRANT RECORD - SZASGNT 
Changes should be made on the Student Grants Maintenance Form (SZASGNT).  When you enter the form, enter the 
relevant Student ID and Term code. Then select ‘next block’.   

 

When updating a level 8 student’s grant record from non-aided to aided, you must enter the new Funding Maintenance 
Code and Awarding Body as appropriate, to reflect the student’s grant entitlements (e.g. Funding Maintenance 82 – 
SUSI 100% Contribution Aided).  

 

 

Note: Depending on the grant you are entering, you may receive an error telling you that the grant could not be 
established. In certain circumstances, this is correct (e.g. a student has been changed from 00 20 to 06 20 which means 
that the student is 100% liable for their own fees, therefore they are not entitled to any grant). 

F10 to save changes. 
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UPDATING GRANT APPLICATION DETAILS 
You must also update the student’s grant application details on SZASGNT. To access this data, select Grant Application 
Details from the Options menu 

 

You should expect to see the following Grant Application details: 

− Grant Application Date 
− Awarding Body / VEC 
− Application Status 
− Comments 
 

 

This grant declaration information is originally submitted by the student using the Online Web Registration facility. If 
the student has not submitted this information online, it will appear blank. 

Following confirmation of a student’s approval for a maintenance grant, the Application Status should also be updated 
to ‘Approved’ along with any additional comments in the Comments field (e.g. Date of update and initials of Banner 
user who processed the update). 
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Updating the status of a student’s grant application does not automatically update the student’s grant funding codes to 
‘aided’.  This action must also be completed on SZASGNT (as outlined previously) to ensure student is coded correctly. 

Note: Where confirmation that a student’s application was rejected, you can also update the Application Status to 
‘Rejected’ 

Save changes upon completion. 

 

TSIAUTH - CONTRACT / EXEMPTION HISTORY QUERY 
To review and query what ‘contract’ a particular student is set-up against, you can use the form TSIAUTH.  This form 
will also allow you to determine if a student has been ‘Deleted’ from a particular contract (i.e. if a Grant Record was 
removed). This is denoted by the D flag under the Delete column. 

To use the form, simply enter the ‘Student ID’ and select ‘next block’. Details of Contracts by Term will then display. 
You can execute queries similar to any other Banner Form by use of F7 & F8. 
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TLT GRANT SCHEME & PROCESS 

The TLT Grant scheme was a grant funding scheme applicable to Ordinary Degrees, Diplomas & Certificates / Level 6 
& 7 programmes. New students now apply to SUSI for grant funding. However, returning students who are still part of 
the old TLT scheme will continue on this scheme. 

All eligible students on these programmes (SUSI and TLT) will inherit a default Grant Code of: 

− Funding Category - 03 (TLT Scheme) 
− Funding Maintenance - 30 (Non Aided) 

 

Students with these funding codes against their grant record on SZASGNT will be automatically set-up against the TLT 
Dept of Ed Fee Scheme (3000) contract. As a result, the Department of Education will be liable for the student’s tuition 
fee. The student will still be liable for the capitation fee while they are coded as Non-Aided (30). 

On TSAAREV, a TLTP (TLT Payment) payment will reconcile against the TUIT (Tuition Fee) charge.  

 

 

MAINTENANCE GRANTS 
Similar to Higher Education grant scheme, students may be eligible to apply to SUSI or a local authority for a 
Maintenance Grant.  If they are successful, you should expect to receive written confirmation from the grant authority 
outlining the student’s grant entitlements.   

Assuming the student is eligible; the student’s grant record will require updating to reflect this change in fees. Namely, 
the Funding Maintenance code, Awarding Body and Bank Account details will be updated on SZASGNT.   

For SUSI students, the maintenance code for students awarded a grant could be coded as: 

81: SUSI -50% Contribution Awarded 
82: SUSI- 100% Contribution Awarded 
83: SUSI – ALL/PART Tuit and Contribution Awarded  
 

For students still on the older TLT scheme, a full list of maintenance codes can be viewed from the Funding 
Maintenance drop down option within SZASGNT.  

For TLT scheme, they are as follows: 
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Next, you will need to update the Awarding Body with the relevant code.  

SUSI students will get the awarding body 8000 (SUSI). 

Students on the older TLT scheme may be awarded from any of the following list of Awarding Body VECs: 

 

Note that all Codes begin with a 3. 
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For SUSI students, DIT does not need to know the student’s bank account details. Since all maintenance payments are 
handled directly by SUSI. 

However, in the case of TLT students, the student’s bank account details are required, so that the TLT process within 
DIT can process the payment from each period via Electronic Funds Transfer.  

The following bank details are required: 

− Bank Account Number 
− Bank Account Name 
− Bank Sort Code (BSC) 

 

As part of the Online Web Registration process, students can now enter their own bank account details online. 
Therefore for those students who registered online, you should expect the student’s bank details to be already entered on 
SZASNGT. 

Note: If a BSC is not appearing in the system, contact the Support Desk and this code can be added. 

An updated SUSI aided grant record on SZASNGNT should look something like this 

 

An updated TLT grant record on SZASGNT should look something like this. 
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UPDATING GRANT APPLICATION DETAILS 
You must also update the student’s grant application details on SZASGNT. To access this data, select Grant Application 
Details from the Options menu 

 

You should expect to see the following Grant Application details: 

− Grant Application Date 
− Awarding Body / VEC 
− Application Status 
− Comments 
 

 

This grant declaration information is originally submitted by the student using the Online Web Registration facility. If 
the student has not submitted this information online, it will appear blank. 

Following confirmation of a student’s approval for a maintenance grant, the Application Status should also be updated 
to ‘Approved’ along with any additional comments in the Comments field (e.g. Date of update and initials of Banner 
user who processed the update).Updating the status of a student’s grant application does not automatically update the 
student’s grant funding codes to ‘aided’.  This action must also be completed on SZASGNT (as outlined previously) to 
ensure student is coded correctly. 

Note: Where confirmation that a student’s application was rejected, you can also update the Application Status to 
‘Rejected’ 

Save changes upon completion. 
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TLT START & END DATES 
TLT Start and End Dates are configured in the system for each programme. They are added at the time of programme 
set-up and updated as necessary prior to the first TLT Grants Payment run. These dates should be reflected on each 
individual student Grant on SZASGNT. 

 
TLT REPORTING 

BUSINESS OBJECTS VALIDATION, AUDIT AND DQM REPORTS 
Prior to each TLT Grants pay period, it is necessary to run the Grants - Validation Listing report from Business 
Objects (Fees and Grants category). This will highlight any invalid data such as missing Bank account details or dates. 
Data which is invalid or missing could result in an unprocessed payment for the student. 

The DQM – Student Data Errors Detail (by Programme) report in the Data Quality Reports category will also 
highlight student grant errors which require attention. A list of DQM error codes is available from the Business Objects 
report DQM – Data Error Codes & Descriptions.  

 
UPDATING INVALID DATA ON A TLT GRANT RECORD 
If you have noticed that details on a student’s grant record are incorrect you may need to make amendments. 

If the TLT grant record is still valid, but rather details such as Bank Account of Funding Maintenance Code need are 
incorrect, simply update the record directly on the form SZASGNT and save. 

If the student is not entitled to a TLT Maintenance Grant, the Funding Maintenance should be changed back to 30 (Non-
aided) and Awarding Body removed. Again, this change can be made directly on the SZASGNT Form and changes 
saved. 

 
CHANGES A TLT GRANT RECORD AFTER FIRST TLT PAYMENT RUN 
If you discover that a TLT grant record is invalid after the first TLT Payment run, then you should never remove the 
TLT Grant record on SZASGNT. Instead, you should update the ‘TLT Grant Details End Date’ directly on SZASGNT. 

 

TLT PAYMENT SCHEDULE 

The TLT Student Payment schedule is published each year and provides details of the TLT payment data including 
closing date for receipt of attendance reports, bank notification date & payment date. 

 

IMPORT OF TLT GRANTS DATA FROM BANNER TO GRANTS SYSTEM 

Based to the TLT Payment Schedule for a given Academic Year and following receipt of attendance reports from each 
Faculty, Payroll will import all TLT Grant Information from Banner for processing and submission to the Bank. These 
dates will be agreed in advance. Payroll will then process the information in the TLT Payments System and generate 
and output file for submission to the Bank and subsequent processing of EFT payment to students accounts. 

  



BANNER OPERATIONAL USER GUIDE 

 

Page 288 of 351 

STUDENT PAYMENTS – TZITLTP 

Once the ‘bank’ file has been generated by Payroll, Banner will be updated with information regarding the student’s 
payments. A full payment audit history on TLT eligible students is available on Banner Form - Student Grants Payment 
– TZITLTP.  

Note: this form is not applicable to SUSI students. 

 

To review details, enter the relevant  

Term Code, Student ID  

and then ‘next block’. 

 

 

 

 

WITHDRAWING A STUDENT 
Where attendance is not satisfied or if the student is withdrawing or deferring from a programme, the user must take the 
appropriate action to update the student’s enrolment status in order to withdraw / defer them. This action will 
subsequently withdraw their grant entitlements. If a student is withdrawing or deferring, you should not remove the 
grant record. Instead, you should ensure that the withdrawn / deferred date is entered correctly in SFAREGS and 
appears in the TLT Grant Details ‘End Date’ in SZASGNT (see details below). If a student is being removed for any 
other reason from a TLT maintenance grant, Payroll needs to be advised. 

To update a student’s enrolment status in SFAREGS, simply 

1. Enter the SFAREGS Form 
2. Enter the Term, ID and effective withdrawal / deferral Date in the key block. 
3. Next Block to enter the Form. 
4. Update the enrolment Status as appropriate (e.g. WI) 
(Note: Withdrawal and Deferral Status must be used in accordance with the correct withdrawal or deferral date as 
outlined in the Student Finance Policy. There are also fee refund implications to these statuses and dates.) 
5. Ensure the ‘Student Grant Withdrawal Date’ is correct when prompted and then save. 
6. The student’s enrolment status will be saved. 
7. Check SZASGNT to ensure the TLT Grant Details ‘End Date’ is updated as per withdrawal date. This will 
ensure the student will not be processed as part of any future TLT Grant payment run. 
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OTHER GRANT RULES 

OVERSEAS NON AIDED 
The Funding Rules for Overseas students are coded as Overseas / Non-Aided (09, 20).  

Overseas students who are eligible for EU fees are coded as Overseas EU Fee / Non-Aided (15, 20). 

There is also an Overseas / 100% Tuition or Capitation (09, 50) coding rule which caters for ‘Overseas’ students where 
fees are covered ‘in-part’ by a Third Party. 

More information on ‘Overseas’ students can found under the section on International Students. 

 

SOCRATES 
Socrates students Grant records are coded as  

- Socrates (incoming 3 months) / Non-Aided (10, 20)  
- Socrates (incoming 1 semester) / Non-Aided (14, 20)   
- Socrates (incoming 1 year) / Non-Aided (11, 20). 
 

POSTGRADUATE 
Postgraduate students are initially coded with funding rules based on the programme set-up which is Self Support / Non-
Aided.  

− Post Graduate Self Support / Non-Aided (16, 20) 

Where postgraduate students are set-up with an ‘aided’ grant, the Third Party awarding bodies associated with these 
grants will begin with 1 or 2.  

Post Graduate students approve for grant maintenance funding are coded with one of the following codes 

− Post Graduate PG Grant (Max Amt Awarded) 
− Post Graduate PG Grant (50% of Max Amt Awarded) 
− Post Graduate BoI Student Loans (PG) 

Postgraduate students who have been awarded funding from a third party are often approved for a specific funding 
amount or percentage of the full programme fee. In such instances, it is possible to insert a ‘maximum’ amount by 
which the third party is liable for. This ‘maximum’ amount must be entered manually against the student’s contract 
direct on TSAACCT. See the section on TSAACCT for further information on managing student contracts and entering 
‘max amounts’. 

SELF-SUPPORT 
Some undergraduate students are entirely liable for their own fees due to the fact that they have completed a year on 
another programme either in DIT or another institution.  These students will have a Funding Codes of Self-Support / 
Non-Aided (06, 20).  100% of their fees will be charged to them. 

  



BANNER OPERATIONAL USER GUIDE 

 

Page 290 of 351 

THIRD PARTY FUNDING 
Some programmes offered at DIT will have an agreement with another third party or funding body.  This will often 
involve the third party agreeing to cover the cost of student fees on that programme. 

These programmes will have a funding rule with grant codes and third party contract associated specifically with that 
programme.  

Once all data is set-up, students on that programme should have the relevant grant codes and awarding body set-up on 
their grant form SZASGNT, thus triggering the liability transfer of programme fees to the relevant third party.  

 

E.g. Grant record reflecting IBEC funding codes 

 

REPEAT STUDENTS 

INTERNAL REPEAT 
When a student is repeating a year, you must change their grant record to reflect this.  Students repeating a year are not 
entitled to a grant and are therefore liable to pay their own fees. Students may be repeating the entire programme year of 
a set no. of modules. Their grant record should reflect this as follows: 

− 12 (FCAT) and 20 (FMAN).  

Note: Where Rate of RCRED is used, a Fee per Module is applied directly on the student’s account. Therefore, the 
Funding Codes for repeat students are used purely as a method to flag students as ‘repeats’ on their grant record. 

EXTERNAL REPEAT 
External Repeat (XR) students are not eligible for a grant. Further information on Repeat students is covered under the 
section ‘Repeat Students’. 
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PROCESSING PAYMENT FROM SFAREGS 
From SFAREGS it is also possible to process a credit or debit card payment for the student. This can be done for both 
full-time and part-time students.  

Part-time student also have the option to submit a cheque payment. 

To select a payment option on SFAREGS, you must first trigger ‘Fee Assessment’ by saving twice from within the 
Registration tab. You will be prompted with the following message: 

 

Select OK. 

You should now notice the following payment and receipt options appearing at the bottom of the form. 

They will vary slightly depending on whether the student is full-time or part-time/apprentice 

The student payment is processed by selecting one of the payment options available at the bottom of the form. 

FULL-TIME PAYMENT OPTIONS 

 

PART-TIME/APPRENTICE PAYMENT OPTIONS 

 

 

CREDIT CARD PAYMENTS 

To choose Card Payment, select this option. A prompt box will appear. The ‘Payment Amount’ should reflect the total 
outstanding fees for that student. 

 

Note: the ‘Important’ instruction on the prompt instructs users to ensure that payment is taken for the appropriate term. 
In other words, if ‘Payment Amount’ includes fees outstanding from a previous term, then payment should be taken 
against that previous term first before processing payments for the current term. 
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You also have the option to ‘override’ the payment amount if you wish to process a different payment amount from the 
student. Simply check the ‘Override Amount’ checkbox and enter the new desired ‘Payment Amount’. 

When have are satisfied, select ‘Proceed’ to continue. 

You will then be brought to a new browser window detailing the transaction number and transaction amount. If you are 
satisfied that the amount is correct, select ‘Proceed to Payment’.  

 

You will then be prompted to enter the student’s credit/debit card details. You can process Visa, MasterCard or Laser 
payments. 
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When you have entered the relevant details, select ‘Pay Now’. You should notice this will then change to ‘Processing’. 
You should not do anything further until you receive a message confirming the card payment has either been processed 
successfully…... 

 

OR declined. 

 

Assuming the payment was successfully processed, you should click ‘Finish’ to close the card payment browser 
window and return to SFAREGS in Banner. 

Return to SFAREGS and update the student enrolment status to RE (Registered), where appropriate. 

 
PRINTING RECEIPTS 
Having processed a card payment, you should now produce a receipt for student. You should first rollback on 
SFAREGS and re-enter the form. Save twice again to re-trigger fee assessment. This will ensure the payment and 
receipt options are displayed. 

To print a receipt, select the ‘Print/Reprint Receipt’ button.  

You will be prompted to select either ‘Last Credit Card Payment’ or ‘Receipt for All Payments’. These are self-
explanatory. Where multiple card payments were made by a student, you may wish to print the ‘Receipt for All 
Payments’. However, if the student paid all outstanding fees using a single card payment, then ‘Last Credit Card 
Payment’ should be sufficient. 
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Assuming you select ‘Last Credit Card Payment’, you should then choose ‘Print Receipt’ button. 

A new browser window will open a PDF document of the receipt details. 

 

This should be printed on the appropriate stationery. The receipt will have a perforated line which you can tear in order 
to give the student their copy and for you to retain your section of the receipt.  

CHEQUE PAYMENTS 

It is also possible to take a cheque payment for part-time students.  To process a cheque payment, select on the ‘Cheque 
Payment’ option. 

Processing a cheque payment does not credit the student’s account, but rather enables you to print a receipt to reflect 
receipt of such payment. 

A prompt box with the amount required will be displayed.  

 

When you select OK to the prompt message, a new browser window will open a PDF document of the cheque receipt 
details. 

This should be printed on the appropriate stationery. The receipt will have a perforated line which you can tear in order 
to give the student their copy and for you to retain your section of the receipt.  
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Upon generating a cheque receipt, the student will be automatically registered (RE). Where appropriate, the student’s 
enrolment status may need to be changed (e.g. if minimum payment amount for registration not satisfied). 

The student’s account on TSAAREV will still have the outstanding debt until the point whereby the cheque is fully 
processed through DIT’s bank account reconciliation and manual payment matching process. 
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TSAAREV – ACCOUNT DETAIL REVIEW FORM 
To query and review the charges and payments against a student’s account, use TSAAREV. This form details all 
account transactions against a student’s account for each Term. 

Simply enter the Student’s ID and then select ‘next block’. All account transactions will display. 

As with any Banner form, you can query and execute on a defined set of values. 

E.g. - To review account transactions for a given term only, select F7 to clear the screen. Enter the Term under Term 
field and select F8 to execute the query. You will now see those transactions only for that specific Term. 

 

The ‘Account Balance’ and ‘Amount Due’ totals at the end should reflect the student’s overall balance. The ‘Query 
Balance’ reflects any specific query you have just executed (e.g. querying transactions against a single term). 

 

Note: Remember Charges and Payments will only be updated providing Fee Assessment has run following the most 
recent change to the student’s account. If Grant records or Enrolment Status have changed, the account details will 
only be updated after the Liability transfer has been triggered.  The liability transfer process runs daily after the fee 
assessment process.  
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AMENDMENTS TO STUDENTS ACCOUNTS 
Not all transactions on a student account can always be captured by the standard fee, billing, grant entitlements or 
payments processes. There may be instances where a manual adjustment is required on a student’s account. In such 
instances, the user must apply an amendment directly on the Account Detail Review Form – TSAAREV.  

The type of manual adjustment will depend on the type of charge / fee amendment required.  This section will aim to 
demonstrate the various types of manual adjustments which can be applied via TSAAREV. Note however, it will not 
attempt to illustrate the Finance regulatory procedures which govern the policies behind any such account amendments. 
This detail is covered as part of the Finance Student Fee policies, published at the beginning of each Academic Year  

(ref http://www.dit.ie/intranet/finance/policiesandprocedures/).  

Note also that where adjustments are manually added to the student’s account, the necessary documentation should be 
kept on file for audit purposes. 

Note: Users must familiarise themselves with all student fee policies prior to making any changes on TSAAREV. 

 

FEE WAIVERS & DISCOUNTS 

Fee Waivers may be approved against a student for varying reasons.  When a waiver is approved for a student, the 
student account in Banner should be manually updated to reflect this. 

APPLYING A FEE WAIVER 

To apply a waiver directly on TSAAREV, you need to:  

− Open the Form – TSAAREV (Account Detail Review Form) 
− Input the Student ID and then ‘next block’. All fee and liability transactions for all Terms will display. 

 

 
 

− From the Menu, select Record -> Insert to create a new transaction. 
− Input detail code of either WAIF (Full Fee waiver) or WAIP (Part Fee waiver) as appropriate. 
− Tab into the Description field and include the Waiver Reference (e.g. EN0001) in the Description 
− Tab to the Term field and input the term code for which the waiver applies.   
− Tab to the Payment field and input the waiver amount and save.   

 

 

  

http://www.dit.ie/intranet/finance/policiesandprocedures/
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APPLYING A DISCOUNT 

Note: Alumni Waivers & Staff Discounts are not applied directly on a student’s account, but rather are set-up with an 
exemption code which automatically triggers the discount on the account. The student is set-up against these exemption 
codes at the point of record set-up or at the point of progression. The sections of ‘Staff and Alumni Registrations’ refer. 

It is also possible to apply a discount directly on the student’s account in TSAAREV. For example International 
Postgraduate students may be eligible for a 20% discount on their fees. 

To apply a discount directly on TSAAREV, you need to:  

− Open the form – TSAAREV (Account Detail Review Form) 
− Input the Student ID and then ‘next block’. All fee and liability transactions for all Terms will display. 
− From the Menu, select Record -> Insert to create a new transaction. 
− Input detail code of DISC. 
− Tab into the Description field and include the appropriate Discount Reference (e.g. Int. Loyalty PG Discount 

20%) as the description. 
− Tab to the Term field and input the term code for which the discount applies.   
− Tab to the Payment field and input the discount amount and save.   

 

 
 

APPLYING LATE FEES & ADMINISTRATION CHARGES ON ACCOUNTS 

The policy and guidelines governing the application of Late fees and Admin charges are covered under the Finance 
Student Fee policies, published at the beginning of each Academic Year  
(ref: http://intranet.dit.ie/finance/pols_proc.html).  
 
APPLYING A LA TE FEE /  ADMIN CHARGE: 

− Open the Form – TSAAREV (Account Detail Review Form) 
− Input the Student ID and then ‘next block’. All fee and liability transactions for all Terms will display. 
− From the Menu, select Record -> Insert to create a new transaction 
− Input detail code of LFEE (Late Fee) or ADCH (Administration Charge). 
− Tab to the description field and enter a description which accurately reflects the reason for the fee / charge. 
− Tab to Term field and enter correct term. 
− Tab into the Charge field and input the fee amount (e.g. €60) and save. 

 
DISSERTATION FEE 

http://intranet.dit.ie/finance/pols_proc.html
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A dissertation fee can be applied to a student’s account, where no module fee already exists. 

APPLYING A DISSERTATION FEE 

− Open the Form – TSAAREV (Account Detail Review Form) 
− Input the Student ID and then ‘next block’. All fee and liability transactions for all Terms will display. 
− From the Menu, select Record -> Insert to create a new transaction 
− Input detail code of DIST. 
− Tab to the Description field. You will notice the text ‘Dissertation Fee’ will default. 
− Tab to Term field and enter relevant term. 
− Tab into the Charge field and input the dissertation fee amount. 
− Save to commit changes. 

 

 

STUDENT REFUNDS 

REFUND 

Where a refund is applicable and has been approved, the refund should be updated against the student record in Banner 
and also processed in the respective financial system (i.e. Agresso for cheque refunds and Real Control for Credit/Debit 
card refunds 

To apply a refund in Banner: 

− Open the Form – TSAAREV (Account Detail Review Form) 
− Input the Student ID and then ‘next block’. All fee and liability transactions for all terms will display. 
− From the Menu, select Record -> Insert to create a new transaction 
− Input detail code of RFND (Refund Payment). 
− Tab to the Description field and enter the refund reference number set by the faculty. 
− Tab to Term field and enter correct term (note: this should always reflect the Term for which the refund 

applies). 
− Tab into the Payment field and input a ‘negative’ minus value followed by the refund amount (e.g. - €200) and 

save. 
 

 

TRANSACTION ENTRY ERRORS 
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If a transaction has been inserted on TSAAREV (Account Detail Review Form) in error, you should reverse this 
transaction by adding a new transaction with the same Detail Code, Description (prefixed with reverse) & Term as the 
error line and enter either a minus or plus payment/charge as appropriate. 
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EXAMINATIONS 
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Examinations processing encompasses the sequence of activities ranging from the initial entry of student grades in EGB 
right through to the rolling grades to Academic History and ultimately flagging students either for Progression (to the 
next term) or Reassessment (to re-sit supplemental exams). 

 
PREPARATION FOR ASSESSMENT MARKS ENTRY 

DISABLING STUDENT PINS 
In advance of opening EGB for assessment marks entry by lecturers, all student PINs are globally disabled by MIS 
Office with a reason Code DPOS (Disable Pin Off Season). This prevents students from logging into Student Self 
Service and viewing exam results before Exam Boards have ratified results. Colleges will be notified in advance of this 
action. 

The status of individual student PINs can be reviewed on GZTPIND. It is also possible to run a student PIN disabled 
report from the Options menu. See section Student PINs for further information in relation to managing student PINs. 

 

EGB - LOGGING IN AND ENTERING ASSESSMENT MARKS 
When EGB is opened to lecturers for the purposes of entering grades, the lecture will logon using the EGB username 
(Staff ID) and PIN.  

If the lecturer is new to DIT and have never used EGB before, their default PIN will be their date of birth. Once logged 
on, they will be prompted to enter a new PIN and a security question.  

If the lecturer has used EGB before but cannot recall their PIN, then the users should be advised to use the ‘Forgot Pin’ 
functionality on the EGB logon screen in order to reset their own PIN. If the lecturer is unable to use the ‘Forgot Pin’ 
functionality (either because they have not yet set-up their security question OR if they can’t remember their security 
question), then you can reset the lecturer’s PIN on GOATPAC. This will reset it to be the same as their user ID (i.e. 
staff no.). 

When lecturers log into EGB for entering Assessment marks, they select: Assessment Academic Year  CRN for 
which they wish to enter marks. 
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Lecturers must enter marks for all components of a given CRN. If marks are not entered for all components, then no 
overall grade will be calculated. Thus no overall grade can be seen in Banner for the selected student(s). 

The Lecturer also has the option in EGB to suggest an overall comment for students. This comment is entered against 
the overall calculated grade and can be used to instruct students to repeat certain components. This comment will also 
display on the class roster form SFASLST. 

 

The list of comments available to lecturers in EGB is as follows: 

R AURAL  Repeat Aural 
R ORAL  Repeat Oral 
RE  Repeat Written Examination 
RL40  Repeat all components less than 40% 
RL50  Repeat all components less than 50% 
RM  Retake Module 
TN  Threshold not met 
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SZPSTAF – ACADEMIC EGB LETTER 
If a lecturer requires a printout of all CRNs/Module which are assigned to them in EGB, it is possible to generate a 
letter detailing this from SZPSTAF. 

 

To use the form, simply select the Term Code and individual Staff ID.  Then click on Create CRN Letters.  Proceed on 
the popup to confirm number or cancel and reselect criteria. 

Note: You only need to check the ‘Reprint’ checkbox if the letter has already been generated for the term. 
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ROLLING EXAM RESULTS 

CLASS ROSTER - SFASLST 
The Class Roster Form SFASLST displays the overall grades and comments for a particular cohort of students on a 
given CRN.  

Overall grades will only be viewable on this form assuming the lecturer has submitted marks for all components on that 
CRN. The overall result will reflect the total grade based on combined component marks and weightings (as defined on 
SHAGCOM (Gradable Component Definition Form) 

To query students’ results on a given CRN, enter the Term and CRN in the key block and then ‘Next Block’ in form.  

Note: Assuming you are not yet in a position to roll students to Academic History at this point, you should ensure the 
Roll indicator checkbox is not checked before you next block into the Form. The ‘Roll’ indicator should only be checked 
when you are happy that all updates including Grade entries and Comments are correct and you are satisfied to roll all 
student grades on this CRN to Academic History. 

 

From this form, you have the option to change the overall Final Grade. However, if you do decide to change to overall 
Final Grade in SFASLST, the combined total of components based on weightings may differ to this manually altered 
overall grade on SFASLST. 

To change a Comment, simply highlight the relevant student record and either overtype with new comment code or 
select comment from Grade Comments validation list (select from dropdown or F9 in Grade Comment field to view all 
Comments).  Comments with an asterisk pre-pended on description are no longer valid and should not be used (e.g. 
*Submit Log Book by 15 August 2005). 

Once all data all has been verified and validated, you will be in a position to roll student results to Academic History.  
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SFASLST 
To ‘roll’ students results to Academic History from SFASLST, you do the following: 

− Enter the Term and CRN in the key block. 
Note: roll-back to the key block if you are already in the form querying results. 
− Check the roll indicator. 
− Next block into the form. 
− Assuming you are happy that all updates have been made and the data has been verified and approved, you can 

roll the students by selecting SAVE. 
− You will now notice the roll indicator checked against all students with grades.  
− At the bottom of the form you should see a message confirming roll was successful  

‘Transaction Complete: _ records applied and saved’ 
 

Before leaving the form, you should return to the key-block and uncheck the roll indicator. This sets it to be unchecked 
as default. 

Once results have been rolled (the Rolled box is checked), then all queries and amendments should be managed on the 
Academic History Forms. 

SHROLL 
SHRROLL is an alternative option to roll CRN grades, thus creating Academic history records for the students. This 
process can be run for more than one CRN at a time. You can run for multiple CRNS by inserting a separate Course 
Reference parameter for each CRN. Each time it runs, it will process any new final grades posted to student records 
since the last time it was run for the CRN. 
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The following Parameter values need to be entered on this Form: 

− Term Code e.g. 201314 
− Part-of-Term Code e.g. 1, S1, S2 
− Course Reference Number: e.g. 9008 
− User ID e.g. your banner user id 
− Report Mode (A is audit mode and U is update mode.  Running in Audit mode will not create academic history 

records but will allow you view what records will be created when you run in update mode).  
− Print Selection = A (All) 
− Grade Term can be left blank 
− Roll Long Title Selection = N 

 

Once all values have been correctly entered, next block to the Submission section. Check the ‘Save Parameter Set as’ 
box and then save the Form (F10).  

 

Select OK to the ‘Saving Current Parameter Values as User level defaults’ popup. 

Following job completion, you will see a log file number. Note this down, as it can be used to confirm that the job ran 
successfully.  Go to Menu: Options -> Review Output [GJIREVO] and click on the preferred .lis file. The file will 
display the CRN and students that have been rolled to academic. 

If you wish to save this file output (or any other job submission file) to a local directory on your PC, simply select 
Option -> Show Documents (Save and Print File) from the menu 

 

You will then be prompted to save the file. 

 

Select ‘Save File’ and the file will be saved to your c:\temp folder on your pc. You will see another message prompt, to 
which you select OK. 

Note: You must have a folder called ‘temp’ already set-up on the root directory of your C drive to save outputs from job 
submission in Banner.  
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ACADEMIC HISTORY - SHATCKN 
After you have rolled students’ results, you can then review all grade result details for a particular student in the 
Academic History form (SHATCKN). 

When you access the SHATCKN form directly, select the student ID and Term, with ‘Validation Check’ set to 
Schedule. ‘Next block’ to query all rolled CRNs for the student. You can scroll through the list of CRNs by using the 
scrollbar beside the Course Detail section. You can also query a particular CRN using the F7 & F8 functions keys as 
you would on any Banner form. 

 

The Grades section will detail the students Overall Grade, for a selected CRN.  You will also notice a ‘change reason’ 
and ‘grade comment’ (where applicable). 

GRADE COMMENTS 
If a Grade Comment was entered prior to the rolling of student’s grade to Academic History, this comment will be 
visible. It is also possible to enter a Grade Comment (where none previously existed) or make an update to a Grade 
Comment as preferred. This Grade Comment should reflect Exam Board decisions and is assigned to the overall CRN 
result. It is generally used as an instruction to the student regarding what action is required (e.g. which components to 
repeat). 

To enter a Grade Comment, next block to Grades and either input relevant code in Grade Comment field or double click 
and select from the list.  Comments pre-pended with asterisk in description should no longer be used. 
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INSERTING NEW OVERALL GRADE 
A new Overall Grade and Grade Change reason can also be inserted for the CRN. This can be done by selecting F6 
(insert new record) when active in the Grades section of the form.  

Simply insert the new Overall Grade as well as the Grade Mode and Credits for the CRN (attempted hours will 
automatically populate). Input a Change Reason code and a Comment where appropriate. Then save using F10.  

 

Note: As per update to Final Grade on Class Roster form SFASLST, any update to Overall Grade on SHATCKN 
precedes the system calculated Overall Grade (which is based on component grades and weightings). Therefore, any 
manually inserted Grade may differ to the system calculated ‘component weighted’ Overall Grade. You should also 
remember to carry forward any required Grade Comments on newly entered Grade Sequence, where applicable. 

 

 

COMPONENTS 
Component results can be reviewed by selecting Options -> Components after you’ve selected the student, term and 
CRN you wish to query on SHATCKN. 

 

Each component is listed for the CRN with details of their latest Score, Weight and Change Reason. 

 

Component History details the history of changes on the Component.  Highlight the component for which you wish to 
view history and click on the Component History button on the bottom right. 
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The full history of changes on the component displays on the form.  The lecturer ID displays as the User ID for marks 
entered or updated in EGB as well as the Change Reason selected by the lecturer on EGB when making the marks 
changes. 

The list of Change Reason codes available to Lecturers in EGB for Assessment is: 

OE Original Entry 
IS Instructor Correction 
DS Did not sit/submit 
 

Once you’ve finished querying one component, click on the Return button (on bottom right) to return to the Component 
Grades record and query another component. 

While on Component Grades, click on the Return button below Component History to return to Course Maintenance 
and select another CRN. 

CHANGING COMPONENT MARKS IN ACADEMIC HISTORY 
Component marks can be changed directly in Academic History.  Select the student, term and CRN you wish to query 
on SHATCKN Course Maintenance.  From the menu go to Options -> Components.  Click on the component you wish 
to update and change the score.  You must also select an appropriate change reason code. Save upon completion. 

 

Selecting YES will trigger a re-calculation of the Overall mark and insert a new Overall Grade record on Academic 
History based on the latest Component marks and weights on SHAGCOM. 

 

Selecting NO will NOT trigger a re-calculation of the Overall Mark. Component grades may have been changed but 
there will be no change on the Overall Grade on Academic History. 

The Calculated Summary popup on the Component provides more details of the activity on the component record. Click 
on the Component you wish to query and double click in the Calculated Summary field. 
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The Composite Marks box on the Component Grades record displays different information depending on the point in 
time and how the data was input.   

If you review the history behind the component, you should also expect to see the latest change with the highest 
sequence number. Note also the INB user who made the component change directly in Academic History 

 

 
GRADE CHANGE REASON CODES 
The grade record inserted from the initial grade roll to academic history (either from SFASLST or SHRROLL process) 
will always have a change reason of OE (original entry). 

The following are the Grade Change Reasons that are available to use when making amendments on SHATCKN 
Academic History (for both Component and Overall Grades) 

A1 Attempt 1 for Module 
A2 Attempt 2 for Module 
A3 Attempt 3 for Module 
A4 Attempt 4 for Module 
AA Additional Mod Attempt Granted 
CX Exclude Component 
ER Office use data entry error 
ES Data Entry pre 7.4 EGB upgrade 
EX Exemption approved by Faculty 
MB Module Board Decision 
NS Did not Sit 
PB Progression and Award Board 
PE Panel of Enquiry Decision 
RB Reconvened Board 
SB Supplemental Board Decision 
SN Did not Sit Supplemental 
SR Supplemental Result 

 
The following are the ‘system required’ Grade Change Reasons. These Change Reasons will generate against grades 
records as a result of component marks changes which trigger re-calculations automatically. These codes are not 
available to you on the drop-down lists when making updates on academic history records.   

CA Calculated EGB 
CE Calculated EGB Acadhist 
CH Calculated SHATCKN 
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RC Shagcom Re-Calculated 
RR Reroll 
SA Shagcom Composite calculation 
TP Temporary AH Final Grade 
ZG Zero calculated Mark/Grade 
RH Recalc SHATCKN 
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PUBLICATION OF EXAMINATION RESULTS 
Once a student’s exam results have been rolled to Academic History, they may be able to view the result online. 
However, students can only to log-on to SSB once their PIN has been re-enabled.  Therefore, exam results are only 
made available to students at the point in time when the examinations office re-enable student PINs. 

RECONVENED BOARDS 
In some instances, individual students may also have their PINs disabled by the Exams offices subject to reconvened 
boards. This is managed by changing the individual student’s PIN on GZTPIND.  

DPPE (Disabled PIN, Results Subject to Panel of Enquiry) is one such example.  

RE-ENABLING STUDENT PINS 
Assuming the Module / Progression Boards have concluded and all exam results have been ratified, student PINs can be 
re-enabled from Form GZTPINE. 

To re-enable student PINs from GTZPINE, enter the Term Code, Programme and Year. Then select ‘Re-enable Pins’. 
Only those students who have a previously disabled PIN of DPOS (Disabled Pin Off Season) will have their PINs re-
enabled.  

PINs disabled with any other reason code (e.g. DPPE - Disabled PIN, Results Subject to Panel of Enquiry) will remain 
disabled. 

 

It is also possible to run an audit report to view which PINs have been re-enabled for a Programme & Year. This is 
available from the Menu: Options -> Student PIN Re-enabled Report 
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SZPEMAL - EXAM RESULTS REMINDER 
Once PINs are re-enabled, a standard email is sent to students notifying them of exam results being available online 
using SZPEMAL. The email also includes student’s logon details and PIN reminder. 

User must select: 
− Term Code 
− Email Type (Exam Results PIN Email) 
− Block Code 
− All Students or individual ID 

 

A checkbox is also available to re-send emails, where the reminders where previously sent. 

 

There is also an Email audit report available from the Options Menu. 
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FLAGGING STUDENTS FOR REASSESSMENT (SUPPLEMENTALS) 
Students who have failed to meet the minimum threshold for passing a particular module must be flagged for re-
assessment.  

To flag a student for re-assessment (supplemental) exams, you need to enter a new grade sequence on SHATCKN with 
one of the following Grade Change Reasons: 

– A1 (Attempt 1 for Module) 
– A2 (Attempt 2 for Module) 
– A3 (Attempt 3 for Module) 
– A4 (Attempt 4 for Module) 
– AA (Additional Mod Attempt Granted) 

 

When entering a new Grade Sequence, ensure the relevant Grade Comment is also added to ensure the student can still 
view this comment / instruction on Student Self Service. 
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PREPARATION FOR REASSESSMENT MARKS ENTRY 

DISABLING STUDENT PINS FOR RE-ASSESSMENT 
In preparing for opening of EGB for ‘supplemental’ marks entry, those students flagged for re-assessment must have 
their PINs disabled. PINs should be disabled for each student individually on form GZTPIND with a reason Code of 
DPOT (Disabled PIN, Other Reason). 

 

You can also run the Student PIN Disabled Report to check which students have been disabled. 

EGB LOGGING IN AND ENTERING RE-ASSESSMENT MARKS 
When lecturers log into EGB for entering Re-Assessment marks, they select: Reassessment Academic Year  
CRN for which they wish to enter marks. 

Only those students that were flagged for re-assessment in Academic History will appear in EGB. The lecturer will see 
the last component mark entered as default. They simply overtype this mark with their new entry, select the appropriate 
‘reason code’ (e.g. SR – Supplemental Result) and submit. 

List of available Change Reason codes in EGB for Reassessment is as follows: 

− SN Did not sit Supplemental 
− SR Supplemental Result 
− CX Exclude Component 
 

Note: The CX (Exclude Component) reason code will exclude the component from inclusion in the overall calculated 
grade. You need to confirm locally if this reason code is being used by your College. 

Not all component marks have to be re-submitted (e.g. if a student only repeated one component, then the lecturer only 
has to re-submit a new mark for that component). 

The Lecturer does not select an overall comment for students (as they did for assessment marks entry). 
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ACADEMIC HISTORY FOR REASSESSMENT– SHATCKN 
Following the submission of component mark(s) in EGB for re-assessment, you will notice a new Grade Sequence 
against the component in Academic History.  

Each update of a component mark in EGB will also trigger a new Overall Grade sequence in Academic History. It will 
display a Change Reason of CE (Calculated EGB AcadHist). 

 

Updates to student’s grades in Academic History can be made in the same manner as per original ‘assessment’ marks 
entries. Following Supplemental Board decisions, a student’s grade can be updated at the component level or the overall 
level. As per assessment, you should ensure the appropriate grade comment is entered (if necessary) and/or attempt 
code is updated where student is to be flagged for further re-assessment. 
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PUBLICATION OF RE-ASSESSMENT EXAMINATION RESULTS 
Once a student’s reassessment exam results have ratified at the Supplemental Board, the results can be made available 
to students online. This is dependent of the re-enabling of student PINs and confirmation of results by email 

 

RE-ENABLING STUDENT PINS FOR PUBLICATION OF RE-ASSESSMENT 
MARKS 
GZTPIND should be used to re-enable each student’s PIN individually. Simply uncheck the ‘PIN Disabled’ checkbox 
and save. 

SUPPLEMENTAL RESULTS REMINDER 
Once PINs are re-enabled, a standard email is sent to students notifying them that supplemental exam results are 
available online. Form SZPEMAL is used to generate this email which include student’s logon details and PIN 
reminder. 

User must select: 

− Term Code 
− Email Type (Supplemental Reminders) 
− Block Code 
− All Students or individual ID 

  

Only students who have had component marks entered in EGB with a supplemental reason code are selected for this 
email reminder. 

There is also an Email audit report available from the Options Menu. 
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UNROLLING A CRN 
 

Unrolling students should only be used where a CRN should never have been rolled to academic history (namely, where 
a student was incorrectly registered on a CRN). It should not be used where an incorrect grade was entered against a 
student. 

Unroll option can only be accessed from SHATCKN or SFASLST (via Options menu) 

 

To ‘unroll’, ensure the Term, CRN and student ID are correct.  Next block to see the student name against the ID. 

 

Select the Unroll from Academic History button. 

A Warning Alert popup will display requesting confirmation of unroll based on Student Name, ID, Term and CRN. 
Ensure details are correct before selecting Unroll to proceed. 

If details are incorrect, select Cancel and a message will appear in the auto-hint line confirming that Unroll cancelled. 

If details are correct, press Unroll and a message will appear in the auto-hint line to say Unroll from Academic History 
completed. 

The unrolled CRN no longer displays on the student’s academic history record (SHATCKN). 

On the class roster form SFASLST, the student still displays for the unrolled CRN (because they are still registered on 
it) with the rolled box unchecked. 

The student will also still display on EGB (because they are still registered on the CRN) until you drop them from the 
CRN on their registration record. See section ‘Dropping Modules from SFAREGS’ for further information on 
performing this task. Once the student has a dropped status on the CRN (DD) they will no longer appear on EGB when 
the lecturer logs on. 

Note: In exceptional circumstances, you may be required to unroll ALL students on a CRN. This is done by simply 
clearing out the student ID. Then select Unroll from Academic History. 
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MISCELLANEOUS EXAM FORMS 
 

SHACRSE - COURSE SUMMARY  
This Form is used to query all the modules on an individual student’s Academic History record. Here, you can drill 
down to detailed information by clicking the ‘Select’ button on the relevant record.  This will open the Section 
Dependent Course Maintenance Form (SHATCKN). 

 

 

SSASECQ (SCHEDULE SECTION QUERY FORM) 
This Form is used to query and display all CRNs currently in the system.  You can also search for CRNs set up against a 
specific Module (Subject and Course).  Campus, maximum and actual enrolment figures are also displayed here. 
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SFAREGS (STUDENT COURSE REGISTRATION) 
This Form can be useful to query a student’s enrolment status and/or to register students for course selections. You can 
perform adds, drops, withdrawals on students’ registration records.  

Students cannot be dropped from CRNs that have already been rolled to their academic history record.  

CRNs that are dropped directly via the SFAREGS form will be noted by their DD status on the form. However, if the 
student has dropped (DD) a CRN themselves via self service, the CRN will not be listed here. 

 

SFASTCA (STUDENT COURSE REGISTRATION AUDIT)  
This Form allows you to query registration transactions for individual students including final grades computed on 
Electronic Grade Book (EGB).  

CRNs which were automatically registered on student’s records as a result of Module Registration process (i.e. SoS 
script) will display user DITMGR. 

 

Any CRNs that the student has dropped will be recorded here with Course Status DD. CRN dropped by an admin user 
in INB will display that user’s ID. If the CRN was dropped by the student in Self-Service, the user WWW_USER will 
display. 

  

A ‘Final Updated to’ message added to the CRN row entry when an overall grade is calculated for results entered via 
EGB (i.e. all components marks have been input and the system has calculated an overall grade based on component 
weights set up on Gradable Component Definition form SHAGCOM). 
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EXAMS REPORTS 
There are also numerous Exams reports available in Business Objects for querying and detailing students’ results, 
progression decisions and award classifications. All reports are available in the Academic History category. 

These reports can be categorised as follows: 

− Results 
− Validation 
− Transcripts 

 

All reports are referenced with an R number. This is a legacy coding structure for referencing academic history reports. 

Note also that there are 2 versions for each type of Results report. The reports have been designed this way in order to 
reflect the following scenarios: 

I. Grades as entered by a Lecturer in EGB Assessment which have not yet been rolled to Academic History in 
Banner 

II. Grades that were rolled to Academic History in Banner. This may also reflect those grades as updated by a 
Lecture in EGB Re-Assessment. 

Therefore when choosing to run a particular Results report, users should cognisant of whether results have been rolled 
to Academic History to ensure the correct version is run. All reports will retrieve the most up-to-date exams data. This 
includes Supplemental results. 

Note: Remember reports reflect a point-in-time accuracy of the Banner database. If results have changed in EGB or 
Banner, reports should also be re-run to ensure you have the most up-to-date accurate list of results. 
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RESULTS REPORTS 
 

R50 -  RESULTS SPREADSHEET BY PROGRAMME (LA TEST MARKS WHETHER ROLLED OR 
NOT ROLLED) 
Module results for all students on a programme and year ordered by student name.  Report displays the latest marks 
whether rolled or not rolled.  This is a combination of the R09 EGB Assessment and Class Roster and R09 Academic 
History broadsheet reports. 
 

R51 -  INDIVIDUAL ACADEMIC HISTORY 
Academic history results record for an individual student.  The report displays the relevant academic year(s), 
programme information, module grade records and associated progression decisions and/or award classifications. 
 

RESULTS – R01 EGB ASSESSMENT & CLASS ROSTER 
Module Results listing by component and overall grade, ordered by student name. CRNs will not appear on this report if 
they have been rolled to Academic History. 
 

RESULTS – R01 ACADEMIC HISTORY & EGB REASSESSMENT 
Module Results listing by component and overall grade, ordered by student name. CRNs will only appear on this report 
if they have been rolled to Academic History. To just select supplemental students choose the appropriate grade change 
code from the list. To run for all students, select all grade change codes.  
 

RESULTS – R02 EGB ASSESSMENT & CLASS ROSTER 
Student Results listing by component and overall grade. CRNs will not appear on this report if they have been rolled to 
Academic History. 
 

RESULTS – R02 ACADEMIC HISTORY & EGB REASSESSMENT 
Student Results listing by component and overall grade. CRNs will only appear on this report if they have been rolled to 
Academic History. To just select supplemental students choose the appropriate grade change code from the list. To run 
for all students, select all grade change codes. 
 

RESULTS – R07 EGB ASSESSMENT & CLASS ROSTER BROADSHEET BY PROGRAMME 
AND YEAR 
Module results for all students on a programme and year ordered by student ID. CRNs will not appear on this report if 
they have been rolled to Academic History. Module results that are less than the value in the minimum pass parameter 
field will be highlighted.  
 

RESULTS – R07_S EGB ASSESSMENT & CLASS ROSTER BROADSHEET BY PROGRAMME 
AND YEAR 
Ordered by Semester version. Module results for all students on a programme and year ordered by student ID. CRNs 
will not appear on this report if they have been rolled to Academic History. Module results that are less than the value in 
the minimum pass parameter field will be highlighted.  
 

RESULTS – R07 ACADEMIC HISTORY & EGB REASSESSMENT BROADSHEET BY 
PROGRAMME AND YEAR 
Module results for all students on a programme and year ordered by student ID. CRNs will only appear on this report if 
they have been rolled to Academic History. Module results that are less than the value in the minimum pass parameter 
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field will be highlighted. To just select supplemental students choose the appropriate grade change code from the list. 
To run for all students, select all grade change codes. 

RESULTS – R07_S ACADEMIC HISTORY & EGB REASSESSMENT BROADSHEET BY 
PROGRAMME AND YEAR 
Ordered by Semester version. Module results for all students on a programme and year ordered by student ID. CRNs 
will only appear on this report if they have been rolled to Academic History. Module results that are less than the value 
in the minimum pass parameter field will be highlighted. To just select supplemental students choose the appropriate 
grade change code from the list. To run for all students, select all grade change codes. 
 

RESULTS - R09 EGB ASSESSMENT & CLASS ROSTER BROADSHEET BY PROGRAMME 
AND YEAR 
Module results for all students on a programme and year ordered by student ID. CRNs will not appear on this report if 
they have been rolled to Academic History. Module results that are less than the value in the minimum pass parameter 
field will be highlighted.  
 

RESULTS – R09 ACADEMIC HISTORY BROADSHEET BY PROGRAMME AND YEAR 
Module results and module grade comments for all students on a programme and year ordered by Student ID. To just 
select supplemental students choose the appropriate grade change code from the list. To run for all students, select all 
grade change codes.  
 

RESULTS - R10 MODULE RESULTS AND PROGRAMME DECISION 
Academic history module results ordered by student with overall progression/award classification decision. 

 

TRANSCRIPT REPORTS 
Note that there are 2 Transcript reports: 

TRANSCRIPT - R24 STUDENT RESULTS NOTIFICATION (NON FINAL YEAR) 
Transcript of student results for non final year students. At least one progression decision must be selected. Students 
without any progression decisions will always display irrespective of decision(s) selected. To run for all students and all 
grade change codes, simply leave the grade change code prompt blank. To just select supplemental students, choose the 
appropriate grade change code from the list. Students with no home address will not appear. 

TRANSCRIPT - R17 RESULTS NOTIFICATION FOR FINAL YEAR STUDENTS 
Transcript of student results for final year students. Only students with an award classification will display. To run for 
all students and all grade change codes, simply leave grade change code prompt blank. To just select supplemental 
students, choose the appropriate grade change code from the list. Students with no home address will not appear. 

 
VALIDATION REPORTS 
Note that there are 8 Validation reports: 
 

VALIDATION - R05 STUDENTS WITHOUT MODULE RESULTS 
List of students with no overall results calculated in EGB or the class roster. 
 

VALIDATION - R18 GRADUATION LISTING 
List of students and their overall award classification. 
 

VALIDATION - R40 GRADE CHANGE CODES 
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List of Grade Change Codes available for selection in Banner (INB) and Electronic Grade Book (SSB) both for 
Assessment & Re-Assessment 
 

VALIDATION - R41 GRADE COMMENT CODES 
List of Grade Comment Codes available for selection in Banner (INB) and Electronic Grade Book (SSB). 
 

VALIDATION - R42 STUDENTS CARRYING A MODULE 
List of students with a CARY detail code transaction on their account. 
 

VALIDATION - R43 STUDENTS REPEATING A MODULE 
List of students with a RCRED Rate Code. 
 

VALIDATION - R32 STUDENTS WITH INVALID ECTS CREDITS 
List of students who have less than or greater than the number of ECTS credits specified in the credits prompt. 
 

VALIDATION - R27 APPROVED MODULES 
List of all modules against a programme and year, as per SZRPGMD. Includes module details (components, 
weightings, lecturer etc) and confirmation of whether modules are authorised or not. 
 
Note: The R32 & R27 reports are available from the General Student Reports category in Business Objects. 
 

VALIDATION – R44 PROGRESSION BOARD DECISION WITH MODULE ACADEMIC 
HISTORY RECORDS 
This report displays the progression decisions recorded on the student progression maintenance form and details the 
associated CRN grade records on academic history for the term and grade comments chosen.   If the academic history 
grade comment prompt is left blank, all the relevant students’ modules on academic history for the term will display. 
 

 
INB REPORTS 
There are also 2 exams reports available directly from Banner. These are as follows: 
 
 

EXAM DOWNLOAD - SZREBRD 
Results download for students based on Programme, Block Code or CRN. 
Breakdown of results by component grade, component change code, overall grade, overall change code and overall 
comment. Can be run for selected grade change codes (e.g. for selecting supplemental results only). 
Two options available for running report: 
 EGB Assessment/ Class Roster 
 EGB Re-Assessment / Academic History 
 

AWARD DOWNLOAD – TZADNLD 
Results download detailing the overall CRN grade(s) for each student on a given programme and year. Used to assist 
the calculation an overall award for final year students.  
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Progression is the process of advancing students from the previous stage of their programme to the next, following the 
successful completion and passing of examinations. A Progression Board convenes to review and make a final decision 
whether a student is entitled to Progress to the next Academic Year. Naturally, this is for all non final year students.  

PROGRAMME PROGRESSION PATHWAYS 
In order for progression to occur, programme progression pathways must be defined. These pathways are used to define 
the Progression Paths and default grant funding codes for each Programme / Block in Banner. 

 

E.g. Progression Paths for DT001 from Term 201213 to 201314 with default grant funding codes 

In advance of Term Roll & Progression activities each year, the Programme Progression Paths must be verified agreed. 
Where necessary, updates are made to reflect a change to a progression path.  Once completed, the Programme 
Progression Roll Process is run which in effect roll the paths the following term. This is usually run as part of the 
Banner Term Roll process. 

Note: The Programme Progression Proof Listing report in Business Objects displays the full list of programme 
progression paths on a given term.  

STUDENT PROGRESSION RUN MODE 1 
Also as part of the Progression & Term Roll, Run Mode 1 of the Student Progression is also run. This process populates 
the Student Progression Maintenance Form (SZASPRF) with a list of students and their suggested progression path 
from current term to next (as per agreed programme paths).  

You can confirm each student’s progression path and make any changes as required. 
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SZASPRF – STUDENT PROGRESSION MAINTENANCE FORM 
To query students on this form, you need to enter the following parameters into the key block: 

− Term Code (i.e. Term you are progressing FROM) 
− Campus  
− Programme 

 

When you have entered the parameters above, continue by choosing ‘next block’. All students registered with a status 
of RE and XR for this programme will appear in alphabetical order.   

 

Note: If students are retrospectively registered for the previous term after run mode 1 of the student progression job, 
they will not automatically appear on SZASPRF.  

To search for a given Programme Year, select F7 to clear the data. Now enter the preferred Year into the Class field 
(e.g. 2) or Block Code into the Current Block field (e.g. DT212/2C). Then select F8 to query and view results. 
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ENTERING A PBD (PROGRESSION BOARD DECISION) 
Following a progression board, SZASPRF is used by the Exams offices in order to record a PBD (Progression Board 
Decision) against each individual student record. The PBD entered against the student on this form will also appear on 
the student’s results transcript. 

There are a number of PBD options available to choose. By highlighting the PBD field and selecting F9, you can 
display the list of options. 

 Progression Rules have been built into Banner according to the above PBD codes.  Therefore based on the PBD 
selected, the student will be automatically flagged with a Roll Indicator or Y or N, thus determining whether or not the 
student is eligible for progression or not.  

The Rules are as follows: 

PBD PBD Description Roll Indicator 
P Pass Y 
CP Pass by Compensation Y 
R Refer to Grade Comment N 
RY Retake Year N 
CG Permission to Progress Carrying Granted Y 
RC Progression Not Allowed as Carry Not Passed N 
PP Proceed to Project Y 
PS Proceed within Stage Y 
PY Proceed within Year N 
PT Pass Practical Pass Theory Y 
RT Pass Practical Repeat Theory Y 
RP Pass Theory Repeat Practical Y 
RR Repeat Theory Repeat Practical Y 
 

Where a PBD decision is not entered on SZASPRF, it is also possible to manually update the Roll Indicator for a 
student(s) directly with a Y or N. The overall process remains the same and students with a Roll Ind of Y will 
eventually be rolled / progressed to the new Term. 

 
CHANGING A STUDENT PROGRESSION PATH 
It is also possible to manually change a student’s progression path on SZASPRF. For example, if you have confirmation 
that a student is progressing to a different programme and year, you can manually update the student’s Programme 
Progression, Roll Block and Class from the default entries.  

You may also to perform such a change if you have confirmation that a student is repeating and thus is progressing back 
into the same year of study and same block code. Simply update the Roll Block and Class accordingly. 
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PERFORM STUDENT PROGRESSION 
Once you are satisfied that the appropriate student records have been flagged for progression with a Roll Indicator of Y, 
you are then in a position to proceed with running the progression job. 

SZRSPRF STUDENT PROGRESSION – RUN MODE 2 
SZRSPRF is used to run the Student Progression Roll. The process is known as Student Progression - Run Mode 2. It 
can be run for an entire Campus, an individual Programme Code or an individual student.  

Upon entering the form, select ‘next block’. This will bring you to the Printer control section. Enter DATABASE in the 
printer field. 

‘Next block’ again into the Parameter Values section of the form. Form here you must enter the following: 

• Run Mode: 2 
• Current Term (Term Progressing from) 
• Campus Code: 
• Level (leave blank) 
• Program: 
• Student ID (usually left blank unless running for an individual student) 

Note: In the case of Student Appeals and/or Autumn Supplementals, you may also wish to run this Progression Roll for 
an individual student. In this case, simply input the relevant Student number in the Student ID parameter. 

 

‘Next block’ against into the Submission section of the form. From here, you need to check the ‘Save Parameter Set’ as 
checkbox.  To proceed with running the progression job, simply select save or F10. You should now expect a message 
prompt ‘Saving current parameter values as user level defaults’. Select OK to this message. 

The job will now run. It should only take a few moments. Once this roll is preformed, a student record for the next term 
will automatically be created.  You will not be able to delete this once it has been completed. 
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Every time a process like this is done, a unique job number is given. Upon completion of the progression job, you 
should notice the Log & Lis file number at the bottom of the screen. 

E.g.  

Take a note of this number as it will be used to check the job output which verifies the successful completion of the 
progression job. 

To review the job output, select from the menu  

Options → Review Output [GJIREVO]  

 

You will then be brought into a new screen. From here you can select your recently run job output number by selecting 
the drop-down beside the Number field. 

 

Double click on the *.log file to confirm if job ran successfully. Double click on the *.lis file to confirm detail of 
students successfully progressed. 

If you wish to save this file output (or any other job submission file) to a local directory on your PC, simply select 
Option -> Show Documents (Save and Print File) from the menu 

 

You will then be prompted to save the file. 
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Select ‘Save File’ and the file will be saved to your c:\temp folder on your pc. You will see another message prompt,to 
which you select OK. 

Note: You must have a folder called ‘temp’ already set-up on the root directory of your C drive to save outputs from job 
submission in Banner. 

 

SZASPRF – CONFIRM STUDENTS PROGRESSED (ROLL INDICATOR OR R) 
Following the completion of the Student Progression Run Mode 2 job, you should then return to SZASPRF to 
confirm that students have rolled / progressed to the new academic Term. 

Upon entering the form with the relevant parameters, you should immediately notice that those students who were 
previously flagged with a Roll Indicator of Y will now be updated to R (Rolled). Those that were flagged with an N will 
remain as N. 

 

You can continue to update any student who still has an N to Y and re-run the progression job in order to roll these 
remaining student records (e.g. repeat students flagged for progression at a later date). 

However, once a student is already Rolled (i.e. Roll Indicator of R), this cannot be undone and you should not change 
the Roll Indicator for these students. 

Similarly, you should never manually update a Roll Indicator to R on this form. This will not roll students. They must 
be flagged as Y and the progression job must then be run in order to progress students. 

 
PROGRESSION BUSINESS OBJECTS REPORTS 
There are two progression reports available in Business Objects to help support the progression process. Both are 
located in the General Student Category. They are as follows: 

− Programme Progression Proof Listing  
− Student Progression Proof Listing  
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MPRG - MANUAL PROGRESSION 
It is also possible to manually progress a student in Banner without utilizing the automated progression jobs.  

Part-time students can be manually progressed by means of the PRG2 QuickFlow. Staff and Alumni students can also 
be progressed using STF2 and ALM2 QuickFlows respectively. Full-time students can be manually progressed by 
means of the MPRG QuickFlow. 

The sequence of forms on the MPRG QuickFlow is as follows: 

 

SGASADD     

 SFAREGS       

SGASTDN 

SZASGNT                

TSASPAY 

SFAREGS 

    

SGASADD - ADDITIONAL STUDENT IN FORMATION FORM 
The first form of the MPRG QuickFlow is SGASADD. This Form will enable you update the Student Attribute Code to 
reflect the correct Year of Study. 

Ensure the correct ‘ID’ and ‘Term’ is entered. The student ID will default from the previous screen. Your term should 
reflect the term the student is progressing to. Select ‘next block’ twice to enter the ‘Student Attribute’ section. You 
should notice the old term and Attribute Code.  You now need to update this to reflect the new attribute code for the 
new term. 

Select the Maintenance Icon. Choose Copy Student Attribute 

 

Select OK to the following prompt. 
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You should now notice the old attribute code has been copied to the new term. You now need to remove this old 
attribute code. 

From the Menu, select Record -> Remove. 

 

Again, you will be prompted with the same previous ‘warning alert’. Select OK to proceed. Attribute Code should now 
be blank. Now enter the correct ‘Year of Study’ for the new term and save changes. Attribute Code should be updated 
for the new term. 

Save changes and exit form. 

 
SFAREGS - STUDENT COURSE REGISTRATION FORM 
The next form is SFAREGS. Upon entering the form, ensure the relevant student ID and the correct term (i.e. Term 
student is progressing to) is in the key block. Then select Next Block. 

 

PROGRESS STUDENT’S CURRICULA TO NEW TERM ON SAME PROGRAMME 
Firstly, you should navigate to the Curricula tab. You now need to manually progress the student’s registration record 
to the new term. To do this you need to select the ‘Duplicate’ icon.  
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This creates a copy of the existing curricula record for the new Term. Save changes when complete. 

 

 

PROGRESS STUDENT’S CURRICULA TO NEW TERM ON DIFFERENT PROGRAMME 
Where a student is progressing to a different Programme, you will need to replace the student’s curriculum with the new 
Programme. You must therefore select the ‘Replace’ icon.  

 

This copies the old curricula, makes it inactive and creates a new blank curriculum.  
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You should then update the curriculum details relevant to the new Programme codes. 

− Update the Catalog Term to reflect current Term (i.e. Term you are progressing to) 
− Ensure the Priority in set to 1. 
− Enter the new Program Code in the Program field. 
− Select ‘return’ and other Programme fields will default. 
− Save your changes. 

 

UPDATE BLOCK CODE 
Next, you should navigate to the Student Term tab. Update the Block Schedule field as appropriate for the new year of 
Study. 
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UPDATE STUDENT TYPE 
Under the same tab (i.e. Student Term) you may also need to update the Student Type. If the student was previously a 
new entrant (N) and is now being progressed the next term, then you must update the student type appropriately. 
Students continuing or re-enrolling on a particular programme of study will have a student type corresponding to their 
student level:  

A – Apprentice 
C – Continuing Education 
D – Professional Development 
U – Undergraduate 
P – Postgraduate 
R – Research 
However, as part of our obligation to return student data to the HEA annually, it is now required that where applicable, 
we also code students according to the criteria below. Therefore if Student Type is considered to be a ‘transfer’ or 
‘repeat’ student, the student type should be updated as follows: 

Student Type Description 
X Transfer-In from own institution 
I Transfer-In from other higher education institution 
B Repeat (Students repeating the same year of the same course for which they are primarily registered) 
 
Select the drop down list beside Student Type field to view list of available options. 
Note: You may also be required to update other fields on this tab if necessary (e.g. if the Rate Code is different for the 
new Term) 

You should now navigate to the Registration tab. Where programme modules have fees attached, you should also 
ensure the student is registered on those modules before you process any payment. 

Saving twice on SFAREGS will then trigger ‘Fee Assessment’. Exit the form to proceed with the QuickFlow. You will 
return to SFAREGS later in the QuickFlow to register the student and to process any payment if required. 

 

SGASTDN – GENERAL STUDENT 
The next form in the QuickFlow is the General Student Form SGASTDN. Again, you need to ensure the term (i.e. 
progression term) for the student is correct and then select ‘next block’ to enter/view information. This is the Student 
Record.  This first Block/Tab is the Learner Block. This is used to view student information such as student status and 
student tab. All information such as Fee Assessment Rate, Student Type, Full/Part Indicator should already be there 
having just progressed the student from the previous term. 

The only thing you need to check on this form is to flag a student as exchange, distance, e-learning or visiting 
occasional students, where applicable. If this does not apply to this particular student, simply exit the form. 

 

Alternatively, if this was entered for a particular student on a previous term and no longer applies, ensure it is removed 
for the current term record. 
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EXCHANGE, DISTANCE, E-LEARNING OR VISITING OCCASIONAL STUDENTS 
If the student belongs to one of the options listed below, you will need to update accordingly on the Session field 
(Additional Information section).  

 

Session 
Code Exchange / Non Standard Attendance / Mode of Study Category 

S Exchange – Erasmus/ Socrates incoming exchange 
I Exchange – Other incoming exchange 
O Exchange – Outgoing Exchange 
C Distance Education 
L E-Learning 
N In-Service Education 
Q Postgraduate Qualifier 
V Visiting Occasional/JYA 1 Term 
J Visiting Occasional/JYA 2 Terms 
Y Visiting Occasional/JYA Full Year 
C Distance Education 
L E-Learning 
N In-Service Education 

  

Save (F10) when complete. 

 

 

SZASGNT – STUDENT GRANT MAINTENANCE FORM 
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The next form is SZASGNT. This is where you enter the student grant details. 

Ensure the Student ID and Term Code has defaulted correctly. Then ‘Next Block’. You will be prompted with the 
following message: 

 

This message infers the student will inherit the default Programme Grant codes. Select OK and the default funding 
codes will populate the student’s grant record. 

Make any updates as required (e.g. if student is eligible for grant funding, update the grant record to reflect this). 

F10 to save changes. Exit the Form. 

 

TSASPAY – STUDENT PAYMENT FORM 
The next Form TSASPAY allows you to trigger the transfer of charges (i.e. liability for Fees) to the relevant Third Party 
such as Dept. of Education or local awarding body. Ensure the key block details are correct (i.e. Term Code and Student 
ID). Select Next Block. The following pop-up box will appear along with the various liability transfer transactions. 
Click on the Return button. 

 

Note: Depending of what type of Grant the student has been set-up against, fees may be covered by the Dept. of 
Education (Free Fees Scheme), an awarding body or both. In some instances the student may be liable for their own 
fees (e.g. repeat students). The transfer of liability between students and Third Parties occurs daily in Banner as part of 
an automated process. However, TSASPAY enables admin staff to trigger this liability transfer manually. Thus ensuring 
student and third party accounts are up-to-date at a particular point in time.  

You can now exit this Form. 

SFAREGS - STUDENT COURSE REGISTRATION FORM 
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On the final form, you are returned to SFAREGS. Ensure details are correct in the key block, and ‘next block’ into the 
Form.  

Save twice to trigger Fee Assessment and the payment options should now appear at the bottom of the form. Save the 
registration record as EL (Eligible to Register). Following this, you can generate an ITR (Invitation to Register) for the 
student so that the individual can register and pay fees online themselves. 
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RECORDING THE AWARD CLASSIFICATION FOR A STUDENT 
All graduates should have an Award Classification recorded in Banner.  

 

SHADEGR – DEGREE AND OTHER FORMAL AWARDS 
Once a Final Award has been agreed at the Board, the student’s award information is updated in Banner from 
SHADEGR. 

Enter the Student ID, Degree Sequence 1 and ‘next block’ 

 

Note: Degree Sequence is normally 1, assuming the student does not have more than one award. You should always 
check the curricula summary to ensure you are querying the correct degree sequence for the correct programme. If not, 
you should review the Degree Sequences from the key block and select the appropriate sequence relevant to the 
Programme.   

Assuming you have ‘next blocked’ to the Learner Outcome tab for the relevant curricula, you should see the Outcome 
Status as SO (Sought).  

If there is no record here (i.e. form is blank), you should go to the section on ‘Entering Degree information where SO 
(Sought Record) does not exist’ and proceed from there. 

Note: An SO degree award is automatically created against a student following the first grade roll for that student. 
Therefore, the only reason an SO degree record will not exist is because the student has no academic history. 
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 Assuming the SO already exists and you have confirmed the curricula data is correct, you should navigate to the 
Graduation Information section and update the following fields 

− Graduation Term: Term of Final Year Registration (e.g. 201213) 
− Graduation Year:  Year of Graduation (e.g. 2012) 

Note: This will default based on Graduation Term. However you can change this if required (e.g. where 
graduation year is the following year) 

− Graduation Status: DS is the only option (For purpose of Diploma Supplement) 
− Graduation Date:  Date Academic Council approved award. 

 

 

Now update the Outcome Status from SO to AW (Awarded). Save at this point. 

 

Finally, proceed to the Honours tab and input the relevant award classification (e.g. 2.1) under Institutional Honours – 
you can see the list of Honors by double clicking in the code field. 
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The checkbox ‘Print on Transcript’ should also be checked ‘on’ under Honours tab. This checkbox will enable students 
to view Award Classification on Student Self-Service. If this is not checked, students will not see their Award 
Classification on Self-Service. 

F10 to save changes.  

The student’s award classification has been successfully created. 

 

SHADEGR – ENTERING DEGREE INFORMATION WHERE SO (SOUGHT 
RECORD) DOES NOT EXIST 
Where a degree sequence does not exist for a programme (i.e. academic history has never been created for the student) 
then the curricula / programme will need to be manually created. 

Open the Degree and Other Formal Awards Form SHADEGR. Enter Student Number and Degree Sequence 1. 

  Next block into the Learner Outcome section of the form 

Where degree sequence with a Sought (SO) record has not been created for a curricula / programme already, then 
neither learner outcome nor curricula summary will display any information. 

 

First, input Outcome Status of SO (sought) and student record term (e.g. 201213) 
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Then select the Curricula tab where you should input the relevant Program code. 

 

Note:  In the case of PG Research programmes, you must ensure you enter the campus first and then the Programme 
Code. 

Save changes at this point. 

Next, go back to Learner Outcome tab. Note that the curricula summary will display the programme information you 
input on the curricula tab 

Navigate to the Graduation Information section and update the following fields: 

− Graduation Term: Term of Final Year Registration (e.g. 201213) 
− Graduation Year:  Year of Graduation (e.g. 2012) 

Note: This will default based on Graduation Term. However you can change this if required (e.g. where 
graduation year is the following year) 

− Graduation Status: DS is the only option (For purpose of Diploma Supplement) 
− Graduation Date:  Date Academic Council approved award. 
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Go to the Outcome Status and change it to AW (Awarded) 

 

Save changes 

Go to Honors Tab. Enter ‘Institutional Honors’ code (i.e. award classification).  

If you wish for the student to see their overall award classification on Student Self Service, you should ensure the ‘Print 
on Transcript’ checkbox is checked ‘on’ under Honours tab. This checkbox will enable students to view Award 
Classification on Student Self-Service. 

 

F10 to save changes.  

The student’s award classification has been successfully created. 
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HEA RETURNS & DATA QUALITY 
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As well as supporting the core academic and administrative processes within DIT, the Banner Student System acts as a 
data repository for all DIT student related information. This data is in turn is used to provide critical information to both 
internal and external parties about DIT’s academic, administrative and financial status.  

DIT is required to submit data to the HEA regarding its programmes, students and graduates. The data required and the 
format in which it is returned is specified by the HEA. In order to satisfy HEA requirements, it is imperative that the 
data held in the Banner Student system is accurate, absolute and consistent. 

The Data Quality Monitor is an ongoing process within DIT to foster and ensure that certain guidelines and practices 
are adhered to in ensuring the highest standard of data quality, which is correct and consistent with DIT business 
process rules. The DQM offers a series of reports in Business Objects. These reports should be run by Registration 
Services within a certain time frame each year, namely in preparation for HEA Student Statistical Returns. The outputs 
of these reports provide each Faculty with an opportunity to correct invalid, missing or redundant data. However, it 
must also be emphasised that data quality is something that every user of Banner should incorporate in everyday tasks 
from Registration to Exam Board Processing. By incorporating a high level of Data Quality from each user, we are 
avoiding the un-desired consequence of data, system and reporting errors.  

 

DQM REPORTS 
All DQM reports are available from the Data Quality category in Business Objects.  The reports are divided into a 
number of sections: 

− Reference & Validation Reports 
− Summary Reports 
− DQM/Error Reports 

 

REFERENCE & VALIDATION REPORTS 
Reference & Validation Reports have been developed to illustrate a high-level view of Programme data in Banner. They 
also detail those programmes which are included and excluded from HEA returns.  The list of reports is as follows: 

− Active Programme Listing 
− HEA Programme Type Definitions 
− Programmes excluded from HEA Returns 

 

SUMMARY REPORTS 
Summary reports can be run off data in Banner based on either ‘provisional’ or ‘final’ HEA returns. It is therefore 
effectively a snapshot of summary data at a point in time contiguous with HEA reporting timeframes and deadlines. 
Normally, provisional returns occur around November and final census returns around February / March. 

The HEA Summary reports will specify summary ‘counts’ of Students, New Entrants and Graduates. The criteria that 
these counts are based on are as follows: 
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− Programme 
− Gender & Programme Type 
− Gender & ISCED code 
− Gender & Age 
− Gender & County 
− Gender & Domiciliary 
− Gender & Nationality 
− Gender & Postal Code 
− Gender & Residency Type 

 

 

E.g. Summary Report of Students by Gender & Age 

 
DQM/ERROR REPORTS 
DQM Error Reports utilise a process whereby a wide spectrum of data inaccuracies are isolated, tracked and stored in a 
temporary table. This extraction process occurs in the form of a batch job which runs daily. 

In supporting this extraction process, a number of DQM error reports have been developed. These have been designed 
specifically to extract user-specified data errors from this temporary DQM table.  

Users should therefore be aware of timing in relation to this DQM extraction process. If a user runs a DQM report on a 
given day and makes changes to amend the reported errors on the same day, the errors will only drop off the relevant 
DQM error report(s) the following day. This is because the DQM extraction process only occurs once a day via a 
nightly batch job.  

The full list of reports is as follows: 

− DQM - Data Error Codes & Descriptions 
− DQM - Exams Data Errors Detail 
− DQM - Student Data Errors Summary (by Programme) 
− DQM - Student Data Errors Summary (by Campus) 
− DQM - Student Data Errors Detail (by Programme) 
− DQM - Student Data Errors Detail (by Campus) 
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APPENDIX – REGISTRATION CODES & 
THEIR MEANINGS  
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EL - ELIGIBLE TO REGISTER 
− Students have accepted a place on a DIT programme but have not yet formally registered. 
− Students have were registered last year and have successfully progressed to the next stage of their programme 

are EL again in advance of the new term registration process. 
− With the exception of international students, all EL students will receive an ‘Invitation to Register’ letter/email 

requesting them to register online and pay their registration fee. 

RE - REGISTERED 
− Students are currently attending a DIT programme.  
− Students are generally coded as RE when they complete the online process of programme web registration. 

They must pay at least 50% of their registration fee to register for the coming academic term.  
− International Students are manually coded as RE when it is confirmed they are attending their respective 

programmes and have paid their international registration fee.  
− Students are included on all standard reports and are counted for statistical analysis.  

XR – EXTERNAL REPEAT 
− Students who are repeating one of more components of the module but do not attend DIT classes for that 

particular module. 
− The student is not studying other than the modules he/she is externally repeating for that Academic Year. 
− External Repeats should have an active registrations record for the term and are counted for statistical purposes 
− They are not entitled to the normal privileges of an RE student such as a DIT student email account, AD 

account or access to the Self-Service and Programme Registration systems. 

OA – OFFSITE ATTENDANCE 
− Students who are registered in DIT but who are studying part of their course for the term offsite in another 

campus, usually in an international capacity.  
− OA students should have an active registrations record for the term and are counted for statistical purposes. 

PN - PERSON NOT ATTENDING 
− Registrations has proof of non-attendance on file (one of the following):  
− Letter/Email from student confirming non-attendance  
− Record of phone call from student confirming non-attendance  
− Noted on class listing as “not attending” – verified by course tutor  

DD - DECEASED 
− Enrolment Status updated to reflect student status as ‘Deceased’. 
− CRNs (not already rolled to Academic History) should be dropped from registrations record. 
− The deceased Indicator and date on Banner (SPAIDEN) must also be set.  
− Students are not included on any reports.  

DE - DUPLICATE ENTRY  
− A student record can be categorised “DE” where more than one record has been set up for a student in error. 
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DI - DEFERRED INACTIVE 
− Students who are granted a deferral on or before 31st October – Registrations will have documentation on file, 

verifying date of deferral.  
− Students are not counted for statistical purposes.  
− No fee will be claimed from DOES.  

DA DEFERRED ACTIV E 
− Students who are granted a deferral between 1st November and 31st January – Registrations will have 

documentation on file, verifying date of deferral.  
− 50% fees may be claimed from the DOES in respect of a “Standard” student. This may have implications for 

fees if the student returns to 3rd level education in a subsequent session.  

DS - DEFERRED END OF SESSION 
− Students who are granted a deferral from 1st February onwards 
−  Registrations will have documentation on file, verifying date of deferral.  
− 100% of fees may be claimed from the DOES in respect of a “Standard” student. This may have implications 

for fees if the student returns to 3rd level education in a subsequent session. 

WI - WITHDRAWN IN ACTIVE 
− Registered students who withdraw from the programme on or before 31st October 
− Registrations will have documentation on file, verifying date of withdrawal.  
− Students are not counted for statistical purposes.  
− Students are regarded as never having attended the programme for fee purposes – no fee will be claimed from 

DOES.  

WA - WITHDRAWN ACTIVE  
− Registered students who leave DIT between 1st November and 31st January – Registrations will have 

documentation on file, verifying date of withdrawal.  
− 50% of fees may be claimed from the DOES in respect of a “Standard” student. This may have implications 

for fees if the student returns to 3rd level education in a subsequent session.  

WS - WITHDRAWN END OF SESSION 
− Registered students who leave DIT from 1st February onwards – Registrations will have documentation on 

file, verifying date of withdrawal.  
− 100% tuition fees may be claimed from the DOES in respect of a “Standard” student. This may have 

implications for fees if the student returns to 3rd level education in a subsequent session.  
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